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• Nikon will not be held liable for any damages resulting from the use of this product.
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Trademark Information
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Warning!

Do not play the installer CD-ROM provided with this product on an audio CD player or other
device not intended for CD-ROMs.  Playing the CD-ROM on an audio CD player could damage the
speakers or result in hearing loss.
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Overview
Before You Begin

Welcome to Nikon Capture software for the D1, D1X, and D1H digital cameras (referred to below as
“your Nikon digital camera” or “camera”).  Nikon Capture 2 allows you to view and edit images taken
with your Nikon digital camera, including images taken at a setting of RAW.  With the camera connected
to a computer via its IEEE 1394 interface, you can upload photographs to the computer as they are
taken.

Nikon Capture 2 can not be used to upload to a computer images already stored on the camera
memory card.  To copy images from a memory card to a computer, use Nikon View 4 or insert the
memory card in a card reader or PC card slot.

Read this manual before using the software, and keep it where all those who use the software will read
it.

Package Contents

Before using this product, check that the package contains the items listed below.  Should you notice
that anything is missing or damaged, contact your retailer or Nikon representative.
• Nikon Capture 2 installer CD
• Nikon Capture 2 User’s Manual (this manual)
• User registration card

About This Manual

This manual describes how to install and use Nikon Capture 2.

Background Knowledge
This manual assumes familiarity with operations common to the Macintosh and Windows operating
systems.  Refer to the documentation provided with your operating system when in doubt about the
meaning of the terms used here.

Symbols and Conventions Used in This Manual
The following symbols and conventions are used in this manual:

Bold text marks button names and menu commands.

This icon marks cautions, information that you should read before using this software to pre-
vent damage to your Nikon digital camera.

This icon marks notes, information that you should read before this software.

This icon marks tips, additional information you may find helpful when using this software.

This icon indicates that more information is available elsewhere in this manual.
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Illustrations
This manual is for use with both Macintosh and Windows versions of this product.  While the majority
of the illustrations in this manual show the Windows version, save where otherwise noted the opera-
tions described apply to both operating systems.  Depending on your operating system, some dialogs
and menus may differ slightly from those shown here.  For information on operations specific to your
OS, refer to the documentation provided with your operating system.

ReadMe File
Be sure to read the ReadMe file on the Nikon Capture installer CD, as it may contain important
information that could not be included in this manual.
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Using Nikon Capture 2, you can view and edit images taken with Nikon D1, D1x, and D1H digital
cameras, including images taken at a setting of RAW.  With any of these camera connected to a
computer via its IEEE 1394 interface, you can upload photographs to the computer as they are taken,
edit them, and save them to disk.  Nikon Capture 2 also offers a camera control function, and its
capacity to manipulate highly versatile, twelve-bit RAW data allows you to take advantage of the full
potential of your Nikon digital camera.

Welcome to Nikon Capture!
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Principle Features
The main advantages offered by Nikon Capture 2 are listed below.

Image Enhancement and Support for RAW Data

Nikon Capture 2 can be used to open photographs taken with the camera and adjust brightness and
contrast, color balance, and sharpness.  It also supports adjustments to white balance, tone curves, and
color settings for RAW images, features unique to Nikon Capture 2.

File Format Can Be Chosen According to Task at Hand

Using Nikon Capture 2, you can save images in a file format suited to the task at hand.  RAW,  TIFF, and
JPEG images can be saved in Nikon’s unique Nikon Electronic Image Format (NEF).  NEF stores any
enhancements to the image separately from the original image data, ensuring that original data is unaf-
fected by changes to image enhancement options or compression when the image is saved in another
format.  Images can also be saved in formats supported by other imaging applications.

Direct Capture

When the camera is connected to a computer via its IEEE 1394 interface, photographs can be captured
to the computer’s hard disk as they are taken.  Photos captured from the camera can be viewed on the
computer monitor, making Nikon Capture an invaluable tool for studio photography.  The high-speed
IEEE 1394 interface allows even large-volume, high-quality images to load quickly.

Camera Control Function

Nikon Capture 2 offers a camera control function that allows you to take photographs and adjust
camera settings from your computer while the camera is connected.  It also supports time-lapse pho-
tography, which can not be performed when the camera is used alone.  Images taken using Nikon
Capture 2 are saved directly to the computer’s hard disk, not to the camera memory card.

Saved Settings

Camera control and image enhancement settings can be saved and recalled as desired.

Batch Processing

Batch processing allows images on the computer’s hard disk or captured directly from the camera via an
IEEE 1394 connection to be processed automatically according to image enhancement settings chosen
in advance.
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This chapter describes the process of installing Nikon Capture 2, registering your camera with the
system (Windows only), and uninstalling Nikon Capture 2.

Installing Nikon Capture 2
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Installing Nikon Capture 2—Windows
This section describes the process of installing Nikon Capture 2 on a computer running Windows 98
Second Edition (SE) or later.  Macintosh users can proceed to “Installing Nikon Capture 2—Macintosh”
(  pg. 53).

System Requirements

Before installing Nikon Capture 2, make sure that your system satisfies the following requirements:

CD-ROM drive

Interface

CPU

OS

RAM

Hard-disk space

Video Resolution

Required for installation

Open Host-Controller Interface (OHCI) compliant IEEE 1394 interface board
for connection to camera†, IEEE 1394 cable

Pentium II or Celeron processor or above (faster processors are recom-
mended for image processing)

Pre-installed versions of Windows 98 Second Edition (SE), Windows Me,
Windows 2000 Professional or later

A minimum of 64 MB available to Nikon Capture 2 (128 MB or more recom-
mended)*

While running, Nikon Capture 2 requires a minimum of 40 MB free hard disk
space (200 MB or more recommended)*

VGA (640 × 480 pixels) or better, sixteen-bit color or higher

* The more images captured, the larger the amount of memory and disk space required.  For
memory requirements when running Nikon Capture 2 at the same time as other software, see
the documentation for the software in question.

† The camera may not function as expected when connected to an IEEE 1394 hub.  For information
on boards or cards that have been tested and approved for use, see our technical support web-
sites.
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Windows 2000

When installing Nikon Capture 2 under Windows 2000, log in to the Administrator account.

Installation

This section describes how to install the Windows version of Nikon Capture 2.  Before starting instal-
lation:
• Check the amount of free disk space remaining
• Exit all applications, including any virus-checking software that may be running
• Confirm that the camera is NOT connected to the computer at this time
• Uninstall Nikon View DX (if installed) and any earlier versions of Nikon Capture
You are now ready to begin installation.

1 Turn the computer on.
Turn the computer on and wait for Windows to start up.

2 Insert the Nikon Capture 2 CD into the CD-ROM drive.
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3 Click Nikon Capture 2.
When the Nikon Capture 2 CD is inserted in the CD-ROM drive, the Nikon Capture 2 Welcome
window will open automatically.  Click Install Nikon Capture 2.

The ReadMe File

Before installing Nikon Capture 2, be sure to read the ReadMe file, which may contain important
information that could not be included in this manual.

If the Welcome Dialog Does Not Appear

If the Welcome dialog does not appear when the CD-ROM is inserted in the CD-ROM drive:
1. Double-click the My Computer icon
2. In the My Computer window, click the CD-ROM drive icon with the right mouse button
3. Select Autorun from the menu that appears

4 Read the license agreement.
A license agreement will be displayed.  If you agree to the terms of the license agreement, click Yes
to continue to the next step.
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5 Enter user information to personalize your copy of Nikon Capture 2.
The User Information dialog will be displayed.  After entering your name, place of work, and the
serial number for your copy of Nikon Capture 2, click Next to proceed to the next step.

Serial Number

The serial number may be found on the CD case.  The Next button in the User Information dialog
will only be available when the serial number has been entered correctly.

6 Confirm that the user information is correct.
If the information in the Registration Confirmation dialog is correct, click Yes to proceed to Step 7.
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7 Choose a destination for Nikon Capture 2.
In the Choose Destination Location dialog, choose the folder to which Nikon Capture 2 will be
installed.  To accept the default destination displayed in the Destination Folder section, click Next.
To choose a new folder, click Browse… and navigate to the desired location.

Nikon Scan 3

If Nikon Scan 3 is installed, you will be prompted to choose whether to associate some of the
extensions used in Nikon Scan 3 with Nikon Capture 2.  Click Yes.

After the installer copies the program files to the hard disk, the Select Application dialog will be dis-
played.
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Choosing an Application to View JPEG, TIFF, and BMP Files

If you choose Select the application later, you can choose the application used to open files of
these types from the File Locations tab of the Preferences dialog (  pg. 197) after installation is
complete.  The selected application will start when:
• you attempt to open a file saved in JPEG, TIFF, or BMP format
• you check Open in External Application in the Save As dialog (  pg. 91)

NEF and YCbCr-TIFF Images

Files saved in NEF and the camera’s YCbCr-TIFF format can only be opened in Nikon View 4 or
Nikon Capture 2 (if you have installed the Nikon NEF and Nikon YCC plug-ins provided with Nikon
View 4, you can also open NEF and YCbCr-TIFF images in Adobe Photoshop version 5.0 or later,
Photoshop LE excluded).

8 Choose the application that will be used to open Nikon Capture 2 files saved in JPEG, TIFF, or
BMP format.
Once a captured image has been saved in a format other than NEF, it can not be opened again in
Nikon Capture 2.  Once you have chosen a destination location and the installer has copied the
program files to the hard disk, a dialog will be displayed where you can select the application that
will be used to open images saved from Nikon Capture 2 in other formats.  To select the application
at a later date, choose Select the application later.  After making your selection, click Next to
proceed to the following step.



12

Before Choosing a Color Space Profile

Before choosing a color-space profile, make sure that your monitor has been properly set up.

9 Select the initial color-space profile.
Nikon Capture 2 uses color-space profiles to ensure consistent color reproduction.  As part of the
installation process, you can choose the default color-space profile that will be used when you first
star t Nikon Capture 2.  A new profile can be chosen at any time from the Nikon Capture 2
Preferences dialog.

Once you have selected the application that will be used to open Nikon Capture 2 files saved in
JPEG, TIFF, or BMP formats, the dialog shown below will be displayed.  To choose a profile that
matches the camera color mode, click D1 or D1X or D1H.  To choose from a list of profiles
supported in Nikon Capture 2, click Manual Setting.

D1
Clicking D1 sets the initial color-space profile to NTSC (1953).

D1X or D1H

Clicking D1X or D1H displays the dialog shown below, where you can choose the initial color-
space profile from “Setting Adobe RGB” and “Setting sRGB.”
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Choosing a Color Space Profile

When choosing a color-space profile, you should bear two things in mind: the gamma value for your
platform and the gamut (range) of colors required for the task at hand.

Gamma is a fundamental characteristic of imaging systems, used to adjust the brightness of scanned
images so that they display correctly on your monitor.  The first six profiles in the profile list have a
gamma value of 2.2, which is the de facto standard for Windows.  The last two have a gamma value of
1.8, the default value for the Macintosh.  Select a profile appropriate to the platform on which the
image is to be displayed.

The other factor to bear in mind when selecting a profile is the gamut, or range of colors you will
need for the task at hand.  If you are not planning to make fine adjustments to color, a profile with a
narrow range of colors is suitable.  Note, however, that a narrow gamut may produce colors that are
too “saturated,” or vivid.  If you intend to fine-tune color, contrast, and brightness using an editing
tool such as the Curves window, choose a profile that offers a wide range of colors.  Without editing,
however, such a profile may produce “flat,” low-contrast images.

Profiles within each of the two groupings are ordered by the size of their gamut.  Those with a
narrow gamut are listed at the top, those with a wide gamut at the bottom.

Manual Setting
Clicking Manual Setting displays the dialog shown below.  Click Continue.
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A list of color-space profiles will be displayed.

Click Windows to display a Windows wizard, Macintosh to display a wizard for Macintosh com-
puters.  Choose a color-space profile by following the on-screen instructions.

Choose a profile for use as the initial color-space profile.  The effects of the color range and gamma
setting for each profile can be seen in the image to the right of the profile list.  Select a profile and
click OK, or click Using the Wizard to choose a color-space profile with the help of a wizard.

Clicking Using the Wizard displays the dialog shown below:
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10Restart the computer.
When installation is complete, the dialog shown below will be displayed.  The computer must be
restarted before you can use Nikon Capture 2.  To restart the computer immediately, select Yes, I
want to restart my computer now before clicking Finish.
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Device Registration

Before you will be able to use your D1, D1X, or D1H digital camera with Nikon Capture 2, you must
register the device with the system.  If you have already registered the device for use with Nikon View
4 or will not be connecting the camera to the computer, you will not need to register the camera now.

Before registering your camera, check that the OHCI-compliant IEEE 1394 interface board is correctly
registered with the system.  Click the My Computer icon on the desktop with the right mouse button
and select Properties from the menu that appears.  The System Properties dialog will be displayed.  If
you are using Windows Millennium Edition (Me) or Windows 98 Second Edition (SE), click the Device
Manager tab.

If the board is correctly registered with the system, it will be listed under “1394 Bus Controller”.  If the
“1394 Bus Controller” entry is not displayed, follow the instructions in the manual provided with the
board to ensure that the drivers are properly installed.

If you are using Windows 2000, click the Hardware tab and then click the Device Manager… button
in the Device Manager section.



17

If the Hardware Wizard Does Not Appear

If the hardware wizard is not displayed when the camera is connected, proceed to “What to Do If
the Hardware Wizard Is Not Displayed” (  pg. 20).

If Nikon View DX or Earlier Versions of Nikon Capture Are Installed

If you are already using the D1 with existing copies of Nikon View DX or Nikon Capture, proceed to
“Updating Drivers for the D1” (  pg. 23).

If the Welcome dialog appears when the CD inserted in the drive, close the dialog by clicking the
Exit button.

Registering the Camera under Windows Millennium Edition (Me)

1 Install Nikon Capture 2 and restart the computer.  Once Windows has restarted, turn the camera
on, make sure that the mode dial is set to PC, and then connect the camera to the computer using
an IEEE 1394 cable.

2 The opening dialog for the Windows hardware wizard will be displayed.  Holding down the shift key
to prevent the Welcome dialog from opening automatically, insert the Nikon Capture 2 CD into
the CD-ROM drive and click Next after confirming that Automatic search for a better driver
(Recommended) is displayed in the hardware wizard.  The wizard will automatically install the
necessary drivers.
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5 The Device Manager sheet will be displayed.  After confirming that “Nikon 1394 Protocol Device”
is listed in the Device Manager, click the “+” sign to its left.

4 Once registration is complete, check that the camera has been correctly registered with the system.
Click the My Computer icon on the desktop with the right mouse button and select Properties
from the menu that appears.  The System Properties dialog will be displayed; click the Device
Manager tab.

3 The dialog shown below will be displayed; click Finish.
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This completes device registration for your Nikon digital camera.

7 The Nikon Digital Camera D1 Series Properties dialog will be displayed.  Click the General tab and
confirm that “This device is working properly.” appears under “Device status.”

6  After confirming that “Nikon Digital Camera D1 Series” is listed under “Nikon 1394 Protocol
Device,” double click the listing to open the Properties window.
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2 The Device Manager sheet will be displayed.  Double-click the listing for your camera appearing
under “Unknown devices” or “Other devices.”

What to Do If the Hardware Wizard Is Not Displayed

1 Click the My Computer icon on the desktop with the right mouse button and select Properties
from the menu that appears.  The System Properties dialog will be displayed; click the Device
Manager tab.
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If the Welcome dialog appears when the CD is inserted in the drive, close the dialog by clicking the
Exit button.

4 The Windows update device driver wizard will be displayed.  Holding down the shift key to prevent
the Welcome dialog from opening automatically, insert the Nikon Capture 2 CD into the CD-ROM
drive.  Confirm that Automatic search for a better driver (Recommended) is selected
and click Next.  The wizard will automatically update the device drivers.

3 The camera properties dialog will be displayed.  Open the General tab and click Reinstall Driver.
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6 Confirm that the camera has been registered with the system as described in steps 4–7 of “Regis-
tering the Camera under Windows Millennium Edition (Me)” (  pp. 18–19).

5 The dialog shown below will be displayed; click Finish.
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Updating Drivers for D1
If you are already using the D1 with Nikon View DX or an earlier version of Nikon Capture, you will
need to update the camera drivers.

1 Click the My Computer icon on the desktop with the right mouse button and select Properties
from the menu that appears.  The System Properties dialog will be displayed; click the Device
Manager tab.

2 The Device Manager sheet will be displayed.  Under the entry “Nikon 1394 Device,” double-click
“Nikon Digital Camera D1.”
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If the Welcome dialog appears when the CD-ROM is inserted, close the dialog by clicking the Exit
button.

4 The Windows Update Device Driver Wizard will be displayed.  Holding down the shift key to
prevent the Welcome dialog from opening automatically, insert the Nikon Capture 2 CD into the
CD-ROM drive. Confirm that Automatic search for a better dirver is selected and click
Next.  The wizard will automatically update the device drivers.

3 The Nikon Digital Camera D1 Properties dialog will be displayed.  Open the Driver tab and click
Update Driver….
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7 Confirm that the camera has been registered with the system as described in steps 4–7 of “Regis-
tering the Camera under Windows Millennium Edition (Me)” (  pp. 18–19).

6 The dialog shown below will be displayed; click Finish.

5 The dialog shown below will be displayed.  Select the file “\INF\NIKONDX.INF” on the CD-ROM
drive and click OK.
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If the Hardware Wizard Does Not Appear

If the hardware wizard is not displayed when the camera is connected, proceed to “What to Do If
the Hardware Wizard Is Not Displayed” (  pg. 31).

If Nikon View DX or Earlier Versions of Nikon Capture Are Installed

If you are already using the D1 with existing copies of Nikon View DX or Nikon Capture, proceed to
“Updating Drivers for the D1” (  pg. 35).

Registering the Camera under Windows 98 Second Edition (SE)

1 Install Nikon Capture 2 and restart the computer.  Once Windows has restarted, turn the camera
on, make sure that the mode dial is set to PC, and then connect the camera to the computer using
an IEEE 1394 cable.

2 The opening dialog for the Windows hardware wizard will be displayed.  Click Next.

3 Select the search option and click Next.
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6 Confirm that “(Drive letter for CD-ROM drive):\Inf ” is displayed in the text box under Specify a
location and click Next.

If the Welcome dialog appears when the CD is inserted in the drive, close the dialog by clicking the
Exit button.

4 Holding down the shift key to prevent the Welcome dialog from opening automatically, insert the
Nikon Capture 2 CD into the CD-ROM drive.  Select Specify a location and click Browse.

5 The dialog shown below will be displayed.  Navigate to the Inf folder on the Nikon Capture 2 CD
(Ncapture2) and click OK.
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9 Once registration is complete, check that the camera has been correctly registered with the system.
Click the My Computer icon on the desktop with the right mouse button and select Properties
from the menu that appears.  The System Properties dialog will be displayed; click the Device
Manager tab.

If the message, “Windows was unable to find a suitable driver for this device,” is displayed, this may
indicate that the Nikon Capture 2 CD was not correctly inserted in the CD-ROM drive or that the
correct search location was not specified.  Click Back to return to the dialog shown in Step 6,
where you can confirm that the correct location has been specified.

7 A dialog will be displayed stating that Windows has found the drivers for “Nikon Digital Camera D1
Series”; click Next.

8 The dialog shown below will be displayed; click Finish.
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11After confirming that “Nikon Digital Camera D1 Series” is listed under “Nikon 1394 Protocol
Device,” double click the listing to open the Properties window.

10The Device Manager sheet will be displayed.  After confirming that “Nikon1394 Protocol Device” is
listed in the Device Manager, click the “+” sign to its left.
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This completes device registration for your Nikon digital camera.

12The Nikon Digital Camera D1 Series Properties dialog will be displayed.  Click the General tab and
confirm that “This device is working properly” appears under “Device status.”
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3 The camera properties dialog will be displayed.  Open the General tab and click Reinstall Driver.

2 The Device Manager sheet will be displayed.  Double-click the listing for your camera appearing
under “Unknown devices” or “Other devices.”

What to Do If the Hardware Wizard Is Not Displayed

1 Click the My Computer icon on the desktop with the right mouse button and select Properties
from the menu that appears.  The System Properties dialog will be displayed; click the Device
Manager tab.
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4 The Windows Update Device Driver Wizard will be displayed; click Next.

5 The dialog shown below will be displayed.  Select Search for the best driver for your device
(Recommended) and click Next.

6 The dialog shown below will be displayed.  Holding down the shift key to prevent the Welcome
dialog from opening automatically, insert the Nikon Capture 2 CD into the CD-ROM drive.  Select
Specify a location and click Browse.

If the Welcome dialog appears when the CD inserted in the drive, close the dialog by clicking the
Exit button.
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8 Confirm that “(Drive letter for CD-ROM drive):\Inf ” is displayed in the text box under Specify a
location and click Next.

7 The dialog shown below will be displayed.  Navigate to the Inf folder on the Nikon Capture 2 CD
(Ncapture2) and click OK.
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11Confirm that the camera has been registered with the system as described in steps 9–12 of “Reg-
istering the Camera under Windows Second Edition (SE)” (  pp. 28–30).

If the message, “Windows was unable to find a suitable driver for this device,” is displayed, this may
indicate that the Nikon Capture 2 CD was not correctly inserted in the CD-ROM drive or that the
correct search location was not specified.  Click Back to return to the dialog shown in Step 8,
where you can confirm that the correct location has been specified.

9 A dialog will be displayed stating that Windows has found the drivers for “Nikon Digital Camera D1
Series”; click Next.

10The dialog shown below will be displayed; click Finish.
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2 The Device Manager sheet will be displayed.  Under the entry “Nikon 1394 Device,” double-click
“Nikon Digital Camera D1.”

Updating Drivers for D1
If you are already using the D1 with Nikon View DX or an earlier version of Nikon Capture, you will
need to update the camera drivers.

1 Click the My Computer icon on the desktop with the right mouse button and select Properties
from the menu that appears.  The System Properties dialog will be displayed; click the Device
Manager tab.
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3 The Nikon Digital Camera D1 Series Properties dialog will be displayed.  Open the Driver tab and
click Update Driver….

4 The Windows Update Device Driver Wizard will be displayed; click Next.

5 The dialog shown below will be displayed.  Select Search for a better driver than the one
your device is using now. (Recommended) and click Next.
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8 Confirm that “(Drive letter for CD-ROM drive):\Inf ” is displayed in the text box under Specify a
location and click Next.

If the Welcome dialog appears when the CD-ROM is inserted, close the dialog by clicking the Exit
button.

6 The dialog shown below will be displayed.  Holding down the shift key to prevent the Welcome
dialog from opening automatically, insert the Nikon Capture 2 CD into the CD-ROM drive.  Select
Specify a location and click Browse….

7 The dialog shown below will be displayed.  Navigate to the Inf folder on the Nikon Capture 2 CD
(Ncapture2) and click OK.
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11Confirm that the camera has been registered with the system as described in steps 9–12 of “Reg-
istering the Camera under Windows Second Edition (SE)” (  pp. 28–30).

10The dialog shown below will be displayed; click Finish.  If a message is displayed prompting you to
restart Windows, click Restart.

If the message, “Windows was unable to find a suitable driver for this device,” is displayed, this may
indicate that the Nikon Capture 2 CD was not correctly inserted in the CD-ROM drive or that the
correct search location was not specified.  Click Back to return to the dialog shown in Step 8,
where you can confirm that the correct location has been specified.

9 A dialog will be displayed stating that Windows has found the drivers for “Nikon Digital Camera D1
Series”; click Next.
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If the Hardware Wizard Does Not Appear

If the hardware wizard is not displayed when the camera is connected, proceed to “What to Do If
the Hardware Wizard Is Not Displayed” (  pg. 43).

If Nikon View DX or Earlier Versions of Nikon Capture Are Installed

If you are already using the D1 with existing copies of Nikon View DX or Nikon Capture, proceed to
“Updating Drivers for the D1” (  pg. 47).

Logging On

When registering the camera under Windows 2000, log in to the Administrator account.

Registering the Camera under Windows 2000

1 Install Nikon Capture 2 and restart the computer.  Once Windows has restarted, turn the camera
on, make sure that the mode dial is set to PC, and then connect the camera to the computer using
an IEEE 1394 cable.

2 The opening dialog for the Windows hardware wizard will be displayed; click Next.

3 Select the search option and click Next.
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4 Holding down the shift key to prevent the Welcome dialog from opening automatically, insert the
Nikon Capture 2 CD into the CD-ROM drive.  Select CD-ROM drives and click Next.

If the Welcome dialog appears when the CD inserted in the drive, close the dialog by clicking the
Exit button.

5 The dialog shown below will be displayed; click Next.

If the message, “Windows was unable to find a suitable driver for this device,” is displayed, this may
indicate that the Nikon Capture 2 CD was not correctly inserted in the CD-ROM drive or that the
correct search location was not specified.  Click Back to return to the dialog shown in Step 4,
where you can confirm that the correct location has been specified.
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6 The dialog shown below will be displayed; click Finish.

7 Once registration is complete, check that the camera has been correctly registered with the system.
Click the My Computer icon on the desktop with the right mouse button and select Properties
from the menu that appears to display the System Properties dialog.  Open the Hardware tab and
click the Device Manager… button in the Device Manager section.

8 The Device Manager will be displayed.  After confirming that “Nikon 1394 Protocol Device” is listed
in the Device Manager, click the “+” sign to its left.
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9 After confirming that “Nikon Digital Camera D1 Series” is listed under “Nikon 1394 Protocol
Device,” double-click the listing to open the Properties window.

10The Nikon Digital Camera D1 Series Properties dialog will be displayed.  Click the General tab and
confirm that “This device is working properly.” appears under “Device status.”

This completes device registration for your Nikon digital camera.
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What to Do If the Hardware Wizard Is Not Displayed

1 Click the My Computer icon on the desktop with the right mouse button and select Properties
from the menu that appears to display the System Properties dialog.  Open the Hardware tab and
click the Device Manager… button in the Device Manager section.

2 The Device Manager will be displayed.  Double-click the listing for your camera that appears under
“Unknown devices” or “Other devices”.
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3 Open the General tab and click Reinstall Driver….

4 The Windows Upgrade Device Driver Wizard will be displayed; click Next.

5 Select the search option and click Next.
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6 The dialog shown below will be displayed.  Holding down the shift key to prevent the Welcome
dialog from opening automatically, insert the Nikon Capture 2 CD into the CD-ROM drive.  Select
CD-ROM drives and click Next.

If the Welcome dialog appears when the CD inserted in the drive, close the dialog by clicking the
Exit button.

7 The dialog shown below will be displayed; click Next.

If the message, “Windows was unable to find a suitable driver for this device,” is displayed, this may
indicate that the Nikon Capture 2 CD was not correctly inserted in the CD-ROM drive or that the
correct search location was not specified.  Click Back to return to the dialog shown in Step 6,
where you can confirm that the correct location has been specified.
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8 The dialog shown below will be displayed; click Finish.

9 Confirm that the camera has been registered with the system as described in steps 7–10 of “Reg-
istering the Camera under Windows 2000” (  pp. 41–42).
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Updating Drivers for D1
If you are already using the D1 with Nikon View DX or an earlier version of Nikon Capture, you will
need to update the camera drivers.

1 Click the My Computer icon on the desktop with the right mouse button and select Properties
from the menu that appears to display the System Properties dialog.  Open the Hardware tab and
click the Device Manager… button in the Device Manager section.

Logging On

When registering the camera under Windows 2000, log in to the Administrator account.

2 The Device Manager will be displayed.  Under the entry “Nikon 1394 Protocol Device,” double-
click “Nikon Digital Camera D1.”
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3 The Nikon Digital Camera D1 Properties dialog will be displayed.  Open the Driver tab and click
Update Driver….

4 The Windows Upgrade Device Driver Wizard will be displayed; click Next.

5 The dialog shown below will be displayed.  Select the search option and click Next.
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6 The dialog shown below will be displayed.  Holding down the shift key to prevent the Welcome
dialog from opening automatically, insert the Nikon Capture 2 CD into the CD-ROM drive.  Select
CD-ROM drives and click Next.

If the Welcome dialog appears when the CD-ROM is inserted, close the dialog by clicking the Exit
button.

7 The dialog shown below will be displayed.  Select Install one of the other drivers and click
Next.
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8 Select Nikon Digital Camera D1 series from the dialog below and click Next.

9 The dialog shown below will be displayed; click Finish.

10Confirm that the camera has been registered with the system as described in steps 7–10 of
“Registering the Camera under Windows 2000” (  pp. 41–42).
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Uninstall

This section describes how to uninstall the Windows version of Nikon Capture 2.

1 Start the uninstall program.
From the Start menu, select Programs > Nikon Capture 2 > Nikon Capture 2 Uninstall.

Logging On

When uninstalling Nikon Capture 2 from Windows 2000, log in to the Administrator account.

2 Confirm file deletion.
When the message, “Do you want to completely remove the selected application and all of its
components?” appears, click OK to begin the process of uninstalling Nikon Capture 2.

The uninstall program will start.



52

4 Restart your computer.
The dialog shown below will be displayed when the process of uninstalling Nikon Capture 2 is
complete.  Confirm that Yes, I want to restart my computer now is selected and click Finish
to restart your computer.

3 Decide whether to delete shared and read-only files.
If any of the components used by Nikon Capture 2 are read-only or are also used by another
program, a confirmation dialog will be displayed.  Follow the instructions in the dialog to remove the
component or leave it untouched.
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Installing Nikon Capture 2—Macintosh
This section describes the process of installing Nikon Capture 2 on a Macintosh computer.  Windows
users can refer to “Installing Nikon Capture 2—Windows” (  pg. 6).

System Requirements

Before installing Nikon Capture 2, make sure that your system satisfies the following requirements:

CD-ROM drive

Interface

CPU

OS

RAM

Hard-disk space

Video Resolution

Required for installation

Built-in IEEE 1394 interface for connection to camera†, IEEE 1394 cable

Power Macintosh G3 (Blue & White) or later

Mac OS versions 8.6 to 9.1

A minimum of 64 MB available to Nikon Capture 2 (128 MB or more recom-
mended)*

While running, Nikon Capture 2 requires a minimum of 40 MB free hard disk
space (200 MB or more recommended)†

VGA (640 × 480 pixels) or better, sixteen-bit color or higher

* The more images captured, the larger the amount of memory and disk space required.  For
memory requirements when running Nikon Capture 2 at the same time as other software, see
the documentation for the software in question.

† Requires FireWire 2.3.3 or later (available from the Apple Computer web-site).  The camera may
not function as expected when connected to an IEEE 1394 (FireWire) hub.
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Installation

This section describes how to install the Macintosh version of Nikon Capture 2.  Before starting instal-
lation:
• Check the amount of free disk space remaining
• Exit all applications, including any virus-checking software that may be running
• Confirm that the camera is NOT connected to the computer at this time
• Uninstall Nikon View DX (if installed) and any earlier versions of Nikon Capture

You are now ready to begin installation.

1 Turn the computer on.
Turn the computer on and wait for the operating system to start up.

2 Insert the Nikon Capture 2 CD into the CD-ROM drive.
The Nikon Capture window will open automatically on the desktop.  If multiple language versions
of Nikon Capture are available, open the folder for the language of your choice.

3 Double-click the Nikon Capture 2 Installer icon.

The ReadMe File

Be sure to read the ReadMe file, which may contain important information that could not be in-
cluded in this manual.
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4 Click Continue….
Double-clicking the installer icon displays the dialog shown below.  Click Continue….

5 Read the license agreement and ReadMe file.
A license agreement will be displayed.  If you agree to the terms of the license agreement, click
Accept to view the ReadMe file.  Take a few moments to read this file, which may contain informa-
tion that could not be included in this manual.  After viewing the ReadMe file, click Continue to
display the installer dialog.
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6 After selecting the installation type and destination folder, start the installer.
Use the pop-up menu in the Install Location section to select the volume and folder to which
Nikon Capture 2 will be installed.  After checking the information in the Install Location area and
confirming that Easy Install is selected in the pop-up menu at the top left corner of the installer
dialog, click Install to start the installer.

7 Enter user information to personalize your copy of Nikon Capture 2.
The dialog shown below will be displayed.  After entering your name, place of work, and the serial
number for your copy of Nikon Capture 2, click OK to proceed to the next step.

Serial Number

The serial number may be found on the CD case.  The OK button in the User Information dialog will
only be available when the serial number has been entered correctly.
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8 Confirm that the user information is correct.
If the information is correct, click Yes to proceed to Step 9.

9 Choose the application that will be used to open Nikon Capture 2 files saved in JPEG, TIFF, or
PICT format.
Once a captured image has been saved in a format other than NEF, it can not be opened again in
Nikon Capture 2.  Once you have personalized your copy Nikon Capture 2, a dialog will be displayed
where you can select the application that will be used to open images saved from Nikon Capture 2
in other formats.  If Adobe Photoshop is installed on your system, you can click Adobe Photoshop®

to choose Photoshop as the application.  To choose a different application, click Select Applica-
tion… and navigate to the folder containing the application you want to use.  Another application
can be chosen from the Nikon Capture 2 Preferences dialog at any time after installation.

Choosing an Application to View JPEG, TIFF, and PICT Files

If you choose Select Application…, you can choose the application used to open files of these
types from the File Locations tab of the Preferences dialog (  pg. 197) after installation is complete.
The selected application will start when:
• you attempt to open a file saved in JPEG, TIFF, or PICT format
• you check Open in External Application in the Save As dialog (  pg. 91)

NEF and YCbCr-TIFF Images

Files saved in NEF and the camera’s YCbCr-TIFF format can only be opened in Nikon View 4 or
Nikon Capture 2 (if you have installed the Nikon NEF and Nikon YCC plug-ins provided with Nikon
View 4, you can also open NEF and YCbCr-TIFF images in Adobe Photoshop version 5.0 or later,
Photoshop LE excluded).



58

10 Select the initial color-space profile.
Nikon Capture 2 uses color-space profiles to ensure consistent color reproduction.  As part of the
installation process, you can choose the default color-space profile that will be used when you first
star t Nikon Capture 2.  A new profile can be chosen at any time from the Nikon Capture 2
Preferences dialog.

Once you have selected the application that will be used to open Nikon Capture 2 files saved in
JPEG, TIFF, or PICT formats, the dialog shown below will be displayed.  To choose a profile that
matches the camera color mode, click D1X or D1H or D1.  To choose from a list of profiles
supported in Nikon Capture 2, click Manual Setting.

D1
Clicking D1 sets the initial color-space profile to NTSC (1953).

D1X or D1H

Clicking D1X or D1H displays the dialog shown below, where you can choose the initial color-
space profile from “Setting Adobe RGB” and “Setting sRGB.”

Before Choosing a Color Space Profile

Before choosing a color-space profile, make sure that your monitor has been properly set up.



59

Manual Setting
Clicking Manual Setting displays the dialog shown below.  Click Continue.

Choosing a Color Space Profile

When choosing a color-space profile, you should bear two things in mind: the gamma value for your
platform and the gamut (range) of colors required for the task at hand.

Gamma is a fundamental characteristic of imaging systems, used to adjust the brightness of scanned
images so that they display correctly on your monitor.  The first six profiles in the profile list have a
gamma value of 2.2, which is the de facto standard for Windows.  The last two have a gamma value of
1.8, the default value for the Macintosh.  Select a profile appropriate to the platform on which the
image is to be displayed.

The other factor to bear in mind when selecting a profile is the gamut, or range of colors you will
need for the task at hand.  If you are not planning to make fine adjustments to color, a profile with a
narrow range of colors is suitable.  Note, however, that a narrow gamut may produce colors that are
too “saturated,” or vivid.  If you intend to fine-tune color, contrast, and brightness using an editing
tool such as the Curves window, choose a profile that offers a wide range of colors.  Without editing,
however, such a profile may produce “flat,” low-contrast images.

Profiles within each of the two groupings are ordered by the size of their gamut.  Those with a
narrow gamut are listed at the top, those with a wide gamut at the bottom.
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A list of color-space profiles will be displayed.

Click Windows to display a Windows wizard, Macintosh to display a wizard for Macintosh com-
puters.  Choose a color-space profile by following the on-screen instructions.

Choose a profile for use as the initial color-space profile.  The effects of the color range and gamma
setting for each profile can be seen in the image to the right of the profile list.  Select a profile and
click OK, or click Using the Wizard to choose a color-space profile with the help of a wizard.

Clicking Using the Wizard displays the dialog shown below:
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11Restart the computer.
When installation is complete, the dialog shown below will be displayed.  Click Restart to restart
your computer.



62

Uninstall

This section describes how to uninstall the Macintosh version of Nikon Capture 2.

1 Start the installer.
Insert the Nikon Capture 2 CD into the CD-ROM drive and start the installer as described in steps
3–5 of “Installation” (  pp. 54-55).

2 Select Uninstall.
Select Uninstall from the pop-up menu at the top left corner of the Nikon Capture Installer
dialog, then click the Uninstall button at the dialog’s bottom right corner.

3 Exit the installer.
Once Nikon Capture 2 has been uninstalled, the dialog shown below will be displayed.  Click OK
to exit the installer.
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This chapter explains the basic operation of Nikon Capture 2.  Read this chapter when running
Nikon Capture for the first time after installation.

Tutorial
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Getting Started

Windows

1 Turn on the computer and start Windows.

2 From the Start menu, select Programs > Nikon Capture 2 > Nikon Capture 2.

Nikon Capture 2 window

Menu bar
Toolbar

Status bar (displays interactive help messages)

Disk-space
indicator

The Nikon Capture 2 window will open on the desktop.

Windows Displayed at Start-up

Any windows that were open when last you quit Nikon Capture 2 will be displayed the next time
you start the program.
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Macintosh

1 Turn on the computer and wait for the operating system to start up.

2 Open the Nikon Capture 2 folder in the folder to which you installed Nikon Capture 2 and
double-click the Nikon Capture icon.

Menu bar

Tool palette

Disk-space
indicator

The Nikon Capture 2 window will open on the desktop.

The Disk-Space Indicator

The color of the disk space indicator shows how much unused hard-disk space is available.
Green: More than 200 MBs available on both the volume used for temporary storage and on the

volume used to store thumbnails
Yellow: Less than 200 MBs remaining on one or both volumes.
Red: Less than 100 MBs remaining on one or both volumes. Choose a different volume from the

File Locations tab of the Preferences dialog (  pg. 197)  or free space by deleting unneces-
sary files.

For a detailed description of the options available in the menu bar, toolbar (Windows), and tool palette
(Macintosh), see “Reference” (  pg. 203).
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Opening Image Files
This section describes how to open image files that have been captured and saved to the computer’s
hard disk.  For information on capturing images, see “Capturing Photographs” (  pg. 139) and “Trans-
ferring Existing Photographs to a Computer” (  pg. 239).

Nikon Capture 2 can be used to open images saved in Nikon Electronic Image Format (NEF) and
unedited JPEG and TIFF files created with D1, D1X, and D1H digital cameras (note that NEF files created
with Nikon Scan 3 can not be opened in Nikon Capture 2).

1 Click the  button or select Open… from the File menu.
A dialog like that shown below will be displayed.

2 Navigate to the desired drive (volume) and folder.

3 Double-click the target file.
The selected image will be opened in an image window within Nikon Capture 2.

Opening Images in an External Application

When you attempt to open a file that has been edited and saved in TIFF or JPEG, a message will be
displayed indicating that the file can not be opened in Nikon Capture 2.  If the Open saved image
in external application option in the File Locations tab of the Preferences dialog (  pg. 197) is
checked, you will be asked whether you would like to open the file in an external application.  Select
Yes to start the application and open the file.

NEF and YCbCr TIFF Formats

• Photographs taken at an image quality setting of HI-RAW are stored in NEF format, which records
twelve-bit image data from the camera’s CCD.  Photographs taken at an image quality setting of
YCbCr-TIFF are saved in an uncompressed TIFF format that models color using measures of
luminance (Y) and chrominance (Cb and Cr).  Images of these types can only be viewed using
Nikon View 4 or Nikon Capture 2.

• NEF and YCbCr files can be opened in Adobe Photoshop version 5.0 or later (Photoshop LE
excluded) using the Nikon NEF and Nikon YCC filters supplied with Nikon View 4 (note that
NEF files created with Nikon Scan 3 can not be opened using the Nikon NEF plug-in).
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Working with Image Windows
Images are displayed in independent image windows or in the Camera Image window (  pg. 145).
Image enhancement and save operations are performed on the image in the active window.

Image Windows
Images are opened in independent image windows when a copy is made of the image selected in the
Camera Image window or when an image is opened with the Open… option in the File menu.  Any
number of image windows may be open simultaneously.

Title Bar
The title bar provides the following information about the image:

File name: If the image was opened using the Open… command in the File menu, the title
bar shows the file name and path.

Zoom ratio: The current zoom ratio as a percentage of the original size.  The original size for
display purposes is determined by the number of pixels in the image and the
resolution of the monitor and does not reflect the physical dimensions of the
image when printed.

“Image not saved” indicator:
Images that have not been saved to disk are indicated by an asterisk (“*”).

Title bar
Shooting

Data
 section

Preview
section
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Right-Button Menu (Windows)

Clicking on the Preview section with the right mouse button displays a menu of options identical to
the Image menu.

Viewing Photo Information

Photo information for the image displayed in the Preview section of the Image window can be viewed
in the Shooting Data section.

1 Display the Shooting Data section.
Click the arrow at the top left corner of the Shooting Data section.

The Shooting Data section shows the date and time of recording and the shooting data in effect at
the time the photograph was taken.

2 Close the Shooting Data section.
To close the Shooting Data section, click the triangle at its top left corner.
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Shooting Data Section
The Shooting Data section shows the following photo information for the selected image:

Camera type
File format
Lens focal length and aperture
Metering mode
Flexible program
Sensitivity (ISO equivalency)
Camera ID
Image sharpening

Date and time of recording
Image quality
Focal length
Shutter speed and aperture
Exposure indicator
Color mode
White balance
Longitude

Image type
Image size
Exposure mode
Exposure compensation
Flash sync mode
Hue adjustment
Tone compensation
Latitude

The shooting data section can be hidden or displayed by clicking the triangle at the top left corner, or by
selecting Shooting Data Section from the View menu.

The Preview Section

Any changes to image adjustment settings are reflected in the image in the Preview section of the active
window.
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Zoom
By altering the zoom ratio, you can enlarge all or part of an image to fill the screen.  The zoom ratio is
displayed in the window title bar.

Using the Zoom Tool

Zooming in on an Image

1 Click the  tool or select Zoom Cursor from the View menu.
The cursor will change to .

2 Click anywhere in the image for an enlarged view of the selected area.
The spot you click will be at the center of the new, enlarged view.

The Zoom Cursor and Zoom Tool (Windows Only)

In the Windows version of Nikon Capture 2, you can zoom in on an area of the image by dragging
the mouse over the area when the zoom cursor is selected.  To restore zoom to 100%, double-click
the zoom tool in the toolbar.

Zoom

Zoom operations have no effect on the physical size of the image.



71

Zooming out from an Image

1 Click the  tool or select Zoom Cursor from the View menu.
The cursor will change to .  Hold down the Ctrl (Windows) or option (Macintosh) key on the
keyboard to change the shape of the cursor to  (the zoom-out cursor).

2 Click anywhere in the image to zoom out from the selected area.
The spot you click will be at the center of the new view.

Using the Zoom Commands

Zooming in on an Image
Select Zoom In from the View menu.  The view will be enlarged by a fixed amount.

Zooming out from an Image
Select Zoom Out from the View menu.  The zoom ratio will be reduced by a fixed amount.

Cursor Short Cuts

While the shift (Windows) or command (Macintosh) key is pressed, the mouse pointer will change
to a zoom-in cursor ( ).  To change to a zoom-out cursor ( ), press the Ctrl (Windows) or option
(Macintosh) key.  Press the Alt (Windows) or shift (Macintosh) key to change to a grab cursor ( ).

The Bird’s Eye Window

The Bird’s Eye window shows the position of the portion of the image visible in the active image
window.  This can be useful if only a portion of the image will fit in the window at the current zoom
ratio, when the Bird’s Eye window can be used to navigate to another area of the image without
zooming the image out.  To view the Bird’s Eye window, select Bird’s Eye from the View menu.  For
more information, see “The Bird’s Eye Window” (  pg. 73).
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Scrolling Images
At high zoom ratios, only part of the image may fit in the image window.  In this case, the grab cursor can
be used to view other areas of the image.

Using the Grab Cursor

Click the  button in the toolbar (Windows) or tool palette (Macintosh).  When the mouse pointer
is moved over the image, it changes to a  cursor.  Drag the image in the image window until the
desired area is visible.
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The Bird’s Eye Window

The Bird’s Eye window shows the position of the portion of the image visible in the active image
window.  To display or hide the Bird’s Eye window, select Bird’s Eye from the View menu.

The portion of the image visible in the active image window is indicated by a red outline.

When the mouse pointer is moved over the red outline, it changes to a  cursor.  Drag the red outline
over the area of the image you would like to view.   The selected area will be displayed in the active
image window.

Red outline is displayed

Changing the Size of the Bird’s Eye Window

The size of the Bird’s Eye window can be adjusted by dragging its borders (Windows) or by dragging
the handle at its lower right corner (Macintosh).
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Rotating and Flipping Images
The image in the active image window can be rotated or flipped as described below.

Rotating Images

Click the  tool or select 90 degrees CW from the Rotate submenu to rotate the image in the
active window ninety degrees to the right.  Click the  tool or select 90 degrees CCW from the
Rotate submenu to rotate the image in the active window ninety degrees to the left.

Flipping Images

Use the commands in the Flip submenu to flip the image in the active window horizontally or vertically.

→
Image before rotation

Image rotated ninety
degrees clockwise
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The Information Window
The information window shows the position and color of the pixel under the mouse pointer.

To display or hide the Information window, select Information from the View menu.

x-y coordinates
Red
Green
Blue
Average

x-y coordinates:
The position of the cursor in the image window, measured in pixels from the top
left corner of the image.

R, G, B, Avg: The values for each of the red, green, and blue elements of the pixel under the
cursor and the average of the three, weighted according to the properties of hu-
man color perception (the weighted average is calculated as (Red × 0.299) +
(Green × 0.587) + (Blue × 0.114)).  Depending on the selected color space, the
average may not reflect the actual luminance of the pixel under the cursor, but it
can be used as a rough guide to brightness.  Values for R, G, B, and the average of
the three range from 0 to 255, with values for twelve-bit images being scaled to fit
in this range.  The number on the left is the input value, or value for the color in the
original image.  The value in the right is the output value, or value after any changes
in the Curves or Color Balance windows have been applied.
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Selecting a Crop
Using the crop tool, you can select a portion of the image to be saved to disk in a separate file.  If no
selection is made, the entire image will be saved.  The crop tool can be used in image windows and in
the Preview section of the Image window.

1 Click the  tool or select Selection Cursor from the View menu.
The mouse pointer will change to crop cursor (+) when moved over the image in the Preview
section of the active window.

2 Drag the mouse to select a crop.
Your selection will be marked by a dotted line.

Saving the Crop to a Separate File

Unless the image is saved in NEF, only the selected portion of the image will be saved.  When images
are saved in NEF, the entire image will be saved together with information on the position and
dimensions of the current crop.
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Cancelling the Current Crop

To cancel the current crop and select the entire image, click outside the current crop or choose Select
Entire Image from the Image menu.  Note that you may not be able to select the entire image when
Keep my output size is selected in the Size/Resolution window.

Moving the Crop

To move the crop over a different part of the image, move the pointer over the crop.  The pointer will
change to a  (Windows) or  cursor (Macintosh).  Drag the crop to move it to a new position.

Changing the Size of the Crop

To change the size of the current crop, move the pointer over the borders of the crop.  The pointer will
change to a double arrow.  Drag the borders of the crop to adjust its size.
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Output Size and Resolution
The Size/Resolution window is where you specify the final (“output”) size of the image in the active
window.  The output size specifies the physical dimensions of the current crop when displayed on a
monitor or printed at the specified resolution.  The resolution should be set to match the resolution of
the printer (for example, 300 or 600 ppi) or monitor (usually 72 or 96 ppi).

1 Select Size/Resolution from the View menu.
The Size/Resolution window will be displayed.

Specifying Output Size in Pixels

If pixels is selected as the unit for output size, you will not be able to change the resolution.

2 Enter a value for width or height and adjust the output resolution to match the output device.
Changes to size and resolution will be reflected instantaneously in the figures for scale (output size
as a percentage of original) and file size.

Changes to size and
resolution reflected

instantaneously
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Image Adjustment
Nikon Capture 2 offers basic image adjustment tools, including tone compensation and unsharp mask.
The higher the quality of a captured image when saved to disk, the less significant the loss of quality
when the image is retouched in another application such as Photoshop.  One of the most notable
features of Nikon Capture 2 is its support of NEF, which allows the original image data to be saved
exactly as originally captured.  Information on any changes made in Nikon Capture 2 saved is separately
in the same file.

RAW Images

RAW images can be edited to remove color casts or change the exposure compensation value or tone
curve selected when the photograph was taken.  These tasks are performed using the tools in the
White Balance and Advanced RAW windows.  White balance can be adjusted by specifying a color
temperature or by editing red and blue gain for the entire image.  The Advanced RAW window is used
to change the options selected for image sharpening, tone compensation, and other settings when the
picture was taken.

Tone, Color Balance, and Contrast

Adjustments to brightness, contrast, and color balance are made in the Curves or Color Balance win-
dow.  Using the tools in the Curves window, you can adjust the tone curves that map between input
and output levels for precise control of tonal information for the image as a whole and for each color
channel.  These tools are best suited to experienced users or to complicated color editing tasks.  The
Color Balance window can not be used to edit tone curves directly, but instead offers easy-to-use tools
for adjusting brightness, contrast, and color balance over the entire image.

Unsharp Mask

If an image lacks overall definition and sharpness, you can use the tools in the Unsharp Mask window to
sharpen outlines.

Using Unsharp Mask

When checking the results of unsharp mask in the monitor, set the zoom ratio in the active window
to 100%.

Curves and Color Balance

Changes to Curves and Color Balance can not be applied simultaneously to a single image.  Choose
the tool suited to your level of experience and the task at hand.
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Basic Image Adjustment Operations

This section describes operations common to the White Balance, Advanced RAW, Curves, Color Balance,
and Unsharp Mask windows.

Viewing the Image Adjustment Windows
To hide or view all image adjustment windows currently on display, press the tab key.

Settings for Newly Captured Images
The settings that apply when an image is captured are determined by the option selected in the Settings
for Next Camera Image panel in the General tab of the Preferences dialog.  You can choose to use the
values in the default image settings file or the settings that applied to the previous image.

Applying Changes
Settings in the White Balance, Advanced RAW, Curves, Color Balance, and Unsharp Mask windows can
only be adjusted, and changes to settings applied, if the Apply button for the window is checked.  If the
Apply button is off, the effects of changes to settings will not be visible and no adjustments to settings
can be made.  Before making changes to settings, click the Apply button once to turn it on.  Note that
Curves and Color Balance can not be applied simultaneously to a single image.

Click to turn Apply button on or off

Apply button off Apply button on

Hiding Changes
Changes to the image in the active window can be hidden by clicking and holding the Show Original
Image Data tool button ( ) in the toolbar (Windows) or tool palette (Macintosh).  The original image
will be displayed only while the button is held down, allowing quick “before-and-after” comparisons that
help you to determine whether adjustments to the image are having the desired effect.

Windows toolbar

Macintosh tool palette

Show Original Image
Data tool button

Show Original Image Data tool
button

↔
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The White Balance Window

To display the White Balance window, select White Balance from the View menu.  White balance for
RAW images can be adjusted by specifying a color temperature or by sampling the image for a “gray
point” (i.e., the color that will appear as neutral gray in the final image).  To choose a specific color
temperature, select Set Color Temperature from the pop-up menu at the top of the White Balance
window.

White Balance

White balance can be performed on RAW images only.  The Apply button in the White Balance
window is not available if the image in the active window is JPEG or TIFF.

To sample the image for the gray point, select Set Gray Point from the pop-up menu.

Pop-up menu

Pop-up menu
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The Advanced RAW Window

To display the Advanced RAW window, select Advanced RAW from the View menu.

Advanced RAW

The options in the Advanced RAW window apply to RAW images only.  The Apply button in the
Advanced RAW window is not available if the image in the active window is JPEG or TIFF.

The tools in the Advanced RAW window can be used to change the exposure compensation, image
sharpening, tone compensation, color mode, and hue adjustment from the values in effect at the time
the photograph was taken.  Select new settings from the pop-up menus or using the sliders.  If the Apply
button is off, the values in effect at the time the photograph is taken will be used.
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The Curves Window

To display the Curves window, select Curves from the View menu.

Apply button Current channel

View edited histogram

Auto contrast

White point

Midpoint

Black point

Resetting All Curves to Linear

Tone curves for the RGB master channel and each of the red, green, and blue channels can be selected
from the pop-up menu at the top of the Curves window.  The sliders at the bottom and left side of the
curve edit display are used to adjust the black point, midpoint, and white point to suit the distribution of
tones in the image.  Adjustments can be made to specific portions of the tone range by editing the
curves directly.  The histogram behind the curve edit display can be used to compare the distribution of
tones in the original image with the tone distribution after editing.

Curves and Color Balance

When the Apply button in the Curves window is on, the Apply button in the Color Balance window
will turn off automatically.  Changes to Curves and Color Balance can not be applied simultaneously
to a single image.

Resetting the Active Curve to Linear
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The Color Balance Window

To display the Color Balance window, select Color Balance from the View menu.

Apply button

Brightness

Contrast

Red

Green

Blue

Adjustments can be made to brightness, contrast, and color balance using the sliders or by entering
values directly in the text boxes to their right.

Curves and Color Balance

When the Apply button in the Color Balance window is on, the Apply button in the Curves window
will turn off automatically.  Changes to Curves and Color Balance can not be applied simultaneously
to a single image.
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The Unsharp Mask Window

To display the Unsharp Mask window, select Unsharp Mask from the View menu.

Unsharp Mask list

Apply button

Unsharp masks can be applied selectively to different color channels.
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High

Uncompressed

Saving Images
Nikon Capture 2 supports a variety of file formats.  Images displayed in Nikon Capture 2 can be saved
in a file format that suits the end in view.  Hints for choosing a file format may be found on the pages that
follow.

File Format and Image Quality

The relationship between the camera image quality setting and the file format used by the camera is
shown in the following table:

Compression

Uncompressed

Compressed

Image QualityCamera File FormatImage Quality Setting

Low

Medium

High

TIFF

NEF
(Nikon Electronic Image Format)

JPEG (DCF†)

RGB-TIFF
YCbCr-TIFF

RAW (uncompressed)*

RAW (compressed)*

FINE

NORMAL

BASIC

* Whether compression is available in at an image-quality setting of RAW depends on the make of
camera.  Compression is only available with the D1X and D1H; the D1 does not support com-
pression.

† DCF (Design Rule for Camera File Systems): an industry-wide standard for digital camera file
systems.

Note that saving JPEG-compressed images in an uncompressed format such as TIFF will not result in
improved image quality (  pg. 88).

Low
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Options for Saving Image Files

Nikon Capture 2 offers two options for saving files: Save and Save as….  The Save command can be
used when saving images opened in Nikon Capture 2 using the Open… command.  If this command
is selected when the image in the active window has yet to be saved to the computer’s hard disk, the
Save As dialog will automatically be displayed.  The Save as… command can also be used to save an
existing file under another name or in a different format or location.

Nikon Capture 2 supports the following file types when saving images:

File Type ExtensionCompression

16-bit TIFF (RGB)
8-bit TIFF (RGB)

.TIFUncompressed

NEF
(Nikon Electronic Image Format)

.NEFUncompressed

JPEG (Exif-compliant) .JPGCompressed

TIFF (CMYK) .TIFUncompressed

BMP (Windows only) .BMPUncompressed

JPEG (JFIF-compliant) .JPGCompressed

PICT (Macintosh only) .PIC
Choice of compressed or

uncompressed

Choosing a File Type

Nikon Electronic Image Format (NEF)
All images, including those taken at an image quality setting of RAW, can be saved in Nikon Electronic
Image Format (NEF).  NEF images can only be opened in Nikon View 4 or Nikon Capture 2, or in
Adobe Photoshop 5.0 or later (Photoshop LE excluded) using the Nikon NEF filter supplied with
Nikon View 4.

Images saved in NEF format maintain the high quality of the original photograph; adjustments to White
Balance, Advanced Raw, Curves, Color Balance, Unsharp Mask and Size/Resolution settings are not
applied to the original image data, but are instead saved separately in the same file.  NEF images can
later be opened in Nikon Capture 2 and saved again in a format that can be opened in other applica-
tions.  As changes to settings are only applied to the original image data when the image is saved in
another format, this minimizes any loss of image quality that may be produced when the image is edited.
Save images in NEF whenever you are unsure of how they will be used or when you want to process
the original image in a number of different ways.

JPEG, TIFF, BMP, and PICT

Images saved in these formats can not be opened in Nikon Capture 2.
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TIFF
Use TIFF when saving images for high-quality output or publishing.  Although the lack of compression
will result in larger files, image quality will be maintained at a high level.  TIFF also preserves the ICC
profile and caption information.  This format is supported by a wide variety of applications on a variety
of platforms.

JPEG
This file type is adequate for images that will be output at low resolution or distributed in electronic
form.  Compression allows more images to be saved in the same amount of disk space while preserving
the ICC profile and caption information.  Note, however, that JPEG compression results in loss of image
information that can not afterwards be restored.  Save files at the lowest compression ratio possible; if
necessary, you can always save them again at a lower compression ratio.  EXIF is an extension of the
JPEG format that allows thumbnail data and information about the image to be included in a JPEG file.

BMP
BMP, the generic image format used on Windows computers, is available only in the Windows version
of Nikon Capture 2.  Most Windows users will be able to view files of this type.  Note that the ICC
profile and caption information are not saved when images are converted to BMP.

PICT
PICT, the generic image format used on Macintosh computers, is available only in the Macintosh version
of Nikon Capture 2.  Most Macintosh users will be able to view files of this type.  Unlike BMP, PICT
supports compression and allows inclusion of the ICC profile and caption information.



89

Using the “Save” and “Save as…” Commands

Images can be saved using Save or Save as….  The Save option saves the image in the same location
as the original without changing the file name or format.  The Save as… option lets you choose a
location, file name, and format.  If you attempt to save an image in the Camera Image window
(  pg. 145) using the Save command, the Save As dialog will automatically be displayed.

1 Click the  tool or select Save from the File menu.
The Save dialog for your platform will be displayed.

2 Navigate to the desired folder.

3 Choose a file type (file format) from the pop-up menu.
See “Choosing a File Type” (  pg. 87) for more information.
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4 Choose whether to compress the image (PICT only).
If the selected file type is PICT (available only in the Macintosh version of Nikon Capture 2), you can
choose to compress the image by selecting the Use Compression option.

5 Choose a compression ratio.
If you have chosen a file type that supports compression (JPEG or PICT), you can select a compres-
sion ratio from “Highest Compression Ratio,” “Good Compression Ratio,” “Good Balance,” “Good
Quality,” and “Excellent Quality.”

6 Enter a file name.
The default file name appears in the File name text box.  A new file name can be entered if
desired.

7 Click Save.
Click Save to save the file under the specified name.
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Save Options
In addition to the settings listed on previous pages, the following options are available in the Save As
dialog:

Bit depth

Add to Database

Bit depth: Gives the bit depth (the number of bits of color information per channel for each
pixel in the image) at which the image will be saved.  The 16-bit option is only
available if the selected file type is TIFF format (RGB) and the original image has
a bit depth of over eight bits.

Open in External Application:
If Open saved Image in external application is selected in the File Locations
tab of the Preferences dialog, the name of the selected application (e.g., Adobe
Photoshop 5.0) will be displayed.  This option can not be selected if the chosen file
format is NEF.  If this check box is on, the image will automatically be opened in the
selected application after being saved to disk.

Add to Database:
If this option is checked, the image will be catalogued in Canto Cumulus 5 as it is
saved.  This option is only available if: Canto Cumulus 5 is installed,  Add saved
images to Canto Cumulus 5 has been selected in the File Locations tab of the
Preferences dialog, and a Canto Cumulus 5 catalog file has been selected.  If any of
the above conditions are not met, this option will not be available.

Add the following to the existing IPTC Caption:
Text to be included with the file.  This information can be displayed in the Adobe
Photoshop file information caption.  The information in this text box will be added
at the end of any existing information.

Open in External
Application

Add the following to the
existing IPTC Caption
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Quitting Nikon Capture 2

Windows

Select Exit from the File menu.

Other Options for Quitting Nikon Capture 2 (Windows)

To exit the Windows version of Nikon Capture 2, you can also:
• Click the close button at the top right corner of the Nikon Capture 2 window
• Click the icon at the top left corner of the Nikon Capture 2 window with the right mouse button

and select Close from the menu that appears.

Macintosh

Select Quit from the File menu.
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This chapter describes how to use Nikon Capture 2 to perform image adjustment operations on
photographs taken with your Nikon digital camera.

Image Adjustment
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Before they will be ready for display or output on a monitor or printer, images captured from the
camera will usually need to be adjusted to a size and resolution appropriate to the task at hand.  Other
settings, such as white balance, contrast, and sharpness, may also require adjustment.  The settings that
can be adjusted depend on the image quality setting in effect when the photograph was recorded.
Photographs taken at an image-quality setting of RAW can be processed to adjust white balance or to
alter exposure compensation, image sharpening, tone compensation, color mode, and hue adjustment
from the settings in effect at the time the photograph was taken.  All images can be processed to adjust,
tone curves, color balance, sharpness, and size and resolution.

98

Window

White Balance

Image Quality

RAW

Process

Adjust white balance.

Advanced RAW 104
Choose new settings for exposure compen-
sation, image sharpening, tone compensation,
color mode, and hue adjustment.

Unsharp Mask 123

If the image lacks definition, you can sharpen
outlines using the controls in the Unsharp
Mask window.  Unsharp mask only be applied
at the last step, after all other adjustments
have been made.

Adjust tone, color balance, and contrast.
There are two distinct tools for this task: the
Curves window, which provides precise con-
trol over tone, and the Color Balance win-
dow, which features simpler controls.

Curves 108

Color Balance 119

Size/Resolution 127
Adjust the size and resolution of the image
for output on a particular device.

RAW
RGB-TIFF

YCbCr-TIFF
FINE

NORMAL
BASIC

When the edited image is saved to disk using the Save as… command, you can choose the color
model (RGB or CMYK) and the bit depth (RGB images only) for the final image.  If the image is saved
in NEF format, the original image data will be saved exactly as recorded by the camera, with changes to
image adjustment settings stored separately in the same file.
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Image Adjustment Control Panel
Using the Image Adjustment Control Panel, you can readily display any of the image adjustment control
windows and turn the adjustments in each window on and off.  The Image Adjustment Control Panel
can also be used to save settings for multiple image adjustment windows in a single file and recall these
settings as desired.  These settings can be used for batch processing, as described in the following
chapter (  pg. 131).

Viewing the Image Adjustment Control Panel

To display the Image Adjustment Control Panel, click the  button or select Image Adjustment
Control Panel from the View menu.

White Balance / Advanced Raw

The Apply check boxes for White Balance and  Advanced Raw are only active if the image in the
active window was captured at an image-quality setting of RAW.

Links: Click the links in the Image Adjustment Control Panel to display the selected image
adjustment window.

Apply check boxes:

Click the Apply check boxes to turn adjustments for the selected window on or off.
The settings in the selected image adjustment window will be applied to the image
in the active window when the box to the right of the window name link is checked.
Note that because Size/Resolution settings always apply, they can not be turned off
in the Image Adjustment Control Panel.

Apply check boxesLinks
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Saving and Loading Settings from the Image Adjustment Control Panel

Settings for the items currently checked in the Image Adjustment Control Panel can be saved in a single
file and recalled as desired.  These settings can also be used for batch processing, as described in the
following chapter (  pg. 131).  To save or recall settings, select Image Adjustments from the Set-
tings menu to display a sub-menu containing the following options:

Apply Button Status

The information saved in the joint settings file includes the status of Apply button for each image
adjustment window.  When the file is loaded, the settings in each window will be turned on or off to
reflect the status of the Apply button when the settings were saved.

Right-Button Menu (Windows)

In the Windows version of Nikon Capture 2, the Image Adjustment Control Panel menu can be
displayed by right-clicking in the Image Adjustment Control Panel.
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Load…: Select this item to load settings previously saved using the Save… option (see
below).  A dialog will be displayed where you can navigate to the drive (volume)
and directory containing the desired settings file (in the Windows version of Nikon
Capture 2, only files with the extension “.set” will be displayed).  The settings in the
Image Adjustment Control Panel window will instantly revert to the saved settings.

Save…: Select this item to save settings to a named file.  These settings can later be recalled
using the Load… option.  Choosing Save… displays a dialog where you can
choose a destination and file name for the current settings (in the Windows ver-
sion of Nikon Capture 2, size and resolution settings are saved with the extension
“.set”).  If this file can later be selected for batch processing, images will be pro-
cessed according to the settings in the file (  pg. 135).
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White Balance
The tools in the White Balance window are used to adjust white balance for RAW images.  Using these
tools, not only can you correct white balance when the setting chosen with the camera failed to
produce the desired effect, you can also deliberately alter white balance to introduce a cold or warm
cast into the image.  White balance can be adjusted by specifying the desired color temperature or by
sampling the image for the gray point.

Specifying a Color Temperature

1 Select White Balance from the View menu.
The White Balance window will be displayed.  Select Set Color Temperature from the pop-up
menu at the top of the window.

Displaying the Color Temperature

When the Show degrees Kelvin for White Balance option is checked in the Advanced Color
tab of the Preferences dialog, the color temperature is displayed in the White Balance and Fixed
White Balance windows.

White Balance

White balance can be performed on RAW images only.  If the image in the active window is JPEG or
TIFF, the Apply button in the White Balance window will be grayed out and inactive.

2 If the Apply button is off, turn it on.

Apply button

Sub menu

Color temperature

Pop-up menu
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3 Adjust white balance using the options in the White Balance window.

Camera WB: Shows the white balance setting in effect at the time the photograph was taken
and the amount of fine-tuning performed.

New WB: The white balance setting to be applied to the captured image can be chosen from
the options listed in the table below.  When Daylight, Standard Fluorescent,
or High Color Rendering Fluorescent is selected, white balance can be fine-
tuned by selecting an option from the sub-menu.

Fine Adjustment:White balance can be fine-tuned using this slider.  This option is not available when
Use Gray Point or Recorded Value is selected for New WB.  White balance
can be adjusted by ±50 mired (a unit of color temperature equivalent to 106 di-
vided by the temperature in degrees Kelvin; for example, 5000 K is equivalent to
200 mired).  Note that color temperature can not be raised above 9066 K, and
that a setting of Flash can be fine-tuned in the range  of 4277 K–7479 K.

The Apply Button

Changes to white balance only take effect when the Apply button at the top left corner of the White
Balance window is checked.  When this button is checked, any changes to white balance will be
visible immediately in the image in the active window.  The Apply button can be turned on and off for
a quick “before-and-after” comparison, allowing you to determine whether changes are having the
desired effect.

Recorded Value

New WB

—

Sub-menu

—

Color
Temperature

The value chosen for white balance
when the photograph was taken is
used.

Notes

Daylight

Direct sunlight

Cloudy

Shade

5,200 K

6,000 K

8,000 K

Use with direct sunlight.

Use under overcast skies.

Use in the shade on sunny days.

Standard
Fluorescent,
 High Color
 Rendering

 Fluorescent

Warm White

3700K

Cool White (4100K)

5000K

Daylight (6500K)

3,000 K

3,700 K

4,100 K

5,000 K

6,500 K

Suited to fluorescent lighting, includ-
ing lighting with a noticeable color cast.
The type of bulb can be chosen from
a sub-menu of five options.

Flash — 5,400 K Use with Nikon Speedlights.

Incandescent — 3,000 K Use with incandescent light.

Use Gray Point — —
The value for white balance chosen in
the grey-point selection dialog is used
(  pg. 100).
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Sampling the Image for Gray Point

1 Select Set Gray Point from the pop-up menu at the top of the White Balance window.

2 If the Apply button is off, turn it on.

Sample Size

The size of the area sampled with the eyedropper cursor can be set using the Dropper sample
size option in the Advanced Color tab of the Preferences dialog.

3 Sample the image to choose a reference point for white balance.
You can define white balance using a single point or the average of several points.  During sampling,
the values for red (R), green (G), and blue (B) for the pixel under the cursor will be shown in the
White Balance window.  Refer to these values when selecting the point or points to be sampled.

Using a Single Point to Define White Balance
After selecting Use a single point, click Start.  The cursor will take the shape of an eyedropper
( ) when moved over the image in the active window.  Click a point that you would like to appear
a neutral gray color in the final image.  The new value for white balance will be reflected in the image
in the active window.

Using the Average of Several Points to Define White Balance
After selecting Average several points, click Start.  The cursor will take the shape of an eye-
dropper ( ) when moved over the image in the active window.  You can then sample points that
should be a neutral gray color in the final image.  If you select more than one point, the average will
be used to determine white balance.  After sampling all the desired points, click Stop.  The new
value for white balance will be reflected in the image in the active window.

Pop-up menuApply button

Reset button

Sliders
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Gain for the red and blue channels will be adjusted based on the points sampled, changing the slope
of the red and blue tone curves and the position of the red and blue sliders.

White balance can also be adjusted by moving the red and blue sliders or by entering a value from
0.1 to 10 in the text boxes to their right.

Reset button: Click this button to reset the red and blue curves to the default value for gain (1.0).

Red slider/Blue slider:
Adjust gain by moving these sliders or entering a value from 0.1 to 10 in the text
boxes to their right.

Choosing a Value for Gain

Very large and small values for gain can result in a drop in image quality.  We recommend values
between 0.25 and 4.0.

Gain

The values for red and blue gain chosen in the White Balance window are multiples of the value set
for gain when the photograph was taken.
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The White Balance Settings Menu

Selecting White Balance from the Settings menu displays a sub-menu of options that can be used
to save and recall white balance settings or to restore the value for white balance in effect at the time
the photograph was taken.

Right-Button Menu (Windows)

In the Windows version of Nikon Capture 2, the White Balance menu can be displayed by right-
clicking in the White Balance window.
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Load…: Select this item to restore white balance to settings saved using the Save… option.
A dialog will be displayed where you can navigate to the drive (volume) and direc-
tory containing the desired settings file (in the Windows version of Nikon Capture
2, only files with the extension “.nwb” will be displayed).  The settings in the White
Balance window will instantly revert to the saved settings.

Save…: Select this item to save current white balance settings to a named file.  These
settings can later be recalled using the Load… option.  Choosing Save… displays
a dialog where you can choose a destination and file name for the current white
balance settings (in the Windows version of Nikon Capture 2, white balance set-
tings are saved with the extension “.nwb”).

Reset to Recorded Value:
Selecting this item restores the value for white balance in effect at the time the
photograph was taken.

Apply Button Status

The status of the Apply button is not recorded when white balance settings are saved.  If you save
white balance settings with the Apply button in the White Balance window on and later load these
settings with the Apply button off, the saved settings will be loaded but the status of the Apply button
will not change.  The saved settings will not apply to the image in the active window until you open
the White Balance window and turn the Apply button on.
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Advanced RAW
The options in the Advanced Raw window are used to alter exposure compensation, image sharpening,
tone compensation, color mode, and hue adjustment from the settings in effect at the time the photo-
graph was taken.

1 Select Advanced RAW from the View menu.
The Advanced Raw window will be displayed.

Advanced RAW

Advanced RAW can be performed on RAW images only.  If the image in the active window is JPEG
or TIFF, the Apply button in the Advanced Raw window will be grayed out and inactive.

2 If the Apply button is off, turn it on.
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3 Choose the desired Advanced RAW settings.

Exp Comp: Choose a value from –2 to +2 EV using the slider or enter a value in the text box
to its right.

Sharpening: Choose from Unchanged, None, Low, Normal, or High.  In the case of pho-
tographs taken with the D1, Normal is equivalent to None.

Tone Comp: Choose from Unchanged, Normal, Less Contrast, More Contrast, or User-
Defined Custom Curve.  Because the D1 does not store custom curves in the
image file, settings of User-Defined Custom Curve and Unchanged are equiva-
lent to Normal when selected with photographs taken with the D1.  With the
D1X and D1H, selecting Unchanged restores the tone curve in effect at the time
the photograph was taken.

Color Mode: Choose from Unchanged, D1 Mode (NTSC), Mode I (sRGB), or Mode II
(Adobe RGB).  In the case of images taken with the D1, Unchanged is equiva-
lent to D1 Mode (NTSC).

Hue Adjustment:
This setting simulates the camera’s hue adjustment setting by modifying hue while
leaving brightness and chroma unaffected.  Changes to this setting have no effect
when Custom Setting 3 is selected.  To use the value for hue adjustment in effect at
the time the photograph was taken, turn the Hue Adjustment check box off.

Hue Adjustment

The hue adjustment option in Nikon Capture 2 allows hue to be adjusted without affecting luminos-
ity or chroma.

The Apply Button

Changes to Advanced Raw only take effect when the Apply button at the top left corner of the
Advanced Raw window is checked.  When this button is checked, any changes to Advanced Raw will
be visible immediately in the image in the active window.  The Apply button can be turned on and off
for a quick “before-and-after” comparison, allowing you to determine whether changes are having
the desired effect.
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The Advanced Raw Settings Menu

Selecting Advanced Raw from the Settings menu displays a sub-menu of options that can be used
to save and recall Advanced Raw settings or to restore the values in effect at the time the photograph
was taken.

Apply Button Status

The status of the Apply button is not recorded when Advanced Raw settings are saved.  If you save
Advanced Raw settings with the Apply button in the Advanced Raw window on and later load these
settings with the Apply button off, the saved settings will not apply to the image in the active window
until you turn the Apply button on.

Right-Button Menu (Windows)

In the Windows version of Nikon Capture 2, the Advanced Raw menu can be displayed by right-
clicking in the Advanced Raw window.

Load…: Select this item to restore Advanced Raw settings to settings saved using
the Save… option.  A dialog will be displayed where you can navigate to
the drive (volume) and directory containing the desired settings file (in the
Windows version of Nikon Capture 2, only files with the extension “.nar”
will be displayed).  The settings in the Advanced Raw window will instantly
revert to the saved settings.

Save…: Select this item to save current Advanced Raw settings to a named file.
These settings can later be recalled using the Load… option.  Choosing
Save… displays a dialog where you can choose a destination and file name
for the current white balance settings (in the Windows version of Nikon
Capture 2,  Advanced Raw settings are saved with the extension “.nar”).

Reset to Neutral: Selecting this item restores the settings in effect at the time the photograph
was taken.  In the case of the D1, image sharpening will be set to None.
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Curves
Although your Nikon digital camera will reproduce colors accurately if settings have been adjusted
appropriately, it will usually be necessary to adjust contrast, tone (brightness) levels, and color balance to
make maximum use of the tone range and color gamut offered by a particular output device, such as a
printer or monitor.  Nikon Capture offers two tools for performing these tasks: the Color Balance
window (see “Color Balance” later in this chapter) and the Curves window.   Of the two, the Curves
window offers the more precise control.  The Color Balance window is useful when, for example, you
want to adjust brightness or color balance for all pixels in the image.  The Curves window, in contrast,
allows adjustments to be made to specific portions of the tone range, making it possible to enhance the
image while preserving detail.

Curves and Color Balance

Color balance and curves can not be used together.  If the controls in the Curves window are active,
the controls in the Color Balance window are disabled.  If the Color Balance controls are active, the
controls in the Curves window are disabled.  Only one of color balance or curves can be applied
when a modified image is saved.

The Apply Button

Changes to curves only take effect when the Apply button at the top left corner of the Curves
window is checked.  When this button is checked, any changes to curves will be visible immediately
in the image in the active window.  The Apply button can be turned on and off for a quick “before-
and-after” comparison, allowing you to determine whether changes are having the desired effect.

Resizing the Curves Window

The Curves window can be resized by dragging its borders (Windows) or by dragging the handle at
the lower right corner of the window (Macintosh).  The curves edit display changes with the size of
the window, allowing you to enlarge the display to a maximum of 256 × 256 pixels.  At this size, each
of the 256 points on the tone curve is represented by a separate pixel, granting maximum precision
when editing curves.
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Curves—an Overview

To open the Curves window, choose Curves from the View menu.

Apply button Current channel

Curve edit display

The main editing tool in the Curves window is the curve edit display, which contains a curve showing
the relationship between input (the tones in the original image) and output (how the tones in the input
will be represented in the final image).  Separate curves control the relationship between input and
output for the image as a whole (the “master curve”) and for each of the red, green, and blue color
components, or “channels.”  The default curve in each case is linear, meaning that tones will be output
exactly as they are input.

The Curve Edit Display

Although values for input and output in the Curves window range from zero to 255 (eight-bit
precision, familiar to users of other image editing software), the results of any changes to curves are
calculated at a precision of sixteen bits.  This allows twelve-bit RAW data to be modified without
lowering the quality of the output.
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Input is plotted along the horizontal axis, with shadows (the dark areas of the image) to the left,
highlights (the bright areas of the image) to the right, and mid-tones in between.  The left end of the axis
marks the minimum possible value for colors in the selected channel (zero, or no color), the right end
the maximum value.  In the case of the master curve, the minimum value represents areas of the input
image that are a true black; the maximum value represents areas that are a true white.  Output is
plotted along the vertical axis, with the minimum possible output value (again, zero, or no color) at the
bottom and the maximum output value at the top.

When the cursor is moved over the curve edit display, the input and output values for the point under
the cursor are shown in the input/output display.  The input value represents the level of the pixel in the
original image, the output value the level of the pixel after any changes to the curve have been applied.
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Viewing the Histogram

The first step in adjusting tone levels and color balance in the Curves window is to view the histogram
displayed in the background of the curve edit display.  The histogram tells you what tones are present in
the original image and in what amounts, information that you will use when setting the black point and
white point and editing curves.  The histogram takes the form of a bar graph.  The horizontal axis gives
the tone level, with shadows to the left and highlights to the right.  The vertical axis gives the number of
pixels of each tone level found in the image, scaled to fit in the curve edit display.

By assigning the darkest tones in the image an output value of zero and the brightest tones in the image
an output value of 255, blacks will be output as blacks and whites as whites, making the most effective
use of the dynamic range of the output device.

To view the distribution of tones in the final, output image after changes to curves, click and hold the
histogram button ( ).

Channel Selection

You can modify tones for all colors in the image using the master curve, or select any
of the red, green, and blue curves for editing using the channel menu.  The histogram
shows tone levels for the selected channel only.  When the master curve is selected,
the auto-contrast button and white-point and black-point eyedropper tools apply
simultaneously to all of the red, green, and blue curves (the master curve is unaf-
fected).  When one of the red, green, and blue curves is selected, these controls can
be used to edit the selected curve only.

Histogram button

Channel Selection Shortcuts

The current channel can also be selected using the following shortcuts:
• Ctrl ~ (Windows)/  ~ (Macintosh)

Master channel (RGB)
• Ctrl 2 (Windows)/  2 (Macintosh)

Green channel (RGB)

• Ctrl 1 (Windows)/  1 (Macintosh)
Red channel (RGB)

• Ctrl 3 (Windows)/  3 (Macintosh)
Blue channel (RGB)
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Setting the White Point and Black Point

The endpoints of the curve are referred to as the “white point” and the “black point.”  The black point
for a given channel represents the darkest shade (minimum value) for that color, the white point, the
brightest shade (maximum value).  By default, the input and output values for the black point are zero.
The darkest shade in the input image may however be greater than zero, with the result that a portion
of the curve is dedicated to reproducing tones not actually present in the image.  Increasing the input
value for the black point until it matches the darkest shade in the image will steepen the curve, enhanc-
ing overall contrast without causing a corresponding loss of detail in shadows.  Similarly, if the original
image does not actually contain shades corresponding to the maximum value, the white point can be
lowered to match the brightest shade in the image.

There are two steps to selecting a white point and black point for the final image: choosing the white-
point and black-point input levels, and selecting output levels.

White-Point and Black-Point Input Levels
Input levels for the white point and black point can be set using any of the following three methods:
• automatic contrast adjustment
• white-point and black-point sliders
• direct sampling using the white-point and black-point eyedropper tools

Automatic Contrast Adjustment
In automatic contrast adjustment, Nikon Capture 2 automatically selects white and black points that
exclude a certain percentage of the brightest and darkest pixels in the image, steepening curves for
enhanced contrast (the exact percentage of pixels excluded can be specified in the Preferences dialog;
see “Preferences,” below). By default, 0.5% of the brightest and darkest pixels are excluded, producing a
curve that makes optimal use of the output tone range while preserving details in shadows and high-
lights.

To perform an auto contrast operation, click the auto contrast button ( ). The white and black points
for each of the red, green, and blue channels will be modified simultaneously and the master curve will
be displayed in the Curves window (the master curve itself is unaffected by this operation). Clicking the
button with the Ctrl (Windows) or option (Macintosh) key held down adjusts contrast only for the
channel currently selected in the channel menu.
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White-Point and Black-Point Sliders
The white-point and black-point sliders can be used to match the white and black points to the histo-
gram displayed in the curve edit display.  While these sliders can be used to edit curves for any channel,
the best results are usually obtained when they are used to modify the master curve.

To edit the white point or black point, click the corresponding slider once to activate it, then drag it to
the right or left (a value can also be entered directly in the text box underneath the slider).  Matching
the black-point slider with the lowest input value displayed in the histogram will set the minimum
output value for the selected channel to the darkest pixel actually present in the image, steepening the
curve and enhancing contrast without sacrificing detail in shadows.  Similarly, matching the white-point
slider with the highest input value displayed in the histogram will set the maximum output value for the
selected channel to the brightest pixel present in the image, enhancing contrast without loss of detail in
highlights.  Any changes are applied instantly to the active image.

Black-point slider White-point slider
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Sampling the Image for White Point or Black Point
The white point or black point can be set by directly sampling the image, allowing you to choose the
pixels that will be used to set the maximum (white point) or minimum (black point) output value.  This
makes it possible to set the black point by matching it to a pixel in the darkest part of the image
containing detail you want to preserve, eliminating details in darker areas that are not important to the
final image.  Similarly, you can match the white point to a pixel in the brightest area of the image
containing details important to the final image.  While direct sampling can be used with any channel, it
is most effective when used with the master curve.  When the master curve is selected, sampling will set
the white or black point for red, green, and blue curves simultaneously; the master curve itself is unaf-
fected.

To sample the white point, click the white-point button ( ).  When the cursor is moved over the active
image, it will take the shape of an eyedropper.  Move the cursor over the image to find the pixel that you
want to use to set the white point, keeping an eye on pixel level display in the Information window to
identify pixels with high input values.  With the cursor over the target pixel, click the mouse button.  The
input value for the selected pixel will be used as the input value for the white point.  The cursor will
return to its original shape, and the image will automatically be altered to reflect the new value for white
point.

To sample the image for the black point, click the black-point button ( ) and move the eyedropper
cursor over the image until you find the point that you want to use to set the minimum input value, then
click the mouse button to select the black point.

Setting the White Point or Black Point for the Current Channel

By default, sampling sets the white point or black point for all channels and displays the master
channel.  To set the white point, midpoint, or black point for the current channel only, sample the
image while holding down the Ctrl key (Windows) or option key (Macintosh) on the keyboard.
Note that midpoint can not be sampled for a single channel; regardless of the channel currently
selected in the channel menu, sampling the image for midpoint always sets the midpoint for all
channels and displays the master channel.
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White Point and Black Point Output Levels
Once you have set the input level for the black point and white point, output levels can be altered to
reflect the actual shade of the darkest and brightest pixels in the image.  If the darkest shade in the
image represents a true black, for example, the output level for the black point can be left at zero.  If,
however, darkest shade present in the image is a lighter color, the output level for the black point can be
raised to achieve more natural coloration.

The output levels for the white point and black point are set using the white-point and black-point
output sliders on the left side of the curve edit display.

To set the output level, click the slider once to activate it, then drag it up or down until you have found
the desired output level (the output level can also be set by entering a value directly in the text box to
the left of the slider).  The effects of the change will be reflected in the active image.

White-point output slider

Black-point output slider
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Setting the Midpoint

The point midway between the maximum and minimum input values is known as the “midpoint,” which
represents a neutral shade corresponding to an output level of 128. The midpoint is controlled by a
midpoint slider at the bottom of the curve edit display.  Moving the midpoint slider to the left increases
the brightness of mid-tones without “washing out” highlights.  Moving the slider to the right darkens
mid-tones without obliterating detail in shadows.

The midpoint can be set using the midpoint slider or by directly sampling the image using the midpoint
eyedropper tool.

The Midpoint Slider
The midpoint slider is located at the bottom of the curve edit display.

Gamma

Gamma (also written “γ”) is a fundamental property of video systems which determines the inten-
sity of the output signal relative to the input.  When calculating gamma, the maximum possible input
intensity is assigned a value of one, and the minimum possible intensity (no input) is assigned a value
of zero.  Output is calculated by raising input to a power that is the inverse of the gamma value
(output = input (1/γ) ).  In practical terms, raising the gamma value has the same effect as moving the
midpoint slider to the left, raising mid-tone output values and brightening the image while leaving the
maximum and minimum values untouched. Lowering the gamma value has the same effect as moving
the midpoint slider to the right, lowering mid-tone output values and darkening the image.  The
default value for gamma is one, which produces a linear curve in which input and output values are
the same. Gamma can be set to any value between 0.05 and 6.00.

After clicking the slider once to activate it, move it to the left to increase the brightness of mid-tones in
the selected channel, or move it to the right to decrease brightness.  Alternatively, you can enter a value
for gamma directly in the text box under the slider. The effects of changes to the midpoint can be seen
in the active image.

Midpoint slider
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Sampling the Image for Midpoint
The midpoint can also be set by direct sampling.  Regardless of the channel currently selected in the
channel menu, sampling simultaneously defines the midpoint for each of the red, green, and blue chan-
nels while leaving the midpoint for the master curve unchanged.

To sample the midpoint, click the midpoint button ( ).  When the cursor is moved over the active
image, it will take the shape of an eyedropper.  Move the cursor over the image to find the pixel that you
want to use to set the midpoint, keeping an eye on the pixel level display in the Information window to
identify pixels with a neutral input value (look for pixels that you think should be a neutral gray color in
the final image).  With the cursor over the target pixel, click the mouse button.  The input value for the
selected pixel will be used as the reference value for the midpoint. The cursor will return to its original
shape, and the image will automatically be altered to reflect the new value for midpoint.

Editing Curves Directly

Fine adjustments can be made to brightness and contrast in specific portions of the tone range by
adding additional points to the curves for each channel.  These points can be freely adjusted by dragging
them into new positions, changing the shape of the curve.  Steepening the slope in a given portion of
the curve will enhance contrast in that portion of the tone range.  Changing the curve so that input
levels in a given portion of the tone range are mapped to higher output levels will brighten tones in the
affected tone range; similarly, changing the curve to map input levels to lower output levels will darken
tones in the affected range.

Adding New Points to the Curve
Move the cursor over the curve edit display and click once to enter curve edit mode.  Move the cursor
to the position where you would like to add a new point, then click.  A new point will be added at this
position and the curve will automatically be adjusted to pass through this point.  The position of the
point can be adjusted by dragging it to a new location within the curve edit display. The image in the
active window will automatically be adjusted to reflect changes to the curve.

Removing Points from the Curve
Points can be removed from the curve by dragging them out of the curve window.

Resetting the Active Curve to Linear
The default linear curve for the current channel can be restored by clicking the  button in the Curves
window.

Resetting All Curves to Linear
To reset all curves to linear, click the  button.  All curves will be reset and the RGB master channel will
be displayed in the Curve window.
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The Curves Settings Menu

Selecting Curves from the Settings menu displays a sub-menu of options that can be used to save
and recall tone adjustment settings or to reset all curves to linear.

Right-Button Menu (Windows)

In the Windows version of Nikon Capture 2, the Curves menu can be displayed by right-clicking in
the Curves window.
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Load…: Select this item to load curves previously saved using the Save… option
(see below).  A dialog will be displayed where you can navigate to the drive
(volume) and directory containing the desired settings file (in the Windows
version of Nikon Capture 2, only files with the extension “.ncv” will be dis-
played).  The settings in the Curves window will instantly revert to the saved
settings.

Save…: Select this item to save curves for all channels to a named file.  These settings
can later be recalled using the Load… option.  Choosing Save… displays a
dialog where you can choose a destination and file name for the current
curves (in the Windows version of Nikon Capture 2, curves are saved with
the extension “.ncv”).

Reset to Neutral: Resets all curves to linear.

Apply Button Status

The status of the Apply button is not recorded when curves are saved.  If you save curves with the
Apply button in the Curves window on and later load these settings with the Apply button off, the
saved settings will not apply to the image in the active window until you turn the Apply button on.
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Color Balance
The Color Balance window offers simple controls for adjusting overall brightness, contrast, and color
balance for the entire image.  Unlike the controls in the Curves window, however, the Color Balance
window does not allow you to make changes that affect only a portion of the tone range.

Adjusting Brightness, Contrast, and Color Balance

1 Select Color Balance from the View menu.
The Color Balance window will be displayed.

Color Balance and Curves

Color Balance and curves can not be used together.  If the controls in the Curves window are active,
the controls in the Color Balance window are disabled.  If the Color Balance controls are active, the
controls in the Curves window are disabled.  Only one of color balance or curves can be applied
when a modified image is saved.

The Apply Button

Changes to curves only take effect when the Apply button at the top left corner of the Curves
window is checked.  When this button is checked, any changes to curves will be visible immediately
in the image in the active window.  The Apply button can be turned on and off for a quick “before-
and-after” comparison, allowing you to determine whether changes are having the desired effect.

Apply button

Brightness

Contrast

Red

Green

Blue

Slider
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2 If the Apply button is off, turn it on.

3 Adjust brightness, contrast, and color balance using the options in the Color Balance window.

Adjusting Overall Brightness
The brightness slider adjusts brightness for the entire image.  Dragging the brightness slider in the +
direction brightens all the colors in the image, making the image as a whole more white.  Dragging
the slider in the – direction darkens all the colors in the image, making the image as a whole darker
and less distinct.  Unlike adjustments to the midpoint in the Curves window, this setting applies
equally to shadows and highlights, producing a flat, low-contrast image.  A value for brightness
between –50 and +50 can be entered directly in the text box to the right of the slider.

Adjusting Image Contrast
Dragging the contrast slider in the + direction heightens the difference between highlights and
shadows in the image, increasing contrast.  Dragging the slider in the – direction decreases the
difference between light and dark portions of the image, lowering contrast.  A value for contrast
between –50 and +50 can be entered in the text box to the right of the slider.

Adjusting Color Balance
While the brightness slider adjusts brightness for the image as a whole, the three color-balance
controls allow the user to adjust brightness for each color individually.  For example, dragging the
red slider in the + direction brightens the red portions of the image, making the image as a whole
more red.  Dragging it in the – direction dims the red elements in the image, bringing out the
remaining colors.  Color balance can also be set by entering values directly in the text boxes to the
right of the sliders.
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The Color Balance Settings Menu

Selecting Color Balance from the Settings menu displays a sub-menu of options that can be used
to save and recall Color Balance settings or to reset brightness, contrast, and color balance to zero.

Right-Button Menu (Windows)

In the Windows version of Nikon Capture 2, the Color Balance menu can be displayed by right-
clicking in the Color Balance window.
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Load…: Select this item to load brightness, contrast, and color balance settings previously
saved using the Save… option (see below).  A dialog will be displayed where you
can navigate to the drive (volume) and directory containing the desired settings file
(in the Windows version of Nikon Capture 2, only files with the extension “.nca”
will be displayed).  The settings in the Color Balance window will instantly revert to
the saved settings.

Save…: Select this item to save brightness, contrast, and color balance settings to a named
file.  These settings can later be recalled using the Load… option.  Choosing Save…
displays a dialog where you can choose a destination and file name for the current
Color Balance settings (in the Windows version of Nikon Capture 2, Color Balance
settings are saved with the extension “.nca”).

Reset to Neutral:
Resets all brightness, contrast, and color balance settings to zero.

Apply Button Status

The status of the Apply button is not recorded when color adjustment settings are saved.  If you save
color adjustment settings with the Apply button in the Color Balance window on and later load
these settings with the Apply button off, the saved settings will not apply to the image in the active
window until you turn the Apply button on.
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Unsharp Mask
Using Unsharp Mask, the user can increase the sharpness of photographs by making edges more dis-
tinct.  Unsharp Mask works by increasing the contrast of the edges in the image while leaving other
areas untouched. The amount of sharpness is determined by three factors: intensity, halo width, and
threshold.

Creating Unsharp Masks

1 Select Unsharp Mask from the View menu.
The Unsharp Mask window will be displayed.

2 If the Apply button is off, turn it on.

Apply button

Unsharp mask list

Color

Delete button

Up/down arrows

Warning button

The Warning Button

A warning button appears if the image in the active window is displayed at a zoom ratio too low to
allow the effects of Unsharp Mask to be displayed.  Click the button to view the warning.

The Apply Button

Changes to Unsharp Mask only take effect when the Apply button at the top left corner of the
Unsharp Mask window is checked.  When this button is checked, any changes to Unsharp Mask will
be visible immediately in the image in the active window.  The Apply button can be turned on and off
for a quick “before-and-after” comparison, allowing you to determine whether changes are having
the desired effect.
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3 Create an Unsharp Mask.
Unsharp Mask can be applied to all the colors in the image or selectively to any combination of red,
green, and blue channels.  Select a combination of colors from the color pop-up menu.  The Unsharp
Mask you create will be applied only to edges in the selected colors.

4 Select values for intensity, halo width, and threshold.

Intensity: The amount the contrast of edges will be increased.  Too great an intensity will
degrade your image rather than sharpening it.

Halo Width: The size of the areas that will be affected.  The greater the halo width, the wider the
edges in the sharpened image will appear.  Too large a value for halo width will
produce a “halo” along edges in the image.

Threshold: The limit at which sharpening will be applied.  If the threshold is zero, sharpening
will apply to all pixels in the image. Increasing the threshold increases the amount of
contrast that must be present between pixels before Unsharp Mask will be applied,
with the result that only more distinctly contrasting edges will be affected.

5 Repeat steps 1–4 to create additional masks for different color combinations.
The controls in the Unsharp Mask window allow you to select multiple combinations of colors that
can be sharpened to different degrees.  As new masks are created, they will be added to the end of
the Unsharp Mask list.  Masks apply in the order listed.  To change the order in which masks apply,
select a mask in the Unsharp Mask list and click the up arrow to move it up in the list, or the down
arrow to move it down.  To delete an Unsharp Mask from the list, select it and click the delete
button.

Unsharp Mask

Unsharp Mask sharpens edges without affecting color balance by making adjustments only to lumi-
nosity (brightness). The effect is the same as performing Unsharp Mask with the Luminosity channel
selected in the Adobe Photoshop Lab color model.  If Unsharp Mask is applied to a single channel,
such as red, the values for ab (chrominance) are used to determine what points in the image are red,
and Unsharp Masking applied to the Luminosity channel for those points only.

No sharpening will be applied if Intensity is set to zero.  Intensity must be set to at least 1% if
sharpening is to apply.
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The Unsharp Mask Settings Menu

Selecting Unsharp Mask from the Settings menu displays a sub-menu of options that can be used
to save and recall Unsharp Mask settings or to delete all masks currently displayed in the Unsharp Mask
window.

Right-Button Menu (Windows)

In the Windows version of Nikon Capture 2, the Unsharp Mask menu can be displayed by right-
clicking in the Unsharp Mask window.
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Load…: Select this item to load Unsharp Masks previously saved using the Save… option
(see below).  A dialog will be displayed where you can navigate to the drive (vol-
ume) and directory containing the desired settings file (in the Windows version of
Nikon Capture 2, only files with the extension “.num” will be displayed).  The set-
tings in the Unsharp Mask window will instantly revert to the saved settings.

Save…: Select this item to save Unsharp Mask settings to a named file.  These settings can
later be recalled using the Load… option.  Choosing Save… displays a dialog
where you can choose a destination and file name for the current Unsharp Mask
settings (in the Windows version of Nikon Capture 2, Unsharp Mask settings are
saved with the extension “.num”).

Reset to Neutral:
Deletes all Unsharp Masks currently displayed in the Unsharp Mask window.

Apply Button Status

The status of the Apply button is not recorded when Unsharp Mask settings are saved.  If you save
Unsharp Mask settings with the Apply button in the Unsharp Mask window on and later load these
settings with the Apply button off, the saved settings will not apply to the image in the active window
until you turn the Apply button on.
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Output Size and Resolution
The Size/Resolution window is where you specify the final (“output”) size of the portion of the image
that will be saved when Save as… is selected from the File menu.  The choice of settings in the Size/
Resolution window depends on how you intend to use the image and the amount of storage space you
have available.  Some examples are given below.

If the image will be used in printing or desktop publishing…
…size and resolution will be dictated by the resolution of the output device and the physical size of the
image when printed, measured in centimeters or points rather than pixels.

If you intend to use the image on a web page…
…specify output size in pixels, keeping file size to a minimum for rapid downloads.  Resolution in this
case is not an issue.

Adjusting Size and Resolution

1 Select Size/Resolution from the View menu.
The Size/Resolution window will be displayed.

Right-Button Menu (Windows)

In the Windows version of Nikon Capture 2, the Size/Resolution menu can be displayed by right-
clicking in the Size/Resolution window.
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2 Make changes to options as described below.

Keep my crop:
When Keep my crop is selected, you can use the mouse to adjust the size and
position of the current crop as desired.  If you enter a new value for height or width
in the Size/Resolution window, the remaining dimension changes automatically to
maintain a constant height-width aspect ratio, and scale is adjusted to reflect the
new dimensions (scale can not be increased beyond 200%).  If the image can not
be output at the current resolution using the new dimensions, resolution will auto-
matically be adjusted to an appropriate value.  This option is useful when you want
to specify height and width after selecting a crop.

Keep my output size:
Keep my output size locks output dimensions and file size at their current
values, setting the aspect ratio of the current crop according to the dimensions
input in the Size/Resolution window.  This height-width aspect ratio will be main-
tained when you adjust the size of the crop in the active window, and scale will be
adjusted to reflect changes to the size of the crop (scale can not be increased
beyond 200%).  If the image can not be output at the current resolution using the
new dimensions, resolution will automatically be adjusted to an appropriate value.
This option is useful when you want to set the output dimensions and file size of
the final image before selecting a crop.

Width/Height:
The output dimensions for the current crop can be entered in
these text boxes.  The units used to describe output dimensions
can be chosen from the menu to the right of the text boxes.

Scale/File Size

Scale (output size as a percentage of input size, maximum 200%) is displayed at the bottom of the
Size/Resolution window, together with the uncompressed file size of the image that would be cre-
ated at current settings. File size depends on the color model (RGB or CMYK) and, in the case of
RGB images, on the pixel bit-depth that will be used when the image is saved.  Separate file sizes are
shown for CMYK and for eight-bit and sixteen-bit RGB.

at: The at text box is where you enter the output resolution.  This
text box is not active if the unit chosen for output size is “pixels,”
when resolution is fixed at 300 ppi.  The value chosen at other
settings should reflect the resolution of the output device on which
the final image is to be printed.  The units for resolution can be
selected from the resolution menu, which offers a choice of pixels
per inch (ppi) or pixels per centimeter (ppcm).  The default reso-
lution is 300 ppi.
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The Size/Resolution Settings Menu

Selecting Size/Resolution from the Settings menu displays a sub-menu of options that can be used
to save and recall size resolution settings or to reset size and resolution to default values.

Saving Size and Resolution Settings

The units selected for size and resolution are not saved when Save… is chosen from the Size/
Resolution sub-menu.

Right-Button Menu (Windows)

In the Windows version of Nikon Capture 2, the Size/Resolution menu can be displayed by right-
clicking in the Size/Resolution window.

Load…: Select this item to load size and resolution settings previously saved using the
Save… option (see below).  A dialog will be displayed where you can navigate to
the drive (volume) and directory containing the desired settings file (in the Win-
dows version of Nikon Capture 2, only files with the extension “.nsr” will be dis-
played).  The settings in the Size/Resolution window will instantly revert to the
saved settings.

Save…: Select this item to save size and resolution settings to a named file.  These settings
can later be recalled using the Load… option.  Choosing Save… displays a dialog
where you can choose a destination and file name for the current size and resolu-
tion settings (in the Windows version of Nikon Capture 2, size and resolution
settings are saved with the extension “.nsr”).

Reset to 100%:
Enlarges the crop to include the entire image.  Resolution will be reset to the
default value of 300 ppi (118.11 ppcm).
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This chapter describes how to use batch processing with images that have been captured to the
computer’s hard disk.

Batch Processing
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Batch Processing
Nikon Capture 2 supports automated processing of multiple images (batch processing).  Batch process-
ing is used to automate image processing, capturing images, applying pre-defined image adjustment
settings, and saving images to disk automatically.  It is most effective when applied to a series of photo-
graphs taken under identical conditions.

When using batch processing, we recommend that you open one of the images to be processed in
Nikon Capture 2 and edit image adjustment settings (white balance adjustment, advanced RAW set-
tings, curves, color adjustment, Unsharp Mask, and size and resolution) to produce the desired result.
You can then save these settings in a joint settings file using the Save… option in the Image Adjustment
Control Panel (  pg. 96).  By selecting the resulting settings file in the Batch dialog, you can perform the
same adjustments on all the images processed.  In studio settings where a variety of shooting conditions
can be replicated with ease, you can create separate settings files for commonly encountered conditions
and use these settings to automate repetitive image enhancement operations.

This chapter describes how to use batch processing with files that have already been saved to the
computer’s hard disk.  For information on batch processing of images captured directly from the cam-
era, see “Capturing Photographs” (  pg. 139).

Limitations on Batch Processing

Batch processing can only be used with unedited images captured from the camera and images that
have been saved in NEF format from Nikon Capture 2 (images saved in NEF format from Nikon Scan
3 can not be processed).

Before Using Batch Processing

Batch processing is used to perform the operations specified in the Image Enhancements section of
the Batch dialog on all files in a selected folder.  To ensure that desired results are achieved, we
recommend processing a test image before beginning batch processing.  Batch processing can not be
used to adjust settings separately for each image; instead, the images must be opened one at a time
and separate adjustments made manually for each image.
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1 Select Batch from the File menu or click the  button.
The Batch dialog will be displayed.

Selecting Folders for Batch Processing

For improved efficiency, create two folders that are used only for batch processing.  The images to be
processed can be copied to one of these folders, which might be named “Batch In.”  If the Delete
files from this folder after they are processed option is checked, these files will automatically
be deleted from the “Batch In” folder after processing, allowing you to copy more files to the folder
without worrying about the files already there (be sure to leave a copy of any images you would like
to keep in their original state in another folder).
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2 In the Image source section, choose the folder containing the images to be processed.

Folder: Select this option to process all images in a specified folder on your computer’s
hard disk.  When this option is selected, the chosen folder will be displayed in the

button and navigate to the desired location.

Browse: Clicking this button displays a dialog where you can choose the folder containing
the images to be processed.  This button is inactive when the Camera option is
selected.

Include subfolders:
Select this option to process all images in any sub-folders under the specified folder.

Periodically check for new files in this folder:
When this option is selected, Nikon Capture 2 will check for new images in the
specified folder once every ten seconds.

Delete files from this folder after they are processed:
Select this option to delete image files from the selected folder after processing.  A
warning dialog will be displayed before batch processing begins.
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3 In the Image Enhancements section, specify the operations to be performed on each image.

Apply current settings:
Select this option to process the images in the selected folder using the settings
currently in effect in the White Balance, Advanced RAW, Curves, Color Balance,
Unsharp Mask and Size/Resolution windows.

Apply settings in:
Select this option to process the images in the selected folder using joint settings
created using the Save… option in the Image Adjustment Control Panel
(  pg. 96).  When this option is selected, a joint settings file can be selected by
clicking the Browse button to its right.

Ignore previously saved settings in NEF files:
Select this option to override the settings saved with NEF files, replacing them with
the settings chosen in the Image Enhancements section.

Existing Image Adjustment Settings

When the Ignore previously saved settings in NEF files option is checked, any changes to
settings stored with files saved in NEF format will be ignored, and the settings in the selected settings
file applied.  If you have processed a series of NEF images separately and want to save them all as
sixteen-bit TIFF, you can turn this option off and use batch processing to save all the images to a
single folder in sixteen-bit TIFF format.
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4 In the Destination section, choose options for saving the processed images.

Use source folder:
When this option is selected, processed images will be saved to the same folder as
the original.

Use source file name:
When this option is selected, processed images will be saved under the same name
and in the same location as the original images, although the file extensipRÄwill
change if the chosen file format differs from the original.

Save to: This text box shows the folder to which the images will be saved after processing.
To choose a new folder, click the Browse button to the right of the text box and
navigate to the desired location.  This option is not available when Use source
folder is selected.

File Naming Conventions

Windows: In environments that do not support long file names, the maximum length is eight characters;
file names may not contain spaces, quotes, or any of the following characters: “\\” “/” “:” “,” “;” “*” “<“
“>” and “|”.

Where long file names are supported, the maximum length is 255 characters.  File names may not contain
quotes or any of the following characters: “\\” “/” “:” “,” “;” “*” “<“ “>” and “|”.

Macintosh: The maximum length for Macintosh file names is thirty-one characters.  Colons (“:”) are
not allowed.
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Next file name:
This text box shows a sample of the file names that will be used when saving the
images after processing.  This text box shows a sample of the file names that will be
used when saving the images after processing.  To choose a new file name, click the
Edit button.  The Generate Multiple File Names dialog will be displayed.

Error Messages

If an invalid file name or other error is identified in the batch processing dialog, a message will be
displayed.  Return to the batch processing dialog and adjust settings as directed in the message.

Using the sample file name as your guide, enter a prefix and suffix and choose the
starting number and number of digits for automatic file numbering.  This option is
not available when Use source folder is selected.

Save as type:
Choose the file format that will be used to save the processed images.  For more
information on the options available, see “File Format and Image Quality” (  pg.
86).

Add to database:
If this option is checked, images will be catalogued in Canto Cumulus 5 database
software as they are saved.  This option is only available if: Canto Cumulus 5 is
installed, Add saved images to Canto Cumulus 5  has been selected in the
File Locations tab of the Preferences dialog, and a Canto Cumulus 5 catalog file has
been selected.
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5 Click OK to put the selected settings into effect.

6 A progress dialog will be displayed.

To stop batch processing before all images have been processed, click Stop Batch.

7 Click Batch Complete.
When batch processing is complete, the Stop Batch button will change to Batch Complete.
Click Batch Complete to exit the batch processing dialog.
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This chapter describes how to capture photographs from the camera and control camera settings
from your computer using Nikon Capture 2.

Capturing Photographs
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Images Stored on the Camera Memory Card

Nikon Capture 2 can not be used to capture images already stored on the camera memory card
directly from the camera.  Use Nikon View 4 or a card reader to capture images from the memory
card.

Important

The camera and computer must be correctly connected when capturing images from the camera.

Capturing Photos as They Are Taken
When your Nikon digital camera is connected in PC mode and Nikon Capture 2 is running, you can
save photographs directly to your computer’s hard disk as they are taken, rather than to the camera’s
memory card.  You can operate the camera directly, or make changes to settings and release the shutter
remotely from the Camera Control window in Nikon Capture 2, where you can confirm changes to
settings as they are made.  For more information, see “Camera Control” (  pg. 163).
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Readying the Camera

Before capturing images to the computer, you will need to turn the camera on and connect it to the
computer.  We recommend that an EH-4 AC adapter (available separately) be used to power the
camera while it is connected to a computer.

1 Turn the camera on and set the mode dial to “PC” (PC mode).
Communication between the camera and your computer is only possible when the camera is on
and in PC mode.

Turn camera on Turn mode dial to “PC”

Connecting and Disconnecting the IEEE 1394 Cable

We recommend that you connect and disconnect the interface cable while the camera is on.  The
camera and computer require some time to establish communication after the cable has been
connected or disconnected; allow a brief pause before beginning operations.  Disconnect the inter-
face cable before turning the camera off.

2 Connect the camera to the computer using an IEEE 1394 cable (available separately).
See the camera User’s Manual and the documentation provided with your computer or IEEE 1394
expansion board for more information.
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Taking Photographs from the Camera

1 Start Nikon Capture 2.
See “Tutorial: Getting Started” for more information.

2 Check the status of the connection between the computer and the camera.
If the two are properly connected, the connection status indicator at the bottom left corner of the
Nikon Capture window (Windows) or tool palette (Macintosh) will be green.

Camera Settings

• In PC mode, Custom Setting 30 controls the choice of single-frame and continuous advance
when taking photographs (see the section on Custom Settings in the camera User’s Manual).
Custom Setting 30 can either be set from the camera itself or remotely from the Mechanical tab
of the Camera Control window in Nikon Capture 2 (  pg. 173).

• The camera’s review function is disabled when the camera is connected to a computer in PC
mode.

• Photographs taken in continuous shooting mode are stored in a temporary buffer in the camera’s
memory, making it possible to take a picture while the previous photograph is being transferred
to the computer.  If Custom Setting 26 is set to “1” when the camera is in continuous shooting
mode, although only one photograph will be taken each time the shutter-release button is pressed,
you will be able to take the next photograph without waiting for the preceding picture to be
transferred to the computer.

Custom Setting 28

If Custom Setting 28 is set to “0,” preventing the camera from taking RAW images, when Nikon
Capture 2 is started with the camera connected, a warning will be displayed.  Click OK to set
Custom Setting 28 to “1,” allowing photographs to be saved as uncompressed RAW images.

Windows Macintosh

Connection status is also displayed in the control panel on top of the camera.  If Nikon Capture 2
is started with the camera connected, the number of exposures remaining will show PC.
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3 Adjust camera settings, frame a photograph, and check focus.
See the camera User’s Manual for details.

4 Take a picture.
Press the shutter-release button on the camera all the way down to take a picture.  The photograph
will be captured and displayed in the Camera Image window.

Each time the shutter is released, the resulting photograph will be displayed in the Camera Image
window.

The Connection Status Indicator

The color of the connection status indicator shows the status of the connection between the
computer and the camera.
Green: Normal connection.  The camera is ready to transfer data or data are being transferred.
Red: No connection.  Either the camera is not connected, or the connection is not functioning

properly.  See “Troubleshooting” (  pg. 246) for more information.

Clicking the connection status indicator displays a message detailing connection status.
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Taking Photographs Remotely Using Nikon Capture 2
Using the Camera Control window, you can adjust camera settings and take photographs from your
computer.

1 Click the camera tool button ( ) or select Camera Control from the View window.
The Camera Control window will be displayed.

The camera settings currently in effect can be viewed in the Camera Control window’s four tabs:
Exposure 1, Exposure 2, Storage, and Mechanical.

2 Adjust camera settings.
Adjust camera settings in the Camera Control window.  For details, see “Camera Control”
(  pg. 163).

3 Take a photograph.
After adjusting camera settings, take a photograph by clicking AF and Shoot or Shoot.
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Working with the Camera Image Window
Images may displayed in either the Camera Image window or in separate image windows.  Image
adjustment and save operations are performed on the image in the active window.  For more informa-
tion on image windows, see “Working with Image Windows” (  pg. 67).

The Camera Image Window

The Camera Image window is where you view thumbnail previews of images taken while the camera
and computer are connected, and where you display selected images for preview or editing.

Title bar Thumbnail

Thumbnails section

Total
number of

images

Shooting Data
section

Preview section

The Connection Status Indicator

Only images taken while the camera and computer are connected are displayed in the Camera
Image window.  Images taken when the camera was not connected can not be displayed in the
Camera Image window, although they can be opened in independent image windows.
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When the Thumbnails Section Is Hidden

Even when the Thumbnails section is hidden, thumbnails can still be deleted or selected for display in
the Camera Image window.

Click to delete the image displayed in the Camera Image window.
Click to display images recorded before the current image.
Click to display images recorded after the current image.

Total number of images

Click to open the
Thumbnails section

To open or close the Camera Image window, select Camera Image from the View menu.  You can
perform the same operation by clicking the  button in the toolbar.

The Title Bar
The title bar of the Camera Image window provides information about the selected image.

File name/thumbnail index:
If a photograph taken with the camera is displayed in the Camera Image window,
the title bar will show “Camera Image” followed by the thumbnail index assigned by
Nikon Capture 2.

Zoom ratio: The zoom ratio is the amount the image in the Preview area is zoomed in or out,
as a percentage of the original size.  The original size for display purposes is deter-
mined by the number of pixels in the image and the resolution of the monitor and
does not reflect the physical dimensions of the image when printed.

The Thumbnails Section
The Thumbnails section shows thumbnail previews of the images captured from the camera.

Thumbnail: Click on a thumbnail to display the image in the Preview section of the Camera
Image window.  The number displayed below each thumbnail is the thumbnail
index assigned by Nikon Capture 2.  The thumbnail index can be reset to one in the
Thumbnails tab of the Preferences dialog (  pg. 198).

 : Click this button to delete the selected image.

The Thumbnails section can be hidden or displayed by clicking the triangle at its top left corner, or by
selecting Thumbnails Section from the View menu.
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The Shooting Data Section
The Shooting Data Section shows photo information (  pg. 69).

The Shooting Data section can be hidden or displayed by clicking the triangle at its top left corner, or by
selecting Shooting Data Section from the View menu.

The Preview Section
The currently selected image is previewed in this area.  Any changes made during editing are reflected
in the image in the Preview section.  No preview is displayed when multiple thumbnails are selected.

Output Size and Resolution for New Files

The first time an image is captured or opened in Nikon Capture 2, size and resolution will be set the
values in the default image settings file or to the values specified for the previous image.  The choice
between these two options is made in the Settings for Next Camera Image panel in the General tab
of the Preferences dialog.

Right-Button Menu (Windows)

Clicking on the Preview section with the right mouse button displays a menu of options identical to
the Image menu.
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Viewing Thumbnails
Using thumbnails (small preview images), you can view at a glance all the photographs that you have
captured to your computer.  To view thumbnails, click the arrow at the top of the Thumbnails section.

Temporary Storage of Captured Images

Images that have been captured to the computer are temporarily stored at full size in a thumbnail
folder on the hard disk.  The folder used for temporary storage of thumbnails can be chosen from
the File Locations tab of the Preferences dialog (  pg. 197).  Any images stored in this folder are
shown in the Thumbnails section.  If an image is deleted from the Thumbnails section, it will also be
deleted from the thumbnails folder.

The Thumbnails section shows the images that have been captured to the thumbnail folder on the
computer’s hard disk, including any previously captured images that have not been deleted.

Thumbnails section
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Viewing Photo Information
Photo information for the image displayed in the Preview section of the Camera Image window can be
viewed in the Shooting Data section.

1 Display the Shooting Data section.
Click the arrow at the top left corner of the Shooting Data section (the Shooting Date section is
located just beneath the Thumbnails section).

The Shooting Data section shows the date and time of recording and the shooting mode in effect
at the time the photograph was taken (  pg. 69).

2 Close the Shooting Data section.
To close the Shooting Data section, click the triangle at its top left corner.
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Selecting Thumbnails
Select thumbnails from the Thumbnails section to view, edit, or save the associated photograph.  When
you click the desired thumbnail, it will be highlighted with a colored border and the image will appear in
the Preview section.
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Selecting Multiple Thumbnails
Select multiple thumbnails to perform such operations as saving images or deleting thumbnails on
several images at once.  Note that when more than one thumbnail is selected, no image will be dis-
played in the Preview section of the Camera Image window.  Select only one thumbnail at a time when
editing images.

Windows
To select multiple images, hold down the Ctrl key while clicking each thumbnail in turn, or hold down
the shift key while clicking two thumbnails to select the thumbnails and all images between them.

Macintosh
To select multiple images, hold down the command key while clicking each thumbnail in turn, or hold
down the shift key while clicking two thumbnails to select the thumbnails and all images between them.

Selecting All Thumbnails
To select all thumbnails, choose Select All Thumbnails from the Image menu.

Deselect All Thumbnails
To deselect all thumbnails, choose Deselect All Thumbnails from the Image menu.
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Creating a Copy of an Image
Copies of photographs selected in the Thumbnails section can be opened in independent image win-
dows.  To open a copy of an image, either :
• double-click the thumbnail in the Camera Image window Thumbnails section, or
• select a thumbnail and choose Create Copy from the File menu.
A copy of the selected image will be opened in an image window.

If an image window is active when Create Copy is selected, another copy of the image it contains will
be opened in a separate image window.

Copy and Original

Any changes to settings in effect when an image is copied will be reflected in the copy.  Any subse-
quent changes to the copy, however, have no effect on the original.  Similarly, any changes made to the
original after it is copied have no effect on the copy.  You can therefore apply one set of image
enhancement operations to a copy and compare them with a different set of operations applied to
the original.
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Image Adjustment for Captured Photographs
The image in the Camera Image window can be processed as described in “Image Adjustment” (  pg.
93).

White Balance (  pg. 98)
Choose a white balance to suit a specific light source, or edit the white balance value in effect when
the photograph was taken.

Advanced RAW (  pg. 104)
Change the exposure compensation, image sharpening, tone compensation, color mode, and hue
adjustment settings from the values in effect when the photograph was taken.

Curves (  pg. 107)
Edit tone curves and adjust brightness, contrast, and color balance to optimize curves for output on
a specific device.  Tone curves offer more precise control than the tools in the Color Balance
window.

Color Balance (  pg. 119)
Perform simple adjustments to the brightness, contrast, and color balance of the captured image.

Unsharp Mask (  pg. 123)
Sharpen outlines in images that are indistinct.

Output Size and Resolution (  pg. 127)
Adjust size and resolution according to how the image will be used.

White Balance and Advanced RAW

White Balance and Advanced RAW can only be applied to RAW images.  If the image in the active
window is JPEG or TIFF, the White Balance and Advanced RAW options in the Image menu are
unavailable.

Color Balance and Curves

Color balance and curves can not be used together.  If the controls in the Curves window are active,
the controls in the Color Balance window are disabled.  If the Color Balance controls are active, the
controls in the Curves window are disabled.  Only one of color balance or curves can be applied
when a modified image is saved.
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Saving Captured Images
The last step in capturing photographs from the camera is saving the pictures as image files.  Nikon
Capture 2 supports a variety of file formats; see pages 87–88 for information choosing a format suited
to the task at hand.

1 Click the Save tool ( ) or choose Save from the File menu.
The Save dialog will be displayed.

2 Navigate to the desired drive (volume) and folder.

3 Choose a file format.
For information on the formats available, see “Options for Saving Image Files” (  pg. 87).
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Saving Multiple Captured Images
This section describes how to save multiple images simultaneously.

1 Select the images to be saved and choose Save.
In the Camera Image window, select the thumbnails corresponding to the images you want to save,
then choose Save or Save as… from the File menu.  A save dialog will be displayed.

2 Click File Names….
The Generate Multiple File Names dialog will be displayed.
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3 Choose options for automatic file name generation.
Using the sample file name as your guide, enter a prefix and suffix and choose the starting number
and number of digits for automatic file numbering.

Prefix/Suffix: Enter a prefix or suffix of up to forty characters each (note that Macintosh file
names can not exceed a total of thirty-one characters).

Sequence Length:
Choose the number of digits to be used for automatic file name generation.  File
numbers can be from two to eight digits long.

Starting Sequence Number:
Each file is assigned a number as it is saved.  Numbers are assigned to files in
ascending order, starting from this number.

4 Click OK.
This will return you to the save dialog.

5 Save the images.
After choosing a destination folder and setting other options, click the Save button to save the
images to the specified location.

File Naming Conventions

Windows: In environments that do not support long file names, the maximum length is eight characters;
file names may not contain spaces, quotes, or any of the following characters: “\\” “/” “:” “,” “;” “*” “<“
“>” and “|”.

Where long file names are supported, the maximum length is 255 characters.  File names may not contain
quotes or any of the following characters: “\\” “/” “:” “,” “;” “*” “<“ “>” and “|”.

Macintosh: The maximum length for Macintosh file names is thirty-one characters.  Colons (“:”) are
not allowed.
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Deleting Thumbnails
As the images in the temporary thumbnails folder occupy a considerable amount of disk space, it is
recommended that you empty the temporary thumbnails folder when they are no longer needed.

1 Select the thumbnail(s) you want to delete.

2 Delete the selected thumbnails.
Choose Remove Selected Thumbnails from the Image menu or click the  button in the
Thumbnails section.

Before Deleting Thumbnails

Once deleted, thumbnail image data can not be restored.  Be sure that the data are no longer
required before deleting thumbnail images.

Deleting Thumbnails Automatically

Two options for removing thumbnails automatically are available in the Thumbnails tab of the Prefer-
ences dialog.
• Clear Camera Image Window on Exit

If this box is checked, a dialog will be displayed when you exit Nikon Capture 2, asking you
whether you wish to delete all thumbnails.

• Auto-Remove thumbnail after save
If this box is checked, the associated thumbnail will be removed when an image is saved.

Deleting All Thumbnails
Select Remove All Thumbnails from the Image menu to remove all thumbnails from the Camera
Image window and delete all image files in the thumbnail folder.
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Processing Photographs as They Are Captured
This section describes how the batch processing option can be used to process photographs automati-
cally as they are captured.  For information on performing batch processing on images that have already
been saved to disk, see “Batch Processing” (  pg. 131).

1 Select Batch from the File menu or click the  button.
The Batch dialog will be displayed.

Batch Processing

Batch processing is used to perform the operations specified in the Image Enhancements section of
the Batch dialog on all images captured from the camera.  To ensure that desired results are achieved,
we recommend processing a test image before beginning batch processing.  Batch processing can
not be used to adjust settings separately for each image; instead, the images must be opened one at
a time and separate adjustments made manually for each image.
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2 Select Camera.
To process images as they are captured, select Camera from the options in the Image source
section.

Camera: Select this option to process images as they are captured using automatic batch
processing.  This option is only available when the camera is connected to the
computer.  Selecting Camera disables the other options in the Image source
section.

3 In the Image Enhancements section, specify the operations to be performed on each image.

Save unmodified image:
Select this option to save images exactly as captured from the camera, without
modification.  This option is only available when Camera is selected in the Image
source section.

Apply current settings:
Select this option to process the images in the selected folder using the settings
currently in effect in the White Balance, Advanced RAW, Curves, Color Balance,
Unsharp Mask and Size/Resolution windows.

Apply settings in:
Select this option to process the images in the selected folder using joint settings
created using the Save… option in the Image Adjustment Control Panel (  pg.
96).  When this option is selected, a joint settings file can be selected by clicking the
Browse… button to its right.
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4 In the Destination section, choose options for saving the processed images.

Save to: This text box shows the folder to which the images will be saved after processing.
To choose a new folder, click the Browse… button to the right of the text box
and navigate to the desired location.

Next file name:
This text box shows a sample of the file names that will be used when saving the
images after processing.  To choose a new file name, click the Edit button. The
Generate Multiple File Names dialog will be displayed.

Using the sample file name as your guide, enter a prefix and suffix and choose the
starting number and number of digits for automatic file numbering.  This option is
not available when Save unmodified image is selected.

Save as type:
Choose the file format that will be used to save the processed images.  For more
information on the options available, see “File Format and Image Quality” (  pg.
86).

Add to database:
If this option is checked, images will be catalogued in Canto Cumulus 5 database
software as they are saved.  This option is only available if: Canto Cumulus 5 is
installed, Add saved images to Canto Cumulus 5 has been selected in the
File Locations tab of the Preferences dialog, and a Canto Cumulus 5 catalog file has
been selected.

5 Click OK to put the selected settings into effect.

6 Take photographs
Take photographs as described in the camera User’s Manual.
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Error Messages

If an invalid file name or other error is identified in the batch processing dialog, a message will be
displayed.  Return to the batch processing dialog and adjust settings as directed in the message.

File Naming Conventions

Windows: In environments that do not support long file names, the maximum length is eight characters;
file names may not contain spaces, quotes, or any of the following characters: “\\” “/” “:” “,” “;” “*” “<“
“>” and “|”.

Where long file names are supported, the maximum length is 255 characters.  File names may not contain
quotes or any of the following characters: “\\” “/” “:” “,” “;” “*” “<“ “>” and “|”.

Macintosh: The maximum length for Macintosh file names is thirty-one characters.  Colons (“:”) are
not allowed.

7 A progress dialog will be displayed.

To end batch processing, click Stop Batch.

8 End batch processing.
Once you have finished taking photographs, click Batch Complete to end batch processing.
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When your Nikon digital camera is connected to a computer running Nikon Capture 2, the Camera
Control and Custom Settings windows allow you to control almost all aspects of camera operation
remotely.  This chapter describes the Camera Control and Custom Settings windows.  For more
information on camera settings, see the documentation provided with your camera.

Camera Control
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The Camera Control Window
To adjust camera settings from the Camera Control window, click on the Nikon Capture camera tool
button ( ) in the toolbar (Windows) or tool palette (Macintosh), or choose Camera Control from
the View menu.  The Camera Control window will be displayed.

Camera Control page selection tabs

Simulated LCD panel

Shoot buttons

Verifying That the Camera is Connected

Before opening the Camera Control window, verify that the camera is connected and turned on.
The color of the connection status indicator at the bottom left corner of the Nikon Capture win-
dow (Windows) or the bottom of the tool palette (Macintosh) shows the status of the connection
between the computer and the camera.  If the indicator is green, the camera is connected and ready
to transfer data.

Important

Changes made to settings in the Camera Control window only apply to photographs taken after the
changes are made, not to photographs that have already been taken.

The Camera Control window shows current camera settings, which may be viewed by clicking the four
page selection tabs.  Camera settings can be altered using the controls in each tab as described below.
The simulated LCD panel and the shoot buttons can be accessed from all four tabs.
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Simulated LCD Panel
The simulated LCD panel shows the information displayed in the camera’s viewfinder, with the excep-
tion of camera errors.  Clicking on an indicator in the panel opens the Camera Control window to the
tab that controls the selected option, where adjustments can be made.

Shoot Buttons
Click either of these buttons to take a photograph at current settings.

AF and Shoot: When this button is clicked, the camera will perform an autofocus and
then release the shutter to take a photograph.  No autofocus operation
will be performed when the camera is in manual focus mode.

Shoot: Click this button to take a photograph.  If the selected focus mode is single-
servo AF, an autofocus operation will be performed before the shutter is
released.

Taking Photographs in Continuous Mode

When the camera is in PC mode, continuous shooting can only be performed using the camera
shutter-release button.  The shoot buttons in the camera control window can only be used to take
one photograph at a time.

Camera Settings That Can Not Be Adjusted from Nikon Capture

The following operations can only be performed using the controls on the camera:
• taking consecutive photographs in continuous shooting mode
• continuous servo autofocus
• shutter speed, aperture, or autoexposure lock
• autofocus lock
• pressing the shutter-release button halfway to check focus without taking a photograph
• manual aperture adjustment using the lens aperture ring
• reactivating the camera after it has entered sleep mode
• capture preview, record-and-review, or autobracketing

The following settings are displayed in the Camera Control window but can not be adjusted in
Nikon Capture:
• focus mode
• metering
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The Exposure 1 Tab

The following settings can be adjusted from the Exposure 1 tab:

Exposure Mode
The Exposure Mode menu contains the following four options:

Manual: User controls both aperture and shutter speed.
Aperture Priority: User sets the aperture and the camera automatically adjusts the shutter

speed.  This setting is useful when you want to give priority to depth of
field: small apertures can bring background and foreground into focus, while
wide apertures can be used to blur the background.

Speed Priority: User sets the shutter speed and the camera automatically adjusts the aper-
ture.  High shutter speeds can be used to freeze motion, while low shutter
speeds can blur moving objects.

Programmed Auto: User can select combinations of aperture and shutter speed pre-pro-
grammed into the camera for various lighting conditions.
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Shutter Speed
Shutter speed can only be adjusted in Manual and Speed Priority modes, when it can be set to
values between Bulb and 1/

16,000
s (1/

500
s when using a Speedlight).  Use high shutter speeds to freeze

motion, low shutter speeds to suggest motion by blurring moving objects.

Aperture
Aperture can only be adjusted in Manual and Aperture Priority modes, when it can be set to
values between maximum and minimum aperture (small apertures have high f-numbers, wide aper-
tures low f-numbers; the actual apertures available depend on the lens used).  Aperture can not be
controlled from Nikon Capture when Custom Setting 22 (  pg. 187) has been set to allow aperture
to be adjusted manually using the lens aperture ring.

Exposure Comp.
Exposure compensation is useful when shooting subjects containing sharp lighting contrasts, or on
other occasions when you want to modify the exposure value determined by the camera.  Exposure
compensation is available in all exposure modes.

Flexible Program
Flexible program can only be used in Program Mode, when it allows you to choose from predeter-
mined combinations of shutter speed and aperture appropriate to current lighting conditions.

Bulb

At a setting of Bulb, the shutter remains while the shutter release button is held down.  For this
reason, although a setting of Bulb can be chosen remotely from Nikon Capture 2, you must use the
shutter-release button on the camera to take photos at this setting.  An error message will be
displayed if you click either of the shoot buttons with the shutter speed set to Bulb.
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The Exposure 2 Tab

The following settings can be adjusted from the Exposure 2 tab:

Focus Area
The focus area can not be selected at an AF-area mode setting of closest subject priority.  At other
autofocus settings, the focus area can be selected using the arrow buttons.  The effects of focus area
selection depend on the option selected for AF Area Mode in the Mechanical tab (  pg. 173).

Single Area AF: The user selects that the camera will use to determine the autofocus target.
Dynamic Area AF: The user selects the primary focus area.  If the target moves, dynamic

autofocus automatically shifts the focus area to track the subject, keeping it
in focus.  The plus pattern displayed to the right of the arrows indicates the
active focus area.
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Metering Mode
This text box shows the current metering mode.  Note, however, that the metering mode can not be
changed from Nikon Capture 2.  The following three settings are available:

Multi-Pattern: Metering is performed by a CCD sensor with 1,005 (67 ver tical × 15
horizontal) metering pixels, which sets exposure using a selection of data
from all areas of the frame.  This system is particularly effective with brightly-
colored (white or yellow) or dark-colored (black or dark green) subjects
that occupy a substantial portion of the frame, producing photographs
close to what is seen by the naked eye.

Center-Weighted: The camera measures light in the entire frame, but assigns the greatest
weight to a circular area in the center of the viewfinder.  This setting can be
used to preserve background details while letting lighting conditions at the
center of the frame define exposure.

Spot: The camera measures light only in a 4-mm (0.15˝) circle centered on the
current focus area.  This setting is useful with backlit subjects or on other
occasions when the background is much darker or much brighter than
your subject.

Flash Sync Mode
When taking photographs with a Speedlight, you can choose a flash setting from the following options:

Front Curtain: This mode is recommended in most situations.  When using the SB-26, SB-
25, or SB-24, set the sync-mode selector on the Speedlight to NORMAL.

Rear Curtain: Use this mode to suggest motion by creating a stream of light that appears
to follow moving objects.  When this mode is combined with programmed
auto or aperture-priority auto, shutter speed is slowed to achieve the same
effect as slow sync.  When using the SB-26, SB-25, or SB-24, set the
Speedlight’s sync mode selector to REAR.

Slow Sync: A lower shutter speed is used in programmed auto and aperture-priority
auto exposure modes to bring out background details.

Red Eye Reduction: In this mode, a red-eye reduction pre-flash lights for approximately one
second before the main flash, causing the pupils in your subjects’ eyes to
contract and reducing the “red-eye” effect a flash can sometimes cause
(available only with SB-28DX, SB-28, SB-27, and SB-26).

Red Eye Slow: This mode combines red-eye reduction with slow sync (available only with
SB-28DX, SB-28, SB-27, and SB-26).  Set the exposure mode to programmed
auto or aperture-priority auto.

Sensitivity
Sensitivity (ISO equivalency) can be raised when taking photographs in low light conditions.  The set-
tings available for Sensitivity depend on the camera used (note that if sensitivity is raised using
Custom Setting 31, sensitivity can not be changed from the Sensitivity menu):
• D1: 200–1600 (ISO equivalent) in steps of 1 EV
• D1X: 125–800 (ISO equivalent) in steps of 1/

3
EV

• D1H: 200–1600 (ISO equivalent) in steps of 1/
3
EV
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Fixed White Balance
White balance is used to ensure that colors which appear white when viewed directly are white in the
final photograph.  The following settings are available:

Auto: The camera sets white balance automatically.
Preset: White balance can be set using a neutral gray or white object as a refer-

ence point.  Depending on the camera, several preset white balance op-
tions may be available.

Direct sunlight: Use this setting when taking photographs in direct sunlight.
Shade: Use this setting when taking photographs in the shade in sunny weather.
Cloudy: Use this setting when taking photographs under overcast skies.
Incandescent: Use this setting when taking photographs indoors under incandescent light.
Fluorescent: Use this setting when taking photographs indoors under fluorescent light.
Flash: Use this setting with Nikon Speedlights.

White Balance

If desired, white balance can be used to produce an intentionally unbalanced rendering of a scene.
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Fine Tune
Click Fine Tune… to make fine adjustments to the white balance settings chosen in the white-balance
pop-up menu.

If the current white balance setting is Auto, the value selected with the Add to Auto slider in the
Exposure 2 tab will be added to the white balance setting chosen by the camera.

Clicking the Reset button returns all values to defaults.  Click OK to apply the current settings to the
camera, or click Cancel to discard any changes and return to the Camera Control window.

Color Temperature

The color temperature will be displayed if Show degrees Kelvin for White Balance is selected
in the Advanced Color tab of the Preferences dialog (  pg. 199).
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Storage

Reducing File Size

Uncompressed, full-sized images require a large amount of disk space.  While file size can be reduced
using compression, compressed images may show some loss in image quality.

The following settings can be adjusted from the Storage tab:

Data Format
The following data formats are available: RAW (12-bit), TIFF-RGB (8-bit), TIFF-YCbCr (8-bit),
and JPEG (8-bit).  The data format setting determines pixel bit depth and file size.

Compression
When data format is set to JPEG (8-bit), you can choose the image quality (JPEG compression)
setting from Fine, Normal, and Basic.  If you are using the D1X or D1H with data format set to RAW
(12-bit), you can choose from a settings of None or Lossless.

Image Type
Choose from Color and Black & White.  Black & White is not available when RAW is selected
for Data Format.

Image Size
If you are using the D1 or D1H, image size will be fixed at Large (2000 × 1312).  At data format
settings other than RAW, the D1X offers a choice of Large (3008 × 1960) and Medium (2000 ×
1312).  When data format is set to RAW (12-bit), image size for the D1X is fixed at Large (3008 ×
1960).
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Mechanical

The following settings can be adjusted from the Mechanical tab:

Shooting Mode
Sets the shooting mode for PC mode to Single or Continuous.  The advance rate for continuous
mode can be set using Custom Setting 25 (  pg. 190).  Changes to the shooting mode are reflected in
Custom Setting 30.

AF Area Mode
The following options are available:

Single Area AF: The camera focuses on the subject in the area selected for autofocus.  This
mode is useful when focusing on subjects that are relatively stationary.

Dynamic Area AF: The camera first focuses on the subject in the area selected for autofocus.
If the subject moves to another focus area, the camera will automatically
shift the focus area to follow it (the focus area shown in the viewfinder will
not, however, change).  This makes it possible to focus on subjects that are
moving irregularly.



174

Focus Mode
The current focus mode setting is displayed.  This setting can not be changed from Nikon Capture 2.

Single Servo: Focus locks when the camera shutter-release button is pressed halfway.
The shutter can only be released when the in-focus indicator (● ) appears
in the simulated LCD panel in the Camera Control window or the camera
viewfinder.

Continuous Servo: The camera will focus continuously as long as the camera shutter-release
button is held down.  The shutter can be released even when the camera
is not in focus.

Manual: User adjusts focus manually.  Shutter can be released even when the cam-
era is not in focus.

Lens
Displays the focal length and maximum aperture of the lens currently attached to the camera.  Depend-
ing on the lens type, some information may not be displayed.

Main Battery Level
Displays the level of the main camera battery.  Green indicates that the battery has enough charge for
continued operation.  Yellow indicates that battery level is low; ready a fully charged spare battery pack.
Red indicates that the battery is exhausted, and that no further photographs can be taken until the
battery pack has been replaced.  You may not be able to control the camera from Nikon Capture 2
when the battery is exhausted.  Replace with a fully charged spare battery pack or use an EH-4 AC
adapter (available separately).

Clock Battery Level
Displays the level of the camera clock battery.  Should this display turn yellow or red, have the clock
battery replaced by an authorized Nikon service representative (a fee is charged for this service).

Getting Good Results with Autofocus

Auto focus does not perform well when:
• The subject is very dark
• There is no contrast between the subject and the background
• The focus area contains objects at different distances from the camera
• The subject is dominated by regular geometric patterns
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Saving and Loading Camera Control Settings

Nikon Capture 2 can be used to save Camera Control settings as well as to load and apply previously
saved settings.  Selecting Camera Control from the Settings menu displays the sub-menu of op-
tions described below.

Right-Button Menu (Windows)

In the Windows version of Nikon Capture 2, the Camera Control menu can be displayed by right-
clicking in the Camera Control window.

Load…: Select this item to load camera settings previously saved using the Save…
option (see below).  A dialog will be displayed where you can navigate to
the drive (volume) and directory containing the desired settings file (in the
Windows version of Nikon Capture 2, only files with the extension “.ncc”
will be displayed).  The settings in the Camera Control window will in-
stantly revert to the saved settings.

Save…: Select this item to save the settings in the Camera Control window to a
named file.  These settings can later be recalled using the Load… option.
Choosing Save… displays a dialog where you can choose a destination
and file name for current camera settings (in the Windows version of Nikon
Capture 2, camera settings are saved with the extension “.ncc”).
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Time Lapse Photography
Using Nikon Capture 2, you can take a series of photographs automatically at a time interval you select.

1 Select Time Lapse Photography… from the Camera menu.
The Time Lapse Photography dialog will be displayed.

2 Adjust settings.
Before shooting starts, adjust the following settings:

Autofocus before each shot:
If this option is checked, the camera will perform an autofocus operation
before each shot.

Keep shooting until cancelled:
If this option is checked, the camera will continue to take photographs until
you click Cancel.

3 Choose the number of photographs to be taken.
Use the Shots box to choose a number of photographs from 2 to 9,999.  This option is not
available when Keep shooting until cancelled is selected.

4 Choose an interval setting.
The delay between shots can be set to any value between 00:00:01 (one second) and 99:59:59
(ninety-nine hours, fifty-nine minutes, and fifty-nine seconds).

5 Choose a destination and click start shooting.
To save photographs to disk as they are taken, check the Process images and save to disk
option in the Time Lapse Photography dialog and click Next.  The Batch dialog will be displayed;
adjust set and click OK to begin time lapse photography.  If Process images and save to disk
is not selected, click time lapse photography.  Images will be captured to the Camera Image window.
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Time Interval Settings

If the delay is shorter than the time required to record each photograph, the actual interval between
photographs will be longer than that specified in the Time Lapse Photography dialog.

Auto Off

When the camera is operated on battery power and for 15 minutes has been selected for “While
application is running, keep camera awake” in the General tab of the Preferences dialog (  pg. 195),
choose a delay of fifteen minutes or less.  When taking photographs at longer intervals, use an EH-4
AC adapter (available separately) to power the camera.

During Time Lapse Photography

No other operations can be performed until the Time Lapse Photography dialog is closed.

Hard Disk Full

A warning will appear when space is no longer available on the destination disk for photographs
taken using time lapse photography.  Use the information in the warning to reduce the number of
photographs or change the destination drive.

6 Follow the progress of time lapse photography in the progress dialog.
Click Stop Shooting to end time lapse photography at any time.  If a number of shots was
specified in the Time Lapse Photography dialog, shooting will end when the specified number of
shots has been taken.

7 Close the Time Lapse Photography dialog.
Once the specified number of shots has been taken, click Stop Shooting button will change to
Shooting Complete.  Click Shooting Complete to exit the Time Lapse Photography dialog.
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Custom Settings
Most of the custom settings stored in camera memory can be viewed and adjusted from the Custom
Settings window in Nikon Capture 2.  For more information on Custom Settings, see the documenta-
tion provided with your camera.

1 Select Custom Settings… from the Camera menu or click the  button.
The Custom Settings dialog will be displayed.

The Custom Settings dialog shows the Custom Settings currently in effect.

Changes to Custom Settings

Changes made to settings in the Custom Settings dialog are stored in the camera, not on the
computer hard disk.  This means that changing settings in the Custom Settings dialog has the same
effect as changing Custom Settings using camera controls.  The  button and the Custom Set-
tings… option in the View menu are only available when a camera is connected to the computer.
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2 Choose a Custom Settings bank.
Choose a Custom Settings bank (Custom Settings set) from the pop-up menu at the top right
corner or the Custom Settings dialog.

Custom Settings

Custom Settings can not be saved to a separate file.  Clicking the Reset button resets all Custom
Settings to their default values.

Settings That Can Not Be Adjusted from the Custom Settings Window

The Custom Settings listed below can not be adjusted in the Custom Settings window.
• Custom Setting 8 (mirror lock-up for CCD cleaning): can only be adjusted from the camera
• Custom Setting 28 (RAW (NEF) image save): if this option is set to “0” (off) when Nikon Capture

is started, a message will be displayed.  Clicking OK in this dialog sets Custom Setting 28 to “1”
(uncompressed RAW image save enabled).  Custom Setting 28 can only be returned to “0” from
the camera.

• Custom Setting 30 (PC Shooting Mode): this option is adjusted from the Mechanical tab of the
Camera Control window.

The banks available depend on the model of camera currently connected.  When the D1 is con-
nected, you have a choice of banks A or B; when the D1X or D1H is connected, banks A, B, C, or D
can be selected.

3 Click OK to save changes to settings in the camera Custom Settings bank.
After making any adjustments to Custom Settings, click OK to save the changes in the camera
Custom Settings bank and exit the Custom Settings dialog.

The pages that follow describe the Custom Settings available in each of the three tabs in the Custom
Settings dialog.  The Custom Settings number is given in parentheses.  Depending on the model of
camera connected, some Custom Settings may not be available (unless indicated otherwise, settings are
available for all models of camera supported under Nikon Capture 2).
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The Page 1 Tab

The items available in the Page 1 tab depend on the model of camera connected.  When the D1 is
connected, the following settings are displayed:

The following settings are displayed when the D1X or D1H is connected:
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Exposure Bracketing
Bracketing Order (#3)
This setting controls the order in which shots are taken when exposure bracketing is used.  The follow-
ing options are available:

Same as Auto Bracketing (default):
Shots are taken in the order : no compensation, negative compensation
(underexposure), positive compensation (overexposure).

Negative to Positive:
Shots are taken in the order: negative compensation (underexposure), no
compensation, positive compensation (overexposure).

AE/Flash Bracketing (#11)
Use this item to select whether bracketing affects only autoexposure, only flash exposure, or both.

AE Only: Only autoexposure bracketing is performed.
Flash Only: Only flash exposure bracketing is performed.
AE and Flash (default):

Autoexposure bracketing and flash exposure bracketing are performed
together.

Autofocus
Activate when Shutter Button is pressed half way (#4)
If this option is checked (default), autofocus is activated when the shutter-release button is pressed
halfway.  If this option is not checked, autofocus must be activated using one of the AF start (AF-ON)
buttons on the camera.

Focus Area Selection (#6)
This setting controls AF area selection.  The following options are available:

Wrap-around disabled (default):
The focus area display is bounded by the four outer focus areas, so that, for
example, pressing the focus selector up when the top focus area is already
selected will have no effect.

Wrap-around in effect:
The focus area “wraps around” from top to bottom and right to left.  Press-
ing the focus selector up when the top focus area is highlighted selects the
bottom focus area.  Similarly, pressing the selector to the right when the
right area is highlighted selects the left focus area.

Dynamic AF Mode in Single-Servo AF (#9)
These options are used to disable or enable closest-subject priority when dynamic AF is used with
single-servo autofocus.

Selected AF Area Priority:
Closest subject priority disabled.

Closest Subject Priority (default):
Closest subject priority enabled.  When closest subject priority is enabled,
the camera assesses the distance to the subjects in each focus area and
automatically selects the subject closest to the camera.
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Dynamic AF Mode in Continuous Servo AF (#10)
These options are used to enable or disable closest-subject priority when dynamic AF is used with
continuous-servo autofocus.

Selected AF Area Priority (default):
Closest subject priority disabled.

Closest Subject Priority:
Closest subject priority enabled.  When closest subject priority is enabled,
the camera assesses the distance to the subjects in each focus area and
automatically selects the subject closest to the camera.

EV Steps for Exposure Control (#2)
Sets the size of the increment for adjusting aperture, shutter speed, exposure compensation, and auto
bracketing.

1/3 EV Step (default): Adjustments to exposure settings are made in increments of 1/
3
EV.

1/2 EV Step: Adjustments to exposure settings are made in increments of 1/
2
EV.

1 EV Step: Adjustments to exposure settings are made in increments of 1 EV.

ISO Step Value (#20) (D1X and D1H only)
Sets the size of the increment for adjusting sensitivity (ISO equivalency).

1/3 EV Step (default): Adjustments to sensitivity are made in increments equivalent to 1/
3
EV.

1/2 EV Step: Adjustments to sensitivity are made in increments equivalent to 1/
2
EV.

1 EV Step: Adjustments to sensitivity are made in increments equivalent to 1 EV.

Center-weighted metering area (#14)
The diameter of the area assigned the greatest weight in center-weighted metering can be set to 6 mm,
8 mm, 10 mm, 13 mm, or to the average of the entire frame.
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The Page 2 Tab

The items available in the Page 2 tab depend on the model of camera connected.  When the D1 is
connected, the following settings are displayed:

The following settings are displayed when the D1X is connected:

The following settings are displayed when the D1H is connected:
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AE Lock when Shutter Button is pressed half way (#7)
When this item is checked, exposure is locked while the shutter-release button is pressed halfway.  If it
is not checked (the default setting), the AE-L/AF-L button on the camera must be pressed to lock
exposure.

Exchange functions for Front and Rear Command Dials (#12)
If this option is checked, the functions of the main- and sub-command dials are reversed.  Default is off.

Easy Exposure Compensation (#13)
If this option is checked, exposure compensation can be set by turning the sub-command dial (pro-
grammed auto or shutter-priority auto) or main command dial (aperture-priority auto or manual). If
the roles of the main command and sub-command dials are switched using Custom Setting 12, expo-
sure compensation will be assigned to the sub-command dial in programmed auto, aperture-priority
auto, and manual modes, and to the main command dial in shutter- priority auto.  If this option is not
checked, exposure compensation can be set by pressing the exposure compensation button on the
camera while rotating the main command dial.  Default is off.

Anti-Mirror-Shock Mode (#5)
If this option is checked, the shutter will release slightly after the shutter-release button has been pressed,
minimizing camera shake.  Default is off.

Disable Shutter Button if no CF Card present (#34) (D1X and D1H only)
If this option is checked, the shutter can not be released when no memory card is inserted in the
camera.

LCD Display
Always use LCD illumination (#17)
When this item is checked, the LCD illuminators (backlights) will light when any button is pressed.  By
default, the LCD illuminators are controlled by the camera power switch.

Zoom-Playback while writing images (#36) (D1X only)
Checking this option allows you to zoom in on images that are displayed in the monitor as they are
being recorded to the memory card.

Assign Command Dial

The functions of the command dials in programmed auto are not affected by Custom Setting 12.
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Image Review (#1)
This setting controls whether photographs are displayed in the monitor after they are taken.  The D1X

and D1H normally only display photographs when the monitor button is pressed; if desired, however,
this setting can be used to display photographs automatically as they are recorded to the memory card.
The D1 can be set to display images taken in single-frame or self-timer modes in the monitor before
they are saved to the memory card, allowing the user to decide whether or not to save the image to the
memory card, or to display images as they are saved to the memory card.

Photograph is not Displayed (default):
Photographs are not displayed in the monitor after they are taken.

Capture-Preview mode (D1 only):
Photograph is displayed in the monitor before being saved to the memory card.

Record and Review mode:
Photograph is displayed in the monitor while being saved to the memory card.

Monitor-off Delay (#18)
This setting determines the length of time the camera monitor will remain on when no operations are
performed. The limit for display can be set to 10 seconds (D1X and D1H only), 20 seconds (default), 1
minute, 5 minutes, or 10 minutes.

Display mode (#27)
This setting allows the user to determine what information is available when images are played back.
The user can opt to include a histogram and/or highlight point display in playback photo information
display.  For details, see the documentation provided with your camera.
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File number sequence (#29)
When auto file numbering is turned on, the camera assigns all subsequent folder and file numbers
sequentially in ascending order,.  If the memory card is formatted or a new card inserted, folder and file
numbering will continue from the last numbers used.  This makes it easier to keep track of photographs
and helps prevent files and folders from being accidentally overwritten when copied to a computer.  If
auto file numbering is turned off, the camera will no longer store the last folder and file numbers used.

Off (default): Normal file name assignment.
On: Sequential file name assignment.

Rear Control Panel Display (#35) (D1X and D1H only)
This setting determines whether the display in the rear control panel shows the current sensitivity (ISO
equivalency) setting or the number of exposures remaining.

ISO sensitivity (default):
Rear control panel shows the current sensitivity setting.

Remaining Frame Count:
Rear control panel shows the number of exposures remaining.
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The Page 3 Tab

The items available in the Page 3 tab depend on the model of camera connected.  When the D1 is
connected, the following settings are displayed:

The following settings are displayed when the D1X or D1H is connected:

Blink Self-Timer LED when Shutter is released (#20) (D1 only)
When this item is checked, the self-timer lamp blinks once to confirm shutter released.  Default is off.

Change aperture setting via lens aperture ring (#22)
If this option is checked, aperture can only be set using the lens aperture ring.

Aperture Setting

When Aperture Setting is checked, aperture is shown in increments of one step and aperture can
only be adjusted using the aperture ring, regardless of the command-dial assignment chosen in
Custom Setting 12.
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Auto meter-off delay (#15)
This setting allows the user to determine the duration of time that the camera meters remain on after
you take your finger off the shutter-release button.  Auto meter switch-off can be set to four, six, eight,
or sixteen seconds (note that longer times shorten battery life).  The default is six seconds.

Self-Timer delay (#16)
This setting allows the user to determine the delay between your pressing shutter-release button and
the shutter being released in self-timer mode.  Delay can be set to two, five, ten, or twenty seconds. The
default is ten seconds.

Aperture control during zoom (#19)
On lenses with a variable focal length (for example, Micro Nikkor or zoom lenses), maximum aperture
varies with focal length.  This setting determines how such changes in the maximum aperture affect the
f/-number specified by the user in aperture-priority auto or manual exposure modes.  By default,
aperture remains fixed at the specified f/-number while the lens is zoomed in or out.  If desired, the
camera can instead be set to vary the f/-number with focal length so that aperture remains a fixed
number of steps from the maximum setting.  Suppose, for example, that a 70–210 mm, f/4–5.6 AF
Zoom-Nikkor lens is mounted on the camera, and an aperture of f/8 is selected when the lens is
zoomed out to 70 mm.  At this zoom position, f/8 is two steps from the maximum aperture of f/4.  Now
imagine that the lens is zoomed out to 210 mm.  If fixed aperture is selected, aperture will remain
constant at f/8.  If aperture is set to vary with focal length, however, aperture will decrease to f/11, two
steps from f/5.6, the maximum value for this focal length.

Fixed (default):
Aperture does not vary with focal length.

Variable: Aperture varies with focal length.

AE-L/AF-L Button (#21)
This option determines the functions performed by the AE-L/AF-L button.

AE Lock and AF Lock (default):
Both auto exposure and autofocus are locked while the AE-L/AF-L button is pressed.

AE Lock Only:
Only auto exposure is locked while the AE-L/AF-L button is pressed.

AF Lock Only:
Only autofocus is locked while the AE-L/AF-L button is pressed.

AE Lock  and Hold:
Auto exposure is locked when the AE-L/AF-L button is pressed, and remains locked
until the button is pressed a second time.
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Image sharpening (#23)
This setting controls the amount of sharpening performed by the camera to make edges more distinct.
Sharpening can be turned off or set to None, Low, Normal (the default value), or High.

Tone compensation (#24)
The user can choose from Auto (the default value), Normal, Less Contrast, More Contrast, or User-
Defined Custom Curve.

Edit Camera Curves
When User-Defined Custom Curve is chosen for Tone Compensation, the user can create a custom
tone curve in the Edit Camera Curves dialog and download it to the camera.

To create a custom curve, click the Edit… (Windows) or Choose… button (Macintosh).  The Edit
Camera Curves window will be displayed.

The controls in the Edit Camera Curves window are identical to those in the Curves window, except
in the following respects: (1) only the master channel, not individual RGB channels, may be edited; (2)
there is a limit of 20 spline points; (3) the midpoint may not be edited; (4) a user-defined sample image
can be displayed.

The upper left section of the Edit Camera Curves window contains Load… and Save… buttons.  By
clicking the Load… button, previously stored curves, with less than 20 spline points, can be selected via
the “Open” dialog (if the selected file has more than 20 spline points, a warning will be displayed, and no
file will be loaded).  In Windows, look for files with the “.ncv” extension.

The Save… button opens the “Save As” dialog, where you can save the current curve.
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Color Mode (#32) (D1X and D1H only)
The color mode can be chosen from Mode I (sRGB) and Mode II (Adobe RGB).

Hue Adjustment (#33) (D1X and D1H only)
Drag the slider to adjust hue.  Values for hue adjustment range from zero to six, with three being the
default value.  Raising hue adjustment above three will introduce a yellow cast, while values below three
will introduce a blue cast.

Continuous-Mode shooting speed (#25)
This setting sets the rate at which photographs are taken in continuous mode.  The options available
depend on the camera model.  The D1 offers settings of continuous low speed (CL, where each
photograph is saved to the memory card before the next photograph is recorded), one, two, three, or
four frames per second and a default setting of continuous high speed (CH; about 4.5 frames per
second).  The D1X offers settings of one, two, and three frames per second (default three frames per
second), the D1H settings of one, two, three, or four frames per second and a default setting of continu-
ous high speed (CH, about 4.5 frames per second).
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Continuous-Mode max shots (#26)
This setting limits the number of frames that can be taken in a single sequence in continuous mode.  The
range of values available depends on the camera model.  The maximum for the D1 can be set to any
value between one and twenty-one (or between one and ten in RAW mode), the maximum for the
D1x to any value between one and nine (one to six in RAW mode), and the maximum for the D1H to
any value between one and forty (one to twenty-seven in RAW mode).

ISO boost (#31)
This setting is used to raise sensitivity (ISO equivalency) one or two steps above the maximum setting.
Sensitivity boost can be used to obtain higher shutter speeds at night-time sporting events, for example,
or to prevent underexposure when photographing poorly-lit subjects.  Note, however, that sensitivity
boost increases the amount of “noise” (a mottling effect similar to the effects of film grain in high-speed
film) that appears in the final photograph.  The options available depend on the camera model:

D1/D1H

• Off: ISO boost off; sensitivity can be adjusted normally.
• 1 step over 1600: Sensitivity raised roughly one step (1 EV) over ISO 1600 equivalent.  Rear

control panel shows HI-1.
• 2 steps over 1600: Sensitivity raised roughly two steps (2 EV) over ISO 1600 equivalent.  Rear

control panel shows HI-2.
D1X

• Off: ISO boost off; sensitivity can be adjusted normally.
• 1 step over 800: Sensitivity raised roughly one step (1 EV) over ISO 800 equivalent.  Rear

control panel shows HI-1.
• 2 steps over 800: Sensitivity raised roughly two steps (2 EV) over ISO 800 equivalent.  Rear

control panel shows HI-2.
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This chapter describes the options available in the Preferences dialog.

Preferences
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To view the Preferences dialog, select Preferences… from the File (Windows) or Edit (Macintosh)
menu.  The Preferences dialog contains the following six tabs:

Tab Function

pp.
195-196

General
Adjust image window display settings and specify the default image en-
hancement options that will apply to newly captured images.

pg. 198Thumbnails Options for deleting the images in the thumbnails folder.

pg. 199
Advanced

Color
Set the defaults for the white and black points in the Curves window.

pg. 200Grid Lines
Specify the spacing and color of the grid displayed in the Preview section
or in image windows.

pg. 201CMS
Select the color profiles used by the Nikon Color Management System
(CMS).

pg. 197File Locations
Specify the location of the folders used for temporary storage and choose
the application that will be used to open saved images.

Viewing Preferences

To view settings in any of the six panes, click the appropriate tab.

Tab
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The General Tab

The General tab contains the following items:

Display Shooting Data in Image Windows
When this box is checked, the Shooting Data section will be displayed.

Open Shooting Data automatically
If the Display Shooting Data in Image Windows option is checked, you can choose whether the
Shooting Data section will be opened automatically when the Camera Image window or a new image
window is opened.

Copy Shooting Data to IPTC Caption
Check this item to automatically copy photo information to the caption area of the IPTC record in file
formats that support this option.

Next Camera Image
Choose the settings (Curves, Color Balance, Unsharp Mask, crop size and location, and output size and
resolution) that will apply to the next image captured from the camera.

Use current settings:
The settings now in effect are applied to the next image.

Use settings defined in:
The settings in the selected file are applied to the next image.  To select
new default settings, click Browse….
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Default file save format
Select the default file format for images saved using the Save as… option.  The following options are
available: Current file format, NEF (Nikon Electronic Image Format), JPEG (EXIF Compliant), JPEG (JFIF
Compliant), TIFF (RGB), TIFF (CMYK), BMP (Windows version only), PICT (Macintosh version only).

While Nikon Capture is running, keep camera awake:
Set the length of time before exposure meters turn off automatically when the camera is running on
battery power.  This setting only takes effect when the camera is connected and powered on, and only
when the camera is operating on battery power.  This setting takes precedence over option chosen in
Custom Setting 15.

for 15 minutes: The time before exposure meters turn off automatically is set to fifteen
minutes.

Always: The camera stays awake indefinitely.

When powered by an EH-4 AC adapter (available separately), the camera stays awake indefinitely,
regardless of the setting chosen using the above option.

Current file format

When this option is selected, the default file format is whatever format is currently selected in the
Save As dialog.  When an image created with the Create Copy option is saved for the first time,
however, the last file format chosen is used.
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The File Locations Tab

The File Locations tab contains the following items:

Folder for Camera Thumbnails:
Specify the folder in which image and other data used in the Camera Image window will be stored.  The
default folder is the “Thumb” folder in the directory to which Nikon Capture was installed.  To choose
a different folder, click the Browse… button and navigate to the desired location.

Folder for Temporary Data:
Specify the folder or volume in which temporary data, such as image cache data, will be stored.  The
default folder for Windows is the “TEMP” folder in the Windows directory, while the default volume for
the Macintosh is the start-up disk.  To choose a different folder in the Windows version of the program,
click the Browse… button and navigate to the desired location.  In the Macintosh version, a new
volume can be chosen from the pop-up menu.

Open saved image in external application
If this option is checked and you attempt to use Nikon Capture 2 to open images saved in TIFF, JPEG,
BMP, or PICT formats, the images will instead be opened in a specified third-party application.  Images
will also automatically be opened in the specified application when saved in any of these formats with
the Open in External Application option checked (  pg. 91).   To specify the application used,
check this option and enter the desired file name and path (twenty-five characters or less), or click the
Browse… button to navigate to the desired application.

Add saved images to Canto Cumulus 5
When this item is checked, images will automatically be catalogued in a Canto Cumulus 5 catalog file as
they are saved.  To choose a catalog file, click the Browse… button and navigate to the desired file.
Canto Cumulus 5 must be installed for this option to take effect.
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The Thumbnails Tab

The Thumbnails tab offers a choice of settings for the Thumbnails section in the Camera Image window.

Clear Camera Image Window on Exit
Controls whether thumbnails will be removed from the Thumbnails section when you exit Nikon
Capture.  If this box is checked, a confirmation dialog will be displayed on exit (no dialog will be
displayed if there are no thumbnails in the Camera Image window).  If this box is not checked, thumb-
nails will be saved, to be displayed in the Thumbnails section when you next start Nikon Capture 2.

Auto-Remove thumbnail after save
Controls whether the associated thumbnail preview will automatically be removed from the Thumb-
nails section when an image is saved.

Confirm before deleting thumbnails
Check this option to have Nikon Capture 2 display a warning dialog before deleting a captured image
that has not been saved.

Next Thumbnail ID:
Displays the ID that will be used for the next thumbnail loaded into the Camera Image window.

Reset ID
Click this button to reset the thumbnail ID for the next thumbnail loaded into the Camera Image
window to one (1).
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The Advanced Color Tab

The Advanced Color tab offers the following options:

Auto-Contrast clip:
Controls how the auto contrast operation calculates the input values for the white point and black
point.  By default, the white point is set to a value that excludes 0.50% of the brightest pixels in the
current crop, the black point to a value that excludes 0.50% of the darkest pixels in the crop.  This
produces an optimal dynamic range, with minimum loss of detail in shadows and highlights.  To preserve
detail at the expense of dynamic range, lower the “excluded” value for auto contrast (a value of 0 will
set the black and white points respectively to the darkest and brightest pixel in the crop).  To increase
the dynamic range at the expense of detail, raise the “excluded” value.

Black Dropper value/White Dropper value:
Controls the default output values for white point and black point.  Output for each channel can be set
to a value between zero and 255; these settings can also be adjusted in the Curves window.  By default,
output levels for the white point are 255 for each channel, which displays as white on most computer
monitors.  The defaults for the black point are 0 for each channel, which displays as black.

Dropper sample size:
This setting determines the size of the area sampled with the eyedropper cursor.  You can select a
sample sizes of Point Sample (the default setting), 3 × 3 Average, and 5 × 5 Average.  When the sample
size is set to 3 × 3 or 5 × 5 Average, the average for the pixels sampled is used.  Choosing a large sample
size reduces precision, but also minimizes the effects of noise; choosing a small sample size has the
opposite effect.

Show degrees Kelvin for White Balance
When this option is checked, the color temperature is displayed in the White Balance and Fine Tune
White Balance windows.

Reset to Default
Click this button to restore settings in the Advanced Color tab to their default values.
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The Grid Lines Tab

The Grid Lines tab controls the color and spacing of the non-printing grid lines overlaid on an image
when Show Grid Lines is selected from the Image menu.

Color:
The color of the grid lines can be selected from white, light gray, dark gray, black, red, green, blue, cyan,
magenta, and yellow.

Display grid line every:
Enter a value for grid spacing in the text box.  The units for the grid can be selected from the pop-up
menu to the right of the text box.  The options available are pixels, inches, millimeters, centimeters, picas,
and points; at settings other than pixels grid spacing can be entered up to two decimal points.

Display n subdivisions per line
The number of subdivisions into which each grid cell will be divided.  The main grid is displayed as solid
lines of the color specified using the Color option, the subgrid as broken lines of the same color.
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The CMS Tab

The CMS tab is where you specify the color management profiles used for displaying images on your
monitor, editing and saving RGB images, and saving and printing CMYK images.

Monitor profile
The ICC monitor profile used to adjust the display for the non-linear characteristics of your monitor is
displayed here.  To choose a different profile, click the Browse… button and navigate to the desired
location.

Working RGB color space
The RGB color-space profile used for output when an image is saved can be selected from sRGB, Bruce
RGB, NTSC (1953), Adobe RGB (1998), CIE RGB, Wide Gamut RGB, Apple RGB, and Color Match
RGB.

CMYK separation profile
The profile used when converting RGB images to CMYK is displayed here.  To choose a different profile,
click the Browse…  button and navigate to the desired location.

RGB Color-Space Profiles

See page 220 for more information on the standard color-space profiles supported under Nikon
Capture 2.

Supported Color Profiles

Nikon Capture 2 supports only ICC (International Color Consortium) monitor and CMYK profiles.
Particular care should be exercised when choosing a CMYK profile, as the profile supplied by the
manufacturer of your output device may not be an ICC profile.
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This chapter describes the options available in the menus, toolbar (Windows), and tool palette
(Macintosh).

Reference
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Menu Commands

The File Menu

The File menu contains the following options:

Windows Macintosh

Open… Images saved in Nikon Capture’s Nikon Electronic Image Format (NEF)
can be opened and viewed.  Unedited images taken by the camera in JPEG
and TIFF formats can also be opened.

Close Closes the active window.

Save Saves the selected image.  Images saved in a format other than NEF can
not be opened again in Nikon Capture 2.

Save As… Use this option to saves the selected image in NEF format or a format that
can be read by third-party applications such as Adobe Photoshop (TIFF,
JPEG, etc.).  Images saved in a format other than NEF can not be opened
again in Nikon Capture 2.

Batch… Displays the Batch dialog.  Images will be processed automatically accord-
ing to user-specified settings.  See “Batch Processing” (  pg. 131) for more
information.

Create Copy A copy of the image selected in the Camera Image window or, if an image
window is active, of the image in the active image window will appear in a
new image window.

Preferences… (Windows only)
The Preferences dialog will open, where you can make adjustments to
preferences.  See “Preferences” for details (  pg. 193).

Recent File (Windows only)
Recent files will be listed in the order opened.

Exit (Windows)/
Quit (Macintosh) Quit Nikon Capture.
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The Edit Menu

The Edit menu contains the following options:

Windows Macintosh

Undo/Cut/Copy These commands can not be used in Nikon Capture 2.

Copy Image Adjustments…

You can select which groups of settings you would like to copy to the
clipboard.  Click on the Copy button after selecting White Balance, Ad-
vanced RAW, Curves, Color Adjustment, Unsharp Mask and/or Size/Reso-
lution.

Copy All Image Adjustments
Copies all settings to the clipboard.

Paste Applies the copied settings to the image in the active window.

Clear This command can not be used in Nikon Capture 2.

Preferences… (Macintosh only)
The Preferences dialog will open, where you can make adjustments to
preferences.  See “Preferences” for details (  pg. 193).
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The View Menu

The View menu contains the following options:

Windows Macintosh

View Entire Image Nikon Capture 2 adjusts the magnification of the image to fit the active
window.

Fit Window to Image Nikon Capture 2 adjusts the size of the active window to fit the image.

Auto Fit Window to Image
When this option is checked, the active window will automatically be ad-
justed to fit the image after any zoom or rotate operations.

Selection Cursor When this option is checked, the cursor becomes a , allowing you to
select a portion of the image in the active window.

Zoom Cursor When this option is checked, the cursor becomes a , allowing you to
zoom in on a portion of the image in the active window.  To zoom out, hold
down the Ctrl (Windows) or option (Macintosh) key while clicking in the
active window.

Grab Cursor When this option is checked, the cursor becomes a , allowing you to
scroll the image in the active window to view another area of the image.
This function performs much the same function as scrolling the window,
although with slightly more control.
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Zoom In Select this option to zoom in on the image in the active window.

Zoom Out Select this option to zoom out from the image in the active window.

Camera Image When Camera Image is checked, the Camera Image window will be dis-
played.

Shooting Data Section When this option is checked, the Shooting Data section is displayed in the
active window.

Thumbnails Section When this option is checked, the Thumbnails section is displayed in the
Camera Image window.

Camera Control Selecting this option opens the Camera Control window, where you can
make changes to camera settings and take photos.

Image Adjustment Control Panel
When this options is checked, the Image Adjustment Control Panel is dis-
played.

White Balance When this options is checked, the White Balance window is displayed.

Advanced RAW When this options is checked, the Advanced RAW window is displayed.

Curves When this option is checked, the Curves window is displayed.

Color Balance When this option is checked, the Color Balance window is displayed.

Unsharp Mask When this option is checked, the Unsharp Mask window is displayed.

Size/Resolution When this option is checked, the Size/Resolution window is displayed.

Bird’s Eye When this option is checked, the Bird’s Eye window is displayed.

Information Check this option to display the Information window.

Toolbar/
Tool Palette Check this option to display the toolbar (Windows) or tool palette

(Macintosh).

Status Bar (Windows only) Check this option to display the status bar at the bottom of the Nikon
Capture 2 window.
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The Image Menu

The Image menu contains the following options:

Windows Macintosh

Open in Photoshop Selected image opened in Adobe Photoshop.  Image adjustment settings in
Nikon Capture 2 are applied to the image before it is passed to Adobe
Photoshop.  Note that this option requires that Adobe Photoshop version
5.5 or later be installed on your computer.

Select Entire Image Selects entire image.

Flip When you click on this item, a submenu appears giving you the choice of
flipping the image currently visible in the active window horizontally or
vertically.

Rotate When you click on this item, a submenu appears giving you the choice of
rotating the image in the active window 180°, 90° clockwise or 90° coun-
terclockwise.

Show Grid Lines When this option is selected, a non-printing grid becomes visible over the
image in the active window.  Grid Line settings can be adjusted from the
Preference window’s Grid Lines tab.

Use for Camera Curves Sample
Select the current thumbnail as the sample image for the Edit Camera
Curves window in the Custom Settings dialog.  Note that only RAW im-
ages can be used.
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Select All Thumbnails Highlights all thumbnails in the Thumbnails section.

Deselect All Thumbnails
Removes highlights from all thumbnails in the Thumbnails section.

Remove Selected Thumbnails
Deletes the thumbnails selected in the Camera Image window.

Remove All Thumbnails
Deletes all images in the Camera Image window.
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The Camera Menu

The Camera menu contains the following options:

Windows Macintosh

Custom Settings… Opens the Custom Settings window, where you can adjust Custom Set-
tings and apply them directly to the camera (  pg. 178).

Set Date and Time… The following dialog will open, where you can set the camera’s internal
clock calendar to the current date and time.  To view the date and time
settings in effect in the camera, click Use Current Date/Time.  Click
OK to put any changes to the date and time into effect.

Edit Camera Curves… Opens the Edit Camera Curves dialog, where you can edit the curve used
when “User-Defined Custom Curve” is selected for Custom Setting 24
(  pg. 189).

Time Lapse Photography…
Use this option to program the camera to take a series of photos at pre-
specified intervals (  pg. 176).
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The Camera Menu

The Camera menu is only available when a camera is connected.

Measure White Balance…
Use this option to measure white balance for the preset white-balance
option in the camera’s white balance menu.  If the camera supports mul-
tiple preset white-balance settings, the setting that will be used to store the
measured value can be selected from the pop-up menu at the top of the
dialog.  After selecting a white-balance setting (if applicable), click OK to
measure white balance.  For more information, see the camera User’s Manual.

D1

D1X, D1H

Edit Camera ID… So that your computer will recognize and remember the camera when it is
attached, you can use the following dialog to give your camera a name up
to thirty-eight characters in length.
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The Settings Menu

The Settings menu contains the following options:

Windows Macintosh

Camera Control The Camera Control menu is used to save and load the settings in the
Camera Control window.  Select Save… to save the current settings to a
named file, Load… to load settings from a selected file and apply them to the
Camera Control window (  pg. 175).

Image Adjustments The Image Adjustments submenu is used to save and load the settings in
the Image Adjustment Control Panel window.  Select Save… to save the cur-
rent settings to a named joint settings file, Load… to load settings from a
selected file and apply them to the Image Adjustment Control Panel window
(  pg. 96).

White Balance The White Balance menu is used to save, load, or reset the settings in the
White Balance window.  Select Save… to save the current settings to a named
file, Load… to load settings from a selected file and apply them to the White
Balance window.  Select Reset to Recorded Value to restore the white
balance setting in effect at the time the photograph was taken (  pg. 102).
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Advanced RAW The Advanced RAW menu is used to save, load, or reset the settings in the
Advanced RAW window.  Select Save… to save the current settings to a
named file, Load… to load settings from a selected file and apply them to the
Advanced RAW window.  Select Reset to Neutral to restore the settings in
effect at the time the photograph was taken (  pg. 106).

Curves The Curves menu is used to save, load, or reset the settings in the Curves
window.  Select Save… to save the current settings to a named file, Load…
to load settings from a selected file and apply them to the Curves window.
Select Reset to Neutral to return all tone curves to linear (  117).

Color Balance The Color Balance menu is used to save, load, or reset the settings in the
Color Balance window.  Select Save… to save the current settings to a named
file, Load… to load settings from a selected file and apply them to the Color
Balance window.  Select Reset to Neutral to return settings for brightness,
contrast, and color balance to zero (  pg. 121).

Unsharp Mask The Unsharp Mask menu is used to save, load, or reset the settings in the
Unsharp Mask window.  Select Save… to save the current settings to a named
file, Load… to load settings from a selected file and apply them to the Unsharp
Mask window.  Select Reset to Neutral to delete all existing Unsharp Masks
(  pg. 125).

Size/Resolution The Size/Resolution menu is used to save, load, or reset the settings in the
Size/Resolution window.  Select Save… to save the current settings to a named
file, Load… to load settings from a selected file and apply them to the Size/
Resolution window.  Select Reset to 100% to enlarge the crop to select the
entire image and set the scale to 100% (  pg. 129).

Right-Button Menus (Windows)

In the Windows version of Nikon Capture 2, the settings menu for a given window can be displayed
by right-clicking anywhere in the menu.
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Windows Macintosh

Cascade/Stack Arranges the Camera Image window and image windows so that they overlap.

Tile (Windows only) Arranges the Camera Image window and image windows so that they do not
overlap.

Arrange Icons (Windows only)
If the Camera Image window or any image windows have been reduced to
icons, this command will arrange the icons along the bottom of the Nikon
Capture 2 window.

Open Windows A list of the windows currently open in Nikon Capture 2 is displayed at end of
the Window menu.

The Window Menu

The Window menu contains the following options:
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The Help Menu

The Help menu contains the following options:

Windows Macintosh

Help Topics/Nikon Capture Help
Selecting Help Topics (Windows) or Nikon Capture Help (Macintosh)
opens the Nikon Capture 2 Help file to an index-type listing of help topics.

About Nikon Capture… (Windows only)
Opens a window which displays the product name, version number, and copy-
right information.

For more information about the other options available in the Macintosh help menu, see the documen-
tation provided with your computer or operating system.
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The Tool Palette (Macintosh)
The palette can be moved anywhere on the desktop, or hidden or displayed using the Tool Palette
item in the View menu.

The Disk-Space Indicator

The color of the disk space indicator shows how much unused hard-disk space is available.
Green: More than 200 MBs available on both the volume used for temporary storage and on the

volume used to store thumbnails
Yellow: Less than 200 MBs remaining on one or both volumes.
Red: Less than 100 MBs remaining on one or both volumes. Choose a different volume from the

File Locations tab of the Preferences dialog (  pg. 197), or free space by deleting unneces-
sary files.

Connection Status Indicator

The camera icon at the bottom of the status bar (Windows) or the tool palette (Macintosh) is the
connection status indicator.  See the Tutorial for details (  pg. 64, 65).

The Toolbar (Windows) and Tool Palette (Macintosh)

By clicking the buttons in the toolbar (Windows) or tool palette (Macintosh), you can perform a variety
of operations, most of which replicate menu commands.

The Toolbar (Windows)
The toolbar at the top of the Nikon Capture 2 window can be hidden or displayed by selecting
Toolbar from the View menu.  When the cursor is positioned over a button, a label will pop up
explaining its function.

The functions of the buttons in the toolbar and tool palette are explained opposite.
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Button Function

Same as the Selection Cursor command in the View menu.

Same as the Zoom Cursor command in the View menu.

Same as the Grab Cursor command in the View menu.

Same as the Camera Control command in the View menu.

Same as the Image Adjustment Control Panel command in the View menu.

Same as the Camera Image command in the View menu.

Same as the 90 degrees CW command in the Image > Rotate submenu.

Same as the 90 degrees CCW command in the Image > Rotate submenu.

Same as the Batch command in the File menu.

Same as the Custom Settings command in the Camera menu.

When this button is clicked, a question mark appears next to the mouse pointer.  Click-
ing on a window, menu, or button while the question mark is displayed will open the help
file to the section that explains the function of the item clicked (Windows only).

The effects of changes to settings in the active image adjustment window (White Bal-
ance, Advanced RAW, Curves, Color Balance, or Unsharp Mask window) are hidden
while this button is held down.

Same as the Open command in the File menu.

Same as the Save command in the File menu.

Same as the Open in Photoshop command in the Image menu.

Same as the Copy Image Adjustment command in the Edit menu.

Same as the Paste command in the Edit menu.
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Appendices
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Appendix A: Supported Color Profiles

1. Standard RGB Profiles Supported in Nikon Capture 2

1.1 Profiles with a Gamma Value of 1.8
Apple RGB
This profile is used in desk-top publishing applications and in Adobe Photoshop versions 4.0 or earlier,
and is the typical RGB profile for Macintosh monitors.  The corresponding RGB setting in Adobe
Photoshop is “Apple RGB.”  This profile is suitable for working with images displayed on the Macintosh.

ColorMatch RGB
The ColorMatch profile is native to Radius PressView monitors.  It has a wider gamut than Apple RGB,
with a particularly wide area devoted to the reproduction of blues.  The corresponding RGB setting in
Adobe Photoshop is “Color Match RGB.”

1.2 Profiles with a Gamma Value of 2.2
sRGB
This RGB profile is used in the majority of Windows monitors.  It closely resembles the RGB commonly
used in color television, and is also used in the digital television broadcasting system that is on its way to
becoming the industry standard in the United States of America.  Software and hardware manufactur-
ers use it as a default color profile and guarantee operation when it used.  It is also on its way to
becoming the standard for images on the web. This profile is suited to users who plan to use their digital
images “as is,” without editing or printing them.  It however suffers from the drawback of a narrow
gamut with a limited area available for reproducing blues. The corresponding RGB setting in Adobe
Photoshop 5.0 and 5.5 is “sRGB,” the corresponding setting in Adobe Photoshop 6.0 “sRGB IWC61966-
2.1.”

Bruce RGB
This color profile attempts to expand on the ColorMatch RGB gamut by defining the chromaticity for
G as lying between the values for G in the Adobe RGB and ColorMatch color-space profiles.  It was
proposed by Bruce Fraser, who claims that it includes most of the colors in the SWOP CMYK gamut.
The R and B used in the Bruce RGB and Adobe RGB color-space profiles match.

NTSC (1953)
This is the color space for video defined by the National Television Standards Committee (NTSC) in
1953 and used in early color televisions.  This color space is also used in some Far-East newspaper and
printing organizations.  The corresponding RGB setting in Adobe Photoshop is “NTSC (1953).”
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Gamut

Adobe RGB (1998)
A color-space profile defined in Adobe Photoshop 5.0.  It has a wider gamut than sRGB and includes the
colors found in most CMYK gamuts, making it suitable for users involved in desktop publishing.  The
corresponding RGB setting in Adobe Photoshop 5.0 is “SMPTE-240M,” the corresponding setting in
Adobe Photoshop 5.5 or later “Adobe RGB (1998).”

CIE RGB
A video color-space profile established by the Commission Internationale de l’Éclairage (CIE).  While it
boasts a fairly wide gamut, it suffers from the drawback that the area devoted to the reproduction of
cyan is relatively small.  The corresponding RGB setting in Adobe Photoshop is “CIE RGB.”

Wide Gamut RGB
This color-space profile, designed by Adobe, incorporates most of the visible colors.  This however has
the consequence that most of the colors it can express can not be reproduced on standard monitors
and printers.  The corresponding RGB setting in Adobe Photoshop 5.0 or later is “Wide Gamut RGB.”

The gamut of colors that can be expressed in the above color-space profiles is shown in the following
chromaticity (x, y) graph.  The greater the area enclosed by the triangle that represents the color-space
profile, the wider its gamut.
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2. Technical Data for RGB Profiles Supported in Nikon Capture 2

The following table shows the gamma values for profiles supported in Nikon Capture 2, together with
the chromaticity values for the white point and for red, green, and blue.

Profile
Gamma

Value

Chromaticity (x,y)White Point

Color
Temperature

Value Name R G B

x 0.31271591 0.625 0.28 0.155x

y 0.32900148 0.34 0.595 0.07y
Apple RGB 1.86500K (D65) Trinitron

x 0.34570292 0.735 0.115 0.157x

y 0.3585386 0.265 0.826 0.018y
Wide Gamut

RGB
2.25000K (D50)

700/525/
450 nm

x 0.31271591 0.64 0.3 0.15x

y 0.32900148 0.33 0.6 0.06y
Default Win-
dows monitor

2.26500K (D65)
HDTV

(CCIR 709)

x 0.34570292 0.625 0.28 0.155x

y 0.3585386 0.34 0.595 0.07y
Default Macin-
tosh monitor

1.8 Trinitron

x 0.34570292 0.63 0.295 0.155x

y 0.3585386 0.34 0.605 0.077y
Color Match

RGB
1.85000K (D50) P22-EBU

x 0.31271591 0.64 0.3 0.15x

y 0.32900148 0.33 0.6 0.06y
sRGB 2.26500K (D65)

HDTV
(CCIR 709)

x 0.3101 0.67 0.21 0.14x

y 0.3162 0.33 0.71 0.08y
NTSC (1953) 2.2

Std
Illuminant C

NTSC (1953)

x 0.31271591 0.64 0.28 0.15x

y 0.32900148 0.33 0.65 0.06y
Bruce RGB 2.26500K (D65) Bruce RGB

x 0.31271591 0.64 0.21 0.15x

y 0.32900148 0.33 0.71 0.06y
Adobe RGB

(1998)
2.26500K (D65)

Adobe RGB
(1998)

x 0.33333333 0.735 0.274 0.167x

y 0.33333333 0.265 0.717 0.009y
CIE RGB 2.2

Std
Illuminant C

CIE RGB

5000K (D50)
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ColorSync (Macintosh)

The explanation in this section assumes that ColorSync version 3.0 or later is installed on your
Macintosh.

Appendix B: Color Matching in Adobe Photoshop (Version 5.0.2
or Later)
When an image saved in Nikon Capture 2 is opened in Adobe Photoshop, the profiles used in Adobe
Photoshop should match those used in Nikon Capture 2.  If the profiles do not match, the colors seen
in Adobe Photoshop may not be the same as those in the original image.  The profiles used with Nikon
Capture 2 can be used with Adobe Photoshop version 5.0.2 or later.

The first step is to match the Nikon Capture 2 monitor profile with that used in Adobe Photoshop.  The
point to remember is that you should specify the monitor profile for Adobe Photoshop first and then
select the same profile for Nikon Capture 2.  For more information, see “Choosing a Monitor Profile”
(  pg, 224).

The next step is to save the image from Nikon Capture 2 using a format that supports inclusion of color
profile information.  If you save the image in TIFF, JPEG (JFIF), JPEG (EXIF), and PICT, information about
the color profile used in Nikon Capture 2 will be embedded in the file, and Adobe Photoshop will use
this information to process colors appropriately when the file is opened.  Color profile information can
not be included with files saved in BMP format, with the result that settings must be correctly adjusted
in Adobe Photoshop before the files are opened.  For more information, see “Adjusting Settings in
Adobe Photoshop” (  pg, 230).
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Choosing a Monitor Profile

Choose a monitor profile as described below.

Creating a New Monitor Profile
If you have not yet calibrated your monitor, use Adobe Gamma to create a profile for your monitor.
Adobe Gamma is included in the standard install of Adobe Photoshop.

Creating a Monitor Profile (Adobe Photoshop 5.x)

1 Select Color Management… from the Adobe Photoshop Help menu.

2 Click Open Adobe Gamma….
In the Adobe Color Management Assistant dialog, click Open Adobe Gamma….

3 Create a color profile.
Follow the on-screen directions to calibrate your monitor.  The resulting monitor profile will be
saved in one of the folders listed below.  Make a note of the file name.
• Windows: Windows\System\Color
• Macintosh: System Folder : ColorSync Profiles

4 Choose the profile created in Step 3 for Nikon Capture 2.
Choose the profile created in Step 3 as the Nikon Capture 2 monitor profile.  For details, see
“Preferences: The CMS Tab” (  pg. 201).
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Creating a Monitor Profile (Adobe Photoshop 6.0)

1 Select Adobe Gamma from the system control panels or double-click the Adobe Gamma
utility icon.

2 Create a color profile.
Follow the on-screen directions to calibrate your monitor.  The resulting monitor profile will be
saved in one of the folders listed below.  Make a note of the file name.
• Windows: Windows\System\Color
• Macintosh: System Folder : ColorSync Profiles

3 Choose the profile created in Step 2 for Nikon Capture 2.
Choose the profile created in Step 2 as the Nikon Capture 2 monitor profile.  For details, see
“Preferences: The CMS Tab” (  pg. 201).
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Using an Existing Monitor Profile
If you have already calibrated your monitor, follow the steps below to select an existing monitor profile.

Using an Existing Monitor Profile (Adobe Photoshop 5.x)

1 Select Color Settings > RGB Setup… from the Adobe Photoshop File menu.

2 Note the name of the monitor profile.
Make a note of the name that appears to the right of the “Monitor” entry in the second line of the
RGB Setup dialog.
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3 Locate the monitor profile.
The monitor profile that appeared in Step 2 will be stored in one of the folders listed below.
• Windows: Windows\System\Color
• Macintosh: System Folder : ColorSync Profiles

4 Choose the profile as the Nikon Capture 2 monitor profile.
Choose the profile noted in Step 2 as the Nikon Capture 2 monitor profile.  For details, see
“Preferences: The CMS Tab” (  pg. 201).
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Using an Existing Monitor Profile (Adobe Photoshop 6.0)

1 Select Color Settings… from the Adobe Photoshop Edit menu.

2 Note the name of the monitor profile.
Open the RGB pop-up menu in the Work Spaces section of the Color Settings dialog.  The
monitor profile will appear to the right of the Monitor RGB entry.  Note down the name of the
profile.

3 Locate the monitor profile.
The monitor profile that appeared in Step 2 will be stored in one of the folders listed below.
• Windows: Windows\System\Color
• Macintosh: System Folder : ColorSync Profiles

4 Choose the profile as the Nikon Capture 2 monitor profile.
Choose the profile noted in Step 2 as the Nikon Capture 2 monitor profile.  For details, see
“Preferences: The CMS Tab” (  pg. 201).

If you are unable to locate a profile with the correct name, create a new profile as directed in “Creating
a Monitor Profile” on page 227.
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Using an Existing Monitor Profile (Macintosh)

The Macintosh version of Adobe Photoshop (version 5.0.2 or later) automatically selects the ColorSync
system profile as the monitor profile.  The ColorSync system profile can be accessed from the Mac
OS Monitor control panel.  This means that you can match the Nikon Capture 2 monitor profile to
the Adobe Photoshop monitor profile as follows:

1 Copy the desired monitor profile to the System folder.
Copy the desired monitor profile to the ColorSync Profile folder in the System folder.

2 Open the Monitor control panel and click Color.

3 Select the monitor profile.
Select the monitor profile you copied to the System folder in Step 1 from the list of ColorSync
profiles and close the control panel.

4 Choose the profile as the Nikon Capture 2 monitor profile.
Choose the selected monitor profile as the Nikon Capture 2 monitor profile.  For details, see
“Preferences: The CMS Tab” (  pg. 201).
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Adjusting Settings in Adobe Photoshop

The following describes the minimum necessary adjustments to ensure consistent color reproduction
in Adobe Photoshop.  The menus and dialogs referred to below are all from Adobe Photoshop.

Opening TIFF, JPEG (JFIF), JPEG (EXIF), and PICT Images Created Using Nikon Capture 2
Images saved in TIFF, JPEG (JFIF), JPEG (EXIF) and PICT formats include color-space profile information.
Open files in these formats as described below.

Opening TIFF, JPEG (JFIF), and PICT Images in Adobe Photoshop 5.x

1 Select Color Settings > RGB Setup… from the Adobe Photoshop File menu.
The RGB Setup dialog will be displayed.

2 Check Display Using Monitor Compensation.
In the Monitor section, check Display Using Monitor Compensation.
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3 Click OK.

4 Select Color Settings > Profile Setup… from the Adobe Photoshop File menu.
The Profile Setup dialog will be displayed.

5 Select Convert to RGB Color for Profile Mismatch Handling.
Select Convert to RGB Color from the RGB pop-up menu in the Profile Mismatch Handling
section.

6 Click OK.
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2 Check Advanced Mode.

Advanced Mode

RGB pop-up menu

Profile Mismatches
section

Opening TIFF, JPEG (JFIF), and PICT Images in Adobe Photoshop 6.0

1 Select Color Settings… from the Adobe Photoshop Edit menu.
The Color Settings dialog will be displayed.
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3 Select Preserve Embedded Profiles for Color Management Policies.
Select Preserve Embedded Profiles from the RGB pop-up menu in the Color Management
Policies section.

4 Remove the check from Ask When Opening.
Remove the check from Ask When Opening in the Profile Mismatches area of the Color Man-
agement Policies section.

5 Click OK.
At these settings, a warning dialog may be displayed when an image is opened.  An option is
available in this dialog which will prevent the warning from being displayed again.
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Opening BMP Images Created Using Nikon Capture 2
Images saved in BMP format do not include color-space profile information.  Consequently, the correct
color-space profile must be selected in Adobe Photoshop before the image is opened.  Follow the steps
below to choose a color-space profile.

Opening BMP Images in Adobe Photoshop 5.x

1 Select Color Settings > RGB Setup from the Adobe Photoshop File menu.
The RGB Setup dialog will be displayed.

2 Check Display Using Monitor Compensation.
In the Monitor section, check Display Using Monitor Compensation.

3 Click OK.
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6 Select Convert to RGB Color for Profile Mismatch Handling.
Select Convert to RGB Color from the RGB pop-up menu in the Profile Mismatch Handling
section.

7 Click OK.

4 Select Color Settings > Profile Setup… from the Adobe Photoshop File menu.
The Profile Setup dialog will be displayed.

5 Select a profile that matches the output color-space profile used in Nikon Capture 2.
Using the RGB pop-up menu in the Assumed Profiles section, select a profile that matches the
output color-space profile used in Nikon Capture 2 (  238).  Note that because Photoshop does
not support the Bruce RGB color space, no matching profile can be selected when this profile is
used in Nikon Capture 2.
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2 Select Web Graphics Defaults from the Settings menu.

Advanced Mode

Working Spaces
section

Opening BMP Images in Adobe Photoshop 6.0

1 Select Color Settings… from the Adobe Photoshop Edit menu.
The Color Settings dialog will be displayed.
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3 Check Advanced Mode.

4 Select a profile that matches the output color-space profile used in Nikon Capture 2.
Using the RGB pop-up menu in the Working Spaces section, select a profile that matches the
output color-space profile used in Nikon Capture 2 (  pg.  238).  Note that because Photoshop
does not support the Bruce RGB color space, no matching profile can be selected when this
profile is used in Nikon Capture 2.

5 Click OK.
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Nikon Capture 2 and Adobe Photoshop Color Profiles

Nikon Capture 2 output profile

Adobe RGB (1998)

CIE RGB

Wide Gamut RGB

sRGB

Apple RGB

Color Match RGB

Bruce RGB

NTSC (1953)

Adobe Photoshop Profile

Version 5.5 or later: Adobe RGB (1998)
Earlier versions: SMPTE-240M

CIE RGB

Wide Gamut RGB

sRGB

Apple RGB

Color Match RGB

—

NTSC (1953)
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Nikon View 4

For more information on Nikon View 4, see the Nikon View 4 Reference Manual.

Appendix C: Processing Images After They Are Taken
This section describes the steps involved in transferring photographs taken with the D1, D1x, or D1H to
a computer and opening them in Nikon Capture 2 after the images are taken.

Transferring Existing Photographs to a Computer
Nikon Capture 2 can not be used to capture images from the camera memory card.  To capture images
already stored on the memory card:
• Remove the memory card from the camera and insert it in a card reader or card slot, where it will

function as a disk
• Use Nikon View 4 to copy images directly from the camera memory card via the camera’s IEEE

1394 interface
• Use Nikon View 4 to copy images from a card inserted in a card reader or card slot

Nikon View 4 can be used to browse the photographs taken with your camera, transfer selected images
to disk, and register images with a specified image database application.
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Transfer button

Preferences button

Copying Images from Memory Cards to Disk

This section describes how to use Nikon View 4 to copy images from a card inserted in a card reader
or card slot

1 Create a new folder.
Create a new folder on the computer’s hard disk to hold images transferred from the camera.  For
purposes of illustration, we will give this folder the name “Original.”

2 Connect the camera or insert the memory card in a card reader or card slot.
Connect the camera or remove the memory card from the camera and insert the it in a card
reader or card slot.  Nikon View 4 will start automatically and the Image Transfer window will be
displayed (the options in the Image Transfer window may differ slightly from those shown below).
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3 Choose the destination folder.
Click the Preferences button in the Image Transfer window to display the Preferences dialog.  In the
Transfer tab, select the folder you created in Step 1 as the destination folder.  If desired, you can also
select the image database software used to catalog images as they are transferred.

4 Transfer the selected images.
Click the Transfer button to transfer selected images to the folder specified in Step 3.  Images will
not be deleted from the memory card after transfer.
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Opening Transferred Images in Nikon Capture 2
Images transferred to the hard disk can be displayed in Nikon Capture 2 by selecting Open… from the
File menu.  Images that have been catalogued using image database software can be browsed and the
desired images selected from a list of thumbnail previews.  This section describes how to open images
catalogued in Canto Cumulus 5.

1 Start Canto Cumulus 5 and select the folder containing the images.
After starting Canto Cumulus 5, select the folder you created in Step 1 of the preceding section.
The images in the folder will be shown as thumbnail previews.

2 Open selected images in Nikon Capture 2.
Select the desired thumbnails and choose Open With > Other… from the Asset menu.  Choose
Nikon Capture 2 as the application that will be used to open images.  It will then appear in the
Open With sub-menu as Nikon Capture or Ncapture.  Choosing either item from the sub-
menu will open selected images in Nikon Capture 2.
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Image Database Software

For more information on image database software, see the documentation provided with the soft-
ware in question.

Settings can also be adjusted in Nikon Capture 2 so that images will automatically be opened in an
imaging application such as Adobe Photoshop as they are saved in Nikon Capture 2.  Once they are
opened in the selected imaging application, images can be edited or retouched as necessary.

3 Perform image adjustment on the selected images.
Nikon Capture 2 will start and the selected images will be opened in image windows.  Perform
image adjustment as desired.
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Batch Scanning with Image Database Software
Image database software can be used when using batch processing option in Nikon Capture 2 to
process images after transfer to the hard disk.

1 Create two new folders.
Create two new folders, one to hold the originals and the other to store the processed images, and
name them appropriately (for example, “Batch In” and “Batch Out”).

2 Using image database software, copy the images to be processed to the “Batch In” folder
Start the image database software and select the images to be processed from the list of images
that have been captured to disk.  Copy the images to the “Batch In” folder.
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3 Start Nikon Capture 2 and adjust batch settings.
Start Nikon Capture 2 and select Batch from the File menu or click the  button to open the
Batch dialog.  Select the Folder option in the Image source section and choose “Batch In” as the
folder containing the originals.  Choose the “Batch Out” folder as the Destination folder in the
Save to section.

When batch processing is performed with these settings, the processed images will be saved in the
“Batch Out” folder.  Processed files can later be opened in imaging software such as Adobe Photoshop
for further editing.
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The ReadMe File

Included on the installer CD is a README file containing the most current information on Nikon
Capture 2.  Please read this file before installing and using Nikon Capture, as it may contain impor-
tant information that could not be included in this manual.  Should you encounter problems with
Nikon Capture 2 not covered in this section, please consult the README file for the most up-to-
date information.

Appendix D: Troubleshooting
Should you encounter problems with Nikon Capture 2, check the list on the following pages before
consulting your retailer or Nikon representative.

Nikon Capture 2 Does Not Start

Confirm that your computer system meets all of the requirements specified for using Nikon Capture 2
(OS, memory, hard disk capacity, etc.).  See “Installing Nikon Capture 2.”

Nikon Capture 2 Does Not Recognize the Camera

If the camera is connected to the computer, verify that the camera’s mode dial is set to “PC.”  In PC
mode, the control panel on the top of the camera will show PC, as will the view through the camera’s
viewfinder.

If the camera is set to PC mode, and Nikon Capture 2 still does not recognize the camera, check the
following points:

1Check the power switch and mode dial
• Is the camera on?
• Is the battery fully charged?  To reduce the drain on the battery, we recommend that the camera

be powered by an EH-4 AC adapter (available separately) when connected to the computer.
• If you are using an AC adapter, is it properly connected and plugged in?

2Verify that the interface cable is properly connected
• Is the IEEE 1394 interface cable securely connected to both camera and computer?

Remember that IEEE 1394 connectors do not make a “click” when fully inserted.  If the cable is
securely connected, try disconnecting the cable and reconnecting the devices in a different order.

• Is there another peripheral connected to the IEEE 1394 bus?
Try disconnecting other IEEE 1394 devices and connecting just the computer and the camera.

3Are you using a recommended IEEE 1394 interface?
See the system requirements in “Installing Nikon Capture 2.”  For information on your IEEE 1394
interface, see the manufacturer’s web-site.
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4 Is the IEEE 1394 interface board correctly registered with the system (Windows only)?
Check whether:
• The “IEEE 1394 Bus Controller” is not displayed in the Device Manager
• The IEEE 1394 board is listed under “Other Devices” or “Unknown Devices”
• A yellow or red mark appears next to the listing for the IEEE 1394 board
If any of the above apply, the IEEE 1394 board has not been correctly registered with the system.
See the documentation provided with the board for information on device registration.

Captured Images are Too Bright, Too Dark, Washed Out, or Out of Focus

• At default settings, Nikon Capture 2 does not modify image images when they are captured from
the camera.  In the General tab of the Preferences dialog, verify that your images are being captured
at Nikon Capture’s default settings and not at the settings of the last image captured.  See “Prefer-
ences” for more information.  Alternatively, check the settings in the Curves, Color Balance, and
Unsharp Mask windows.  Choose the reset option from the Settings menu for each window, or turn
the Apply button for the window off.

• Are monitor settings correctly adjusted?
Try adjusting your monitor’s contrast/brightness, color system, etc. to be sure that it is properly set
for viewing images.  See the documentation provided with your monitor for instructions on adjusting
monitor settings.
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Appendix E: Glossary
This glossary provides definitions of some of the terms used in this manual.

Bit depth
The number of bits used to express color, also referred to as color depth.  The bit depth determines the
amount of color information in an image.  The greater the bit depth, the larger the number of colors,
and the finer the gradations, that can be expressed.  Bit depth can be used to refer both to the number
of bits per channel and to the combined bit depth for all channels; thus, for example, an image with a bit
depth of eight bits per channel can be said to have a bit depth of twenty-four bits.  An image with a bit
depth of one bit has only two colors, typically black and white, with no gradation between the two.  See
also Channel.

Black Point
The input value below which all input tones are mapped to the minimum output value (by default no
color, or black).  Any details darker than the black point will be lost.  See also Tone, Tone curve.

Channel
The component colors in a given color space.  The RGB color space is made up of red, green, and blue
channels and a master channel that combines the three.  See also Color space.

Clip
The percentage of pixels at both ends of the curve that are excluded in an auto contrast operation.  See
also Tone curve.

CMS
See Color management system.

CMYK
A reflective (subtractive) color model commonly used in printing, which models color using combina-
tions of the three secondary colors used in printer’s ink, Cyan, Magenta and Yellow.  Because no combi-
nation of these three inks will create a true black, blacK ink is also used.

Color management system
A method of ensuring consistency of color reproduction between devices such as scanners, monitors,
and printers, and between different computer platforms.  In the color management system used in
Nikon Capture 2, accurate color reproduction is ensured through the use of profiles that provide
information about the characteristics of the monitor or printer and the color space used for editing.
See also ColorSync, ICC, Profile.

Color space
A general term encompassing both the model used to define color (for example, CMYK or RGB) and
the range, or gamut, of colors that can be expressed in a given color model.  See also CMYK, Gamut,
RGB.

ColorSync
A color management system for Mac OS developed by Apple.  See also Color management system,
ICC.

CompactFlash™ memory card
A small, removable flash memory card.  Used for storage of photographs in Nikon digital cameras.
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Compression
A method for reducing file sizes for storage or transmission.  Compression algorithms can be divided
into “lossless” algorithms, such as LZW, in which no information is lost when files are restored to their
original size for display or editing, and “lossy” algorithms, such as JPEG, in which some information is lost
when the file is restored.  See also JPEG, TIFF.

Crop
The portion of the image selected in the Camera Image window Preview section or in an image
window.

Curve
See Tone Curve.

Eyedropper
A tool for sampling white point, black point, or midpoint.  See also Black point, Midpoint, White point.

FireWire
Apple’s term for the IEEE 1394 interface.  See IEEE 1394.

Gamma
Gamma (also written “γ”), a fundamental property of video systems, determines the intensity of the
output signal relative to the input.  When calculating gamma, the maximum possible input intensity is
assigned a value of one, and the minimum possible intensity (no input) is assigned a value of zero.
Output is calculated by raising input to the inverse of the gamma value (output = input ( 1/γ ) ).

Gamut
The range of colors that can be expressed by a given input device (for example, scanner or digital
camera), output device (monitor or printer), or color profile.   No gamut can reproduce all of the colors
seen by the human eye.  The gamut of primary RGB (Red, Green, and Blue) transmitted light displays
(film transparencies and color monitors) is very different from, and complementary to, the gamut of
secondary CMYK (Cyan, Magenta, Yellow, and blacK) reflected light displays (printed materials).  See also
CMYK, Profile, RGB.

Gray point
See Midpoint.

Halo width
The extent of pixels around a selected central pixel affected when Unsharp Mask is applied.  Also
referred to as “radius.”  Increasing the halo width increases the width of edges affected by Unsharp
Mask.  Excessive application of Unsharp Mask results in an undesirable halo along edges in the image.
See also Unsharp Mask.

Histogram
A bar graph showing the distribution of tones in an image.  The horizontal axis shows tone level
(brightness), the vertical axis the number of pixels.  The bars in the graph show the number of pixels of
a given brightness in the image.  The histogram displayed in the Curves window shows the distribution
of tones for the currently selected channel, and can be used for reference when editing curves.  See also
Tone, Tone curve.
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ICC
The International Color Consortium, an international organization working to develop standards for
color management and color management profiles.  ICC profiles were developed for the conversion of
color space information between devices, and are now on their way to becoming a global standard.
ICC profiles have been proposed as an International Organization for Standardization (ISO) standard.
See also Profile.

IEEE 1394
A high-speed transfer protocol developed by the Institute of Electrical and Electronics Engineers for
connecting peripherals such as hard disks, MO drives, and digital cameras to a computer via a cable.

JPEG
A standard graphic format designed by the Joint Photographic Experts Group.  Images are compressed
using a discrete cosine transform that takes advantage of the properties of human vision, which is more
sensitive to light in the lower wavelengths, to increase quantization at lower frequencies.  JPEG com-
pression is “lossy,” meaning that information is lost when images are compressed, leading to a drop in
image quality.  A lossless compression option is also supported in some implementations.  JPEG images
can be compressed to as much as 100:1, though quality will be significantly reduced.  At a compression
ratio of 20:1, image quality is not noticeably diminished.

LCD
Liquid Crystal Display.  LCDs are notable for their thinness, lightness, and the fact that they consume
relatively little energy.

Midpoint
Controls the output level for mid-tones in the original image.  See also Tone, Tone curve.

NEF
An abbreviation of Nikon Electronic Image Format, an image file format developed by Nikon to support
high-resolution, twelve-bit RAW image data.  In Windows, NEF files have the extension “.nef ”.  NEF
images can be opened and edited only in Nikon Capture.  The advantage of NEF is that while user
settings such as curves and color balance are saved, they are not applied to the original image data.  NEF
images may thus be edited and saved several times without degrading or altering the original image.
NEF files however require a relatively large amount of storage space.  See also RAW image.

Noise
Data in an image file that are not a part of the original image, the digital equivalent of film grain.  The
presence of noise is reflected in a loss in image quality.  Noise appears primarily in dark areas of the
image, and can be reduced by adjusting exposure or lighting to fill in shadows.

ppcm
pixels per centimeter, a measure of resolution.  The more pixels per centimeter, the higher the resolu-
tion. See also ppi, Resolution.

ppi
pixels per inch, a measure of resolution.  The more pixels per inch, the higher the resolution. See also
ppcm, Resolution.

Preferences
Settings controlling basic operations performed by a given program, adjustable by the user.



251

Profile
A file defining the color characteristics of an input device such as a scanner or digital camera, an output
device such as a printer or monitor, or the color space used for editing images.  Profiles are used by
color management systems to ensure consistent color reproduction.  The Nikon Color Management
System used in Nikon Capture employs ICC profiles.  See also Color space, ICC.

RAW image
A photograph taken at an image quality setting of HI-RAW.  “Raw,” unmodified image data from the
camera’s image sensor (charge-coupled display, or CCD) are saved in uncompressed form at a pixel bit-
depth of twelve bits per pixel.  RAW images can only be opened in Nikon Capture 2, and must be saved
again in a standard image format such as TIFF or JPEG before they can be opened in another application.
See also NEF.

Resolution
The density of dots or pixels that make up an image, measured in dots per inch (dpi) or pixels per inch
(ppi); the resolution of Macintosh monitors, for example, is 72 ppi.  The greater the density of dots or
pixels, the higher the resolution and the greater the capacity to express detail.  Resolution is hence the
digital equivalent of film resolving power.  Computer monitors typically have a resolution of 72 ppi or
96 ppi, while printers may have resolutions of 300 dpi, 600 dpi, 1200 dpi, or 2400 dpi.  See also ppcm,
ppi.

RGB
An additive color model commonly used in monitors, in which light emitted in three primary colors,
Red, Green and Blue, is combined to create a wide variety of colors.  White is modeled by mixing 100%
of all three colors.

Scale
The output size of an image as a percentage of the input size.  At a scale of 50%, images will be output
at half their original size.

Speedlight
A brand name for Nikon flashes.

Threshold
The limit up to which Unsharp Mask will be applied.  While it is generally the case that the higher the
threshold, the greater the amount of sharpening applied, the exact effect depends on other Unsharp
Mask settings, such as halo width.  See also Halo width, Unsharp Mask.

Thumbnail
A small preview image, the digital equivalent of a photographic film contact sheet.  Images loaded into
Nikon Capture are displayed in a thumbnail list in the Thumbnails section of the Camera Image window.

TIFF
Tagged Image File Format, an image file format for color or grayscale images, suited to storing bit-
mapped images such as digital photographs.  In some implementations, TIFF supports “lossless” LZW
and packbit compression (in “lossless” compression methods, no information is lost when the image is
compressed, as opposed to “lossy” compression methods such as JPEG, in which detail is sacrificed to
achieve higher compression ratios).  Images saved in TIFF format using Nikon Capture are not com-
pressed.  See also Compression, JPEG.
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Tone
Pixel brightness, measured either as the combined intensity for red, green, and blue or the intensity of
each of these colors (channels) individually.  The number of tones that can be expressed depends on
the bit depth of the image; Nikon Capture 2 supports 256 tone levels per channel at a bit depth of eight
bits and 4096 tone levels per channel at a bit depth of twelve bits (data with a bit depth of twelve bits
are handled internally as sixteen-bit data).  The distribution of tones in the image can be seen in the
Curves window histogram.  See also Bit depth.

Tone curve
A visual tool for editing tones, enhancing brightness and contrast in a selected portion of the tone
range.  Changing the shape of the tone curve changes the mapping between input (the tones in the
original image) and output (tones as they appear after editing).  The digital equivalent of a densitometric
curve.  See also Tone.

Unsharp Mask
A filter for increasing the apparent sharpness of bit-mapped images.  Sometimes abbreviated as “USM.”
Unsharp masks emphasize the differences in color and brightness between edges (outlines) and the
rest of the image.  See also Halo width, Threshold.

White balance
The human eye is able to adapt to changes in lighting, and consequently to humans a white object will
still look white whether viewed in direct sunlight or under overcast skies, or indoors under incandescent
or fluorescent lighting.  A digital camera, in contrast, must adjust colors according to lighting if colors that
appear white when viewed directly are also to appear white in the final photograph.  This adjustment is
called “white balance.”

White point
The input value above which all input tones are mapped to the maximum output value (the default for
the master channel is white).  Any details brighter than the white point will be lost.  See also Tone, Tone
curve.
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90 degrees CCW command ............................ 74

90 degrees CW command ............................... 74
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About Nikon Capture (Windows only) ...... 215
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Arrange Icons (Windows only) ..................... 214
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B
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